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Working with the RAW Fine Tuning Controls

You can modify how the Mac OS decodes RAW files using the adjustment controls in the RAW Fine
Tuning area of the Adjustments inspector or the Adjustments pane of the Inspector HUD. The Mac OS
characterizes the RAW file format for each digital camera supported by Aperture. This calibration data
usually results in the optimal decoding of the RAW image files for a particular camera. However, certain
types of images may require adjustments to how the Mac OS decodes the RAW image file.

The RAW Fine Tuning controls include the following parameters:
e Boost: Use the Boost and Hue Boost sliders and value sliders to control image contrast.
For more information, see “Using the Boost Controls.”

e Sharpening: Use the Sharpening and Edges sliders and value sliders to fine-tune the amount of
sharpening you want applied to images during the RAW decoding process.

For more information, see “Using the Sharpening Controls.”

e Moire: Use the Moire and Radius sliders and value sliders to correct color fringing in high-contrast
edges and the moire pattern effect found in images with subjects whose linear patterns introduce the
effect, such as a brick wall or a picket fence.

For more information, see “Using the Moire Controls.”

e Auto Noise Compensation: Select this checkbox to turn on additional adjustments, such as noise
reduction and stuck pixel removal, that are automatically applied to the image.

For more information, see “Turning On Automatic Noise-Compensation Adjustments.”
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Note: Some controls in the RAW Fine Tuning area of the Adjustments inspector and the Adjustments
pane of the Inspector HUD appear dimmed if these settings are not available for use with images derived
from a particular RAW file format. Some camera models can create multiple types of RAW file formats,
and different controls may be available for each of these RAW file formats.

Using these controls, you can fine-tune your RAW decoding settings on an image-by-image basis.
Aperture also enables you to save your customized RAW decoding settings as presets or as the default
settings always used with a specific camera, so they are easily applied to newly imported images. For
more information about saving your custom RAW Fine Tuning settings as the default for a specific
camera, see “Setting the Camera Default.”
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If the RAW Fine Tuning controls do not appear, the selected image is from a previous version of

Aperture. You must first reprocess the image using Aperture 3 image processing. For more information,
see “Reprocessing Images from Previous Versions of Aperture.”

This photo was adjusted using an :
earlier version of Apple's RAW | Regrocess |

e,
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Using the Boost Controls

The Mac OS characterizes each digital camera’s RAW file format to determine an optimal contrast setting.
The Boost controls allow you to set the strength of the contrast when the RAW file is decoded. The Hue
Boost controls are used to maintain the hues in the image as the contrast is increased using the Boost
controls. When the Hue Boost parameter is set to 1.00 and the Boost parameter is set to 1.00, the hues
of the primary and secondary colors are pinned to their pure color values, resulting in a shift of all the
hues in the image. For images that consist of saturated primary and secondary colors, such as an image
of flowers in a lush garden, shifting the hues to their true values has a desirable visual effect. However,
this is not visually desirable for images containing skin tones. Shifting the hues most often causes the
skin to appear yellow. Setting the Hue Boost parameter to 0.00 increases the color contrast in the image
while preserving the original hues in the image.

@ To adjust the Boost parameters

1. Select a RAW image imported with or reprocessed using Aperture 3 image processing.

Note: If the RAW Fine Tuning controls do not appear in the Adjustments inspector or the Adjustments
pane of the Inspector HUD, the selected image is from a previous version of Aperture. You must first
reprocess the image using Aperture 3 image processing. For more information, see “Reprocessing
Images from Previous Versions of Aperture.”

2. In the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust the Boost parameter
by doing one of the following:

e By default, the Boost slider is set to 1.00. Drag the Boost slider to the left to decrease the amount of
contrast applied to the image during the RAW decoding process, and drag the Boost slider back to the
right to increase the contrast.

e Click the left or right arrow in the Boost value slider to adjust the contrast by 5 percent increments, or
drag in the value field.

e Double-click the number in the Boost value slider, then enter a value from 0.00 to 1.00 and press
Return.

Lise the Boost slider and value
Baat: 4J (100 - —— slider to adjust the amount of
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Hue Baost: L + 0.50 contrast applied during the RAW
decoding process.

A value of 0.00 applies no contrast adjustment to the image during the RAW decoding process. A value
greater than 0.00 increases the contrast adjustment to the image. A value of 1.00 applies the full Apple-
recommended contrast adjustment for the specific camera model.

3. Adjust the Hue Boost parameter by doing one of the following:

e By default, the Hue Boost slider is set to 1.00. Drag the Hue Boost slider to the left to preserve the
accuracy of the hues, and drag the Hue Boost slider back to the right to allow the hues to shift during
the RAW decoding process.

e Click the left or right arrow in the Hue Boost value slider to adjust the accuracy of the hues by 5
percent increments, or drag in the value field.
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e Double-click the number in the Hue Boost value slider, then enter a value from 0.00 to 1.00 and press
Return.

Boost: i) (100> Use the Hue Boost slider and value
Mk Danst: i (< 0En-t slider to protect hue fidelity during

the RAW decoding process.

A value of 0.00 preserves the original hues in the image in relation to the Boost adjustment (color
contrast) during the RAW decoding process. A value greater than 0.00 increases the hue adjustment to

the image. A value of 1.00 applies the full Apple-recommended hue adjustment for the specific camera
model.
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Using the Sharpening Controls

You can adjust sharpening during the RAW decoding process by using the RAW Fine Tuning Sharpening
controls in the Adjustments inspector or the Adjustments pane of the Inspector HUD.

Note: The effect of sharpening an image or group of images using the RAW Fine Tuning adjustment is
very subtle. More sharpening effects can be obtained using the Edge Sharpen adjustment. For more
information about the Edge Sharpen adjustment, see “Working with the Edge Sharpen Controls.”

@ To adjust the sharpening applied during the RAW decoding process

1. Select a RAW image imported with or reprocessed using Aperture 3 image processing.

Note: If the RAW Fine Tuning controls do not appear in the Adjustments inspector or the Adjustments
pane of the Inspector HUD, the selected image is from a previous version of Aperture. You must first
reprocess the image using Aperture 3 image processing. For more information, see “Reprocessing
Images from Previous Versions of Aperture.”

2. Adjust the strength of the sharpening effect by doing one of the following:

e The default value for the Sharpening slider and value slider is determined by the camera used to
create the RAW image file. Drag the Sharpening slider to the right to increase the strength of the
sharpening effect applied during the RAW decoding process, and drag the Sharpening slider back to
the left to reduce the sharpening effect.

e Click the left or right arrow in the Sharpening value slider to adjust the strength of the sharpening
effect by 5 percent increments, or drag in the value field.

e Double-click the number in the Sharpening value slider, then enter a value from 0.00 to 1.00 and
press Return.

Use the Sharpening slider and

Sharperting: i == . ,§7 " value slider to adjust the strength
Enges: J "+ Loa+] of the sharpening effect applied

during the RAW decoding process.

A value of 0.00 applies no sharpening effect to the image during the RAW decoding process. A value
greater than 0.00 increases the sharpening effect to the image.

3. Adjust how the sharpening effect is applied to edges by doing one of the following:

e The default value for the Edges slider and value slider is determined by the camera used to create the
RAW image file. Drag the Edges slider to the right to intensify the sharpening effect that occurs at
“hard” edges (areas where significant color changes occur) during the RAW decoding process, and
drag the Edges slider back to the left to limit the sharpening effect.

e Click the left or right arrow in the Edges value slider to adjust the strength of the sharpening effect
that occurs at hard edges by 5 percent increments, or drag in the value field.

e Double-click the number in the Edges value slider, then enter a value from 0.00 to 1.00 and press
Return.
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Use the Edges shider and value slider

Sharpening, e o (. g g7 ] ta adjust how the sharpening effect
Edges: i) (7 100 ——— is applied to the edges during the

RAW decoding process.

A value greater than 0.00 intensifies the sharpening effect on hard edges.
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Using the Moire Controls

Digital images often have color artifacts that appear around edges and lines because of noise created by
digital image sensors. Images whose subjects have linear patterns often introduce a moire pattern that
gives the subject a wrinkled or rainbow-colored appearance. In addition, cameras with image sensors
employing Bayer patterns often introduce noise into monochromatic images. The Moire adjustment
controls in the RAW Fine Tuning area of the Adjustments inspector or the Adjustments pane of the
Inspector HUD identify these patterns and correct these artifacts.

Because many digital cameras have weak anti-aliasing filters, the Moire and Radius parameters are
specifically used to correct aliasing in an image caused by edges with high color contrast. Weak anti-
aliasing filters tend to curve edges, skewing the colors in the process. During the RAW decoding process,
the Mac OS scans for high-frequency information in the RAW file, looking for blended colors, and then
replaces the blended colors with the edge colors that originally existed in the scene. The Moire
parameter adjusts the amount of signal to apply the adjustment to. The Radius parameter adjusts the
pixel area (visual threshold) the adjustment is applied to.

Note: The Moire controls replace the Chroma Blur controls found in previous versions of Aperture.

@ To adjust the Moire and Radius parameters
1. Select a RAW image imported with or reprocessed using Aperture 3 image processing.

Note: If the RAW Fine Tuning controls do not appear in the Adjustments inspector or the Adjustments
pane of the Inspector HUD, the selected image is from a previous version of Aperture. You must first
reprocess the image using Aperture 3 image processing. For more information, see “Reprocessing
Images from Previous Versions of Aperture.”

2. Adjust the amount of signal to apply the Moire adjustment to by doing one of the following:

e The default value for the Moire slider and value slider is 0.00. Drag the Moire slider to the right to
increase the amount of signal the Moire adjustment is applied to during the RAW decoding process,
and drag the Moire slider back to the left to reduce it.

e Click the left or right arrow in the Moire value slider to adjust the intensity by 5 percent increments, or
drag in the value field.
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e Double-click the number in the Moire value slider, then enter a value from 0.00 to 1.00 and press
Return.

| Use the Moire slider and value slider
Moire: b [+ oone1— to adjust the amount of signal the
Radlus:, —————— (= a00-1 | Moire adjustment is applied to
' during the RAW decoding process.

A value of 0.00 applies no moire correction during the RAW decoding process. A value greater than 0.00
applies moire correction during the RAW decoding process.

3. Adjust the pixel area (visual threshold) the Moire adjustment is applied to by doing one of the following:

e The default value for the Radius slider and value slider is 4.00 pixels. Drag the Radius slider to the
right to increase the area over which the Moire adjustment is applied during the RAW decoding
process, and drag the Radius slider back to the left to reduce the area.

e Click the left or right arrow in the Moire value slider to adjust the radius by 10 percent increments, or
drag in the value field.

e Double-click the number in the Radius value slider, then enter a value from 0.10 to 25.00 and press

Return.
Use the Radius slider and value
Mire: (f [+ o.00~ slider to adjust the visual threshold
Y [ 4,00 - af the Moire adjustment during the

RAW decoding process.

A value of 0.10 is the most limited area over which the moire correction can be applied during the RAW
decoding process. A value greater than 0.10 increases the area over which the moire correction is
applied during the RAW decoding process.
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Turning On Automatic Noise-Compensation Adjustments

Digital image sensors produce noisy images at certain settings (generally high I1SO settings and long
exposures). The Mac OS analyzes the noise characteristics of each camera’s RAW file format and uses
them to control parameters such as sharpness. You can turn on the automatic adjustment by selecting
the Auto Noise Compensation checkbox.

@ To turn on the automatic noise-compensation adjustment

1. Select a RAW image imported with or reprocessed using Aperture 3 image processing.

Note: If the RAW Fine Tuning controls do not appear in the Adjustments inspector or the Adjustments
pane of the Inspector HUD, the selected image is from a previous version of Aperture. You must first
reprocess the image using Aperture 3 image processing. For more information, see “Reprocessing
Images from Previous Versions of Aperture.”

2. In the RAW Fine Tuning area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, select the Auto Noise Compensation checkbox.

(¥ Auto Noise Compensation !

Aperture applies the automatic noise-compensation adjustment during the RAW decoding process.
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Working with DNG Files

In Aperture, you can adjust how the Mac OS decodes RAW images in the DNG format. If the digital
camera that captured an image is supported by Aperture, the calibration data for that camera is used to
decode the RAW file in the same manner as if it were decoded from the RAW file format itself. If the DNG
file is from an unsupported camera, Aperture uses the camera information stored in the DNG file to
decode the image.

@ To adjust the RAW Fine Tuning parameters of a DNG file

1. Select a DNG file imported with or reprocessed using Aperture 3 image processing.

Note: If the RAW Fine Tuning controls do not appear in the Adjustments inspector or the Adjustments
pane of the Inspector HUD, the selected image is from a previous version of Aperture. You must first
reprocess the image using Aperture 3 image processing. For more information, see “Reprocessing
Images from Previous Versions of Aperture.”

2. Adjust the RAW Fine Tuning parameters as necessary for the image.
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Setting the Camera Default

When you’ve modified the RAW decoding settings using the controls in the RAW Fine Tuning area of the
Adjustments inspector or the Adjustments pane of the Inspector HUD, you can save these settings as the
default parameter values for the camera model. All RAW image files from this camera model that are
imported into Aperture are decoded using these saved settings.

¥ RAW Fimz Tuning b -
Camera: Canen EQS- 10 Mark 11l

The camera model is
displayed in the Camera field.

@ To set the camera default

1. In the RAW Fine Tuning area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, choose Save as Camera Default from the Action pop-up menu (with a gear icon) for the RAW Fine
Tuning adjustment.

—J Apple - Camera Default
oa S B Preger. .

4 EditPresers..

o
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The RAW Fine Tuning Adjustment Presets dialog appears.
2. Enter a name for the preset and click OK.

The Action pop-up menu for the RAW Fine Tuning adjustment displays the preset’s name with a
checkmark next to it.

You can always clear the saved camera default settings. To remove a RAW Fine Tuning adjustment preset
from the list of camera default settings, you have to delete it.

@ To clear the camera default settings

1. In the RAW Fine Tuning area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, choose Apple from the Action pop-up menu (with a gear icon) to make it the camera default
setting, then choose Edit Presets from the Action pop-up menu.

The RAW Fine Tuning Adjustment Presets dialog appears.
2. Select the RAW Fine Tuning preset you want to remove, then press the Delete key.
3. In the dialog that appears, click the Delete Adjustment Presets button.

The adjustment preset is removed from the RAW Fine Tuning Adjustment Presets dialog, and the
adjustment preset no longer appears in the RAW Fine Tuning Action pop-up menu.

You can also set the RAW Fine Tuning controls to use the Apple-recommended RAW decoding settings.

@ To use the Apple-recommended camera default settings
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® |n the RAW Fine Tuning area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, choose Apple from the Action pop-up menu (with a gear icon).

A checkmark appears next to Apple in the Action pop-up menu.
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Understanding How to Read Histograms

The histogram is a graph that displays relative brightness in an image, from pure black to pure white.
The area under the graph represents all the pixels in the image. From left to right, the histogram
describes the range of dark pixels (shadows), gray pixels (midtones), and bright pixels (highlights) in the
image. The shape of the histogram graph depends on the tonality of the scene and the exposure.

Brightness increases -

s SSBRIIN] 5|3 ] i

Shadows Midwones Highlights

A histogram can also be used as a tool to evaluate whether or not there is enough shadow, midtone, and
highlight information in the image. Aperture provides three histograms in the Adjustments inspector and
the Adjustments pane of the Inspector HUD. The histogram above the adjustment controls indicates the
current state of the image. The Levels histogram included with the Levels adjustment controls provides a
way to adjust the brightness values in the image in relation to the displayed histogram. You use the
Levels controls to adjust the shadow, dark quarter-tone, midtone, light quarter-tone, and highlight
values independently of each other without affecting the other areas of the image. The Curves histogram
included with the Curves adjustment controls provides a way to adjust the tonal values in the image in
relation to the displayed histogram. You use the Curves controls to adjust the full range of tonal values
independently of each other without affecting the other areas of the image.

For more information about performing Levels adjustment, see “Working with the Levels Controls.” For
more information about performing Curves adjustment, see “Working with the Curves Controls.”
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Evaluating Exposure

Histograms are good tools for evaluating exposure. For example, a series of peaks in the darker side of
the histogram often indicates an underexposed image that consists mainly of dark pixels.

A series of peaks in the center of the histogram often indicates a balanced exposure because a majority
of the pixels are concentrated within the midtones of the histogram. They’re not too dark or too bright.

However, a series of peaks in the brighter side of the histogram often indicates an overexposed image
because most of the pixels in the image are too bright.
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Evaluating Tonality and Contrast

Although histogram graphs are good tools for evaluating an image’s exposure, you shouldn’t interpret
histograms for exposure information only, because the shape of the histogram is also influenced by the
tonality in the scene. You need to take the subject of the image into account when evaluating its
histogram. For example, images shot at night are naturally going to have a majority of peaks in the
darker side of the histogram.

Likewise, images of bright scenes, such as snow or light reflecting off the ocean, have a majority of their
peaks in the brighter side of the histogram.

Histograms can also depict contrast in an image. For example, this silhouette of the man in the
hammock in front of the sunset consists of a relatively even assortment of extreme bright and dark tonal
values with few midtones. In this case, the histogram is shaped like a valley with peaks in both the dark
and bright sides.

Likewise, histograms can also depict a lack of contrast in an image. For example, an image of a rainbow
in the fog lacks contrast. Without directional lighting, there aren’t any highlights or shadows in the
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image. In this case, the peaks of the histogram are concentrated in the center and do not come close to
either the dark or bright sides.
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About Making Adjustments Onscreen

Human eyes perceive color subjectively. It’s difficult to make objective changes to the colors in an image
because the brain is so advanced that it skews the perception of colors to make them appear as natural
as possible. For this reason, it is essential that you create the best possible work environment for
performing color adjustments. Such an environment excludes extraneous colors that have the potential
to throw off your eye.

Creating a Good Work Environment

Before you begin making color adjustments to your images, it’s important to pay attention to the
following:

e Set your display to its highest-resolution setting. This will give you the best view of your image.

e Make sure you are employing good color management. This means that your displays and printers
are calibrated and their profiles are up to date. For more information about calibrating and
profiling your Aperture system, see “Calibrating Your Aperture System.”

e Reduce the ambient light in the room you are working in to prevent the light from skewing your
perception of the colors on your screens, and make sure your displays are set to their brightest
levels.

e |f possible, paint the walls in the room in which you perform detailed image adjustments a neutral
gray. Keep bright-colored objects to a minimum to ensure that the colors on your screens are not
altered by the color in the rest of the room.
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Making Image Adjustments
You use adjustment controls when you want to perfect an image. The type of adjustment control you use
depends on the aspect of the image you are trying to change.
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Working with the Retouch Controls

You use the Retouch brushes to touch up imperfections in the image caused by sensor dust, image
artifacts, and other environmental conditions. You can also copy an element of an image and paste it in
another area for purely aesthetic reasons. Aperture provides two methods for retouching your images.
The method you use depends on whether you are trying to copy texture from the source while
preserving hard edges at the destination (where the blemish is) or simply copy pixels from one area of
the image and replace them over another.

If the area you need to repair has a hard edge near the problem area, you use the “repair” method. You
also use the repair method when you want to copy high-frequency texture from one area of the image
(the source) and brush the texture over the destination area while maintaining the underlying color and
shading of the destination area.

The second method, “cloning,” is used when you simply want to copy pixels from one area and paste
them on another area. Cloning is useful when you want to copy an element of an image as is (a cloud, for
example) and paste it in another area.

Which Retouching Adjustment Should You Use?

Aperture provides two sets of controls that you can use to retouch your image: Retouch and Spot &
Patch.

In the vast majority of cases, Retouch provides the controls that will best serve your image-repair
needs. The Spot & Patch controls have been included in Aperture 3 in order to retain the integrity of
images that were adjusted with earlier versions of Aperture. In many cases, image repairs might even
be improved by removing an existing Spot & Patch repair and replacing it with a Repair or Clone
adjustment performed with the Retouch tool.

There are certain situations in which Spot & Patch is the adjustment of choice. For example, an
artifact on or very near a curved edge in an image may be more effectively removed using the Angle
parameter. For more information about the Spot & Patch adjustment controls, see “Working with the
Spot & Patch Controls.”
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Repairing Your Images

You use the Repair brush of the Retouch adjustment when the area surrounding the blemish has
elements of high contrast, such as an edge, or when you need to copy texture from the source area and
maintain the color and shading in the destination area.

Before Repair adjustment After Repair adjustment

@ To retouch an image using the Repair brush
1. Select an image.

2. It’s a good idea to set the image to appear at full size (100 percent) to prevent image scaling from
obscuring details. To display images at full size, click the Zoom Viewer button in the tool strip or the Full
Screen view toolbar (or press 7).

3. Choose Retouch from the Quick Brush pop-up menu (with a brush icon) in the tool strip or the Full
Screen view toolbar (or press X).

The pointer changes to a brush, and the Retouch HUD appears.

Eetnuh

¥ Repair

4. In the Retouch HUD, do the following:
a. Click the Repair button.

b. Set the radius of the brush by dragging the Radius slider, entering a value in the Radius value slider,
or using your mouse’s scroll wheel.

Note: The mouse’s scroll wheel is disengaged when the pointer is placed over the Retouch HUD.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=2 Page 1 of 2

Petitioner Apple Inc. - Ex. 1005, p. 580



Aperture 3 User Manual: Repairing Your Images 9/28/21 12:50 PM
c. Set the softness of the brush by dragging the Softness slider or entering a value in the Softness value
slider.

d. Set the opacity of the brush by dragging the Opacity slider or entering a value in the Opacity value
slider.

5. If you want the Retouch adjustment to preserve edge details in the image, select the “Detect edges”
checkbox.

6. If you need to copy pixels from another area of the image, deselect the “Automatically choose source”
checkbox, and Option-click the source area.

7. Brush over the area with the imperfection.

Brush ower the blemish
with the Repair brush.
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Cloning Your Images

You use the Clone brush of the Retouch adjustment to copy pixels from an area of the image with similar
visual elements and paste the pixels over the area with the imperfection. No pixels are blended from the
area surrounding the brush stroke.

Before Clone adjustment After Clone adjustment

@ To retouch an image using the Clone brush
1. Select an image.

2. It’s a good idea to set the image to appear at full size (100 percent) to prevent image scaling from
obscuring details. To display images at full size, click the Zoom Viewer button in the tool strip or the Full
Screen view toolbar (or press Z).

3. Choose Retouch from the Quick Brush pop-up menu (with a brush icon) in the tool strip or the Full
Screen view toolbar (or press X).

The pointer changes to a brush, and the Retouch HUD appears.

Eatnuh

Repair ¥ Clond

4. In the Retouch HUD, do the following:
a. Click the Clone button.
b. Set the radius of the brush by dragging the Radius slider or entering a value in the Radius value slider.

c. Set the softness of the brush by dragging the Softness slider or entering a value in the Softness value
slider.
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d. Set the opacity of the brush by dragging the Opacity slider or entering a value in the Opacity value
slider.
5. Option-click the source area (the area where you want to copy the pixels).

6. Brush over the area with the imperfection.

Brush ower the blemish
with the Clone brush,
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Deleting Retouch Brush Strokes

You can delete a Retouch brush stroke at any time. Because pixels in brush strokes are sampled
sequentially, brush strokes can be deleted only in reverse order.

@ To delete a brush stroke

1. Click the Delete button in the Retouch area of the Adjustments inspector or the Adjustments pane of the
Inspector HUD.

* [ Retouth S Click the Dalate button
Rt Dl to remave a brush stroke,

2. Repeat step 1 until the brush stroke you want to remove is deleted.

@ To delete all brush strokes at one time

® Click the Reset button (a curved arrow) in the Retouch area of the Adjustments inspector or the
Adjustments pane of the Inspector HUD.
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Working with the Red Eye Correction Controls

You use the Red Eye tool and the Red Eye Correction adjustment controls to reduce the red-eye effect in
the eyes of the subjects in your image. You use the Red Eye tool to place targets on the red eyes of the
subjects in the image, and then you can adjust the radius and sensitivity of the target overlays using the

Red Eye Correction controls. Aperture desaturates the red pixels within the target overlay area, reducing
the effect.

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=5 Page 1 of 1

Petitioner Apple Inc. - Ex. 1005, p. 585



Aperture 3 User Manual: Reducing Red-Eye Using the Red Eye Tool 9/28/21 12:50 PM

Reducing Red-Eye Using the Red Eye Tool

Reducing red-eye in the eyes of the subjects in your image is as simple as targeting the red eyes with
the Red Eye tool.

Before Red Eye adjustment After Red Eye adjustment

© To remove red-eye with the Red Eye tool
1. Select an image.

2. It’s a good idea to set the image to appear at full size (100 percent) to prevent image scaling from
obscuring details. To display images at full size, click the Zoom Viewer button in the tool strip or the Full
Screen view toolbar (or press Z).

3. Select the Red Eye tool in the tool strip or the Full Screen view toolbar (or press E).

The pointer changes to a target, and the Red Eye HUD appears.

4. Click a red eye in the image to place a Red Eye target overlay on it.

The Red Eye target overlay is placed over the red eye, and the red pixels within the Red Eye target
overlay are desaturated.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=6 Page 1 of 2

Petitioner Apple Inc. - Ex. 1005, p. 586



Aperture 3 User Manual: Reducing Red-Eye Using the Red Eye Tool 9/28/21 12:50 PM

5. Repeat step 4 until all of the red eyes in your image are corrected.
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Adjusting the Size of Red Eye Target Overlays

Aperture fixes red-eye in your images by desaturating the red pixels within the Red Eye target overlay
area. It’s a good idea to fit each Red Eye target overlay to the size of the eye it covers. This prevents any
red pixels in the skin around your subject’s eyes or in clothing, such as a scarf or hat, from being
affected by the red-eye adjustment. You may also need to increase the size of a Red Eye target overlay
to completely encompass the eye you are targeting if the image is a close-up. You can adjust the size of
a Red Eye target overlay before and after it’s placed on the image.

@ To change the size of the Red Eye tool’s target

Do one of the following:

® Drag the Radius slider in the Red Eye HUD.

® |f you have a mouse device with a scroll wheel, rotate the scroll wheel.

The size of the Red Eye tool’s target changes.

You can also change the size of any Red Eye target overlay that you’ve already placed on an image.

@ To change the size of an existing Red Eye target overlay

1. Display the image at full size (100 percent) by clicking the Zoom Viewer button in the tool strip or the
Full Screen view toolbar (or pressing Z).

2. Click the Red Eye target overlay to select it.

A hand icon appears to indicate that you can select the Red Eye target overlay.

The Red Eye tool changes
to @ hand icon to indicate
that you can select the
Red Eye target overlay.
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3. In the Red Eye Correction area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, adjust the Radius parameter by doing one of the following:

e Drag the Radius slider.

e Click the left or right arrow in the Radius value slider to change the size of the Red Eye target overlay
by single increments, or drag in the value field.

e Double-click the number in the Radius value slider, then enter a value from 3.00 to 400.00.

¥ | Redd Eye Correction - 5 0.
tooi#:  lafl [ Delee |
ludius:—?—'- 96 |

Senstoiny “ (= & r)

Drag the Radius slider
to adjust the size of
the selected Red Eye
target overlay.

The size of the Red Eye target overlay increases as the parameter value increases.
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Adjusting the Sensitivity of Red Eye Target Overlays

When you target a red eye in a picture, Aperture automatically chooses the area within the target overlay
circle where the desaturation is applied. In a few cases, the area chosen by Aperture might be either
slightly too large or slightly too small (typically including a few pixels in the eyelid skin, or missing a few
red pixels inside the pupil). For these difficult cases, you can adjust the Sensitivity parameter to change
the area where desaturation occurs. For example, dragging the Sensitivity slider to the left by one notch
decreases the radius of the active area within the Red Eye target overlay by one pixel, and dragging the
Sensitivity slider one notch to the right enlarges it by one pixel.

Before Sensitivity adjustment After Sensitivity adjustment
[the eyelids are desaturated)

@ To adjust the sensitivity of a Red Eye target overlay
1. Click the Red Eye target overlay to select it.

2. In the Red Eye Correction area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, adjust the Sensitivity parameter by doing one of the following:

e Drag the Sensitivity slider.

e Click the left or right arrow in the Sensitivity value slider to change the sensitivity of the Red Eye target
overlay by single-pixel increments, or drag in the value field.

e Double-click the number in the Sensitivity value slider, then enter a value from -10.00 to 10.00 and
press Return.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=38 Page 1 of 2

Petitioner Apple Inc. - Ex. 1005, p. 590



Aperture 3 User Manual: Adjusting the Sensitivity of Red Eye Target Overlays

* ¥ Red Cye Correction - 5 0.
Spot® lofl [ Delese |
Radiizs: —ig———— [~ 85 |

P = R

Tl..-'s-e the Sensitivity slider
and value slider to fine-tune
the area within the Red Eye
target overlay where
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The area within the Red Eye target overlay where desaturation occurs increases as the parameter value

increases.
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Viewing the Corrected Image Without Red Eye Target Overlays

After correcting the red eyes in your image, you can view the corrected image with the Red Eye target
overlays turned off.

@ To view the corrected image with the Red Eye target overlays turned off
B Select the Selection tool in the tool strip or the Full Screen view toolbar (or press A).
The Red Eye target overlays disappear, but the effect of the Red Eye adjustment remains visible.

Note: You can still make adjustments to the targeted red eyes with the overlays turned off, and the
image is updated to show the changes.

@ To turn the Red Eye target overlays on again
Do one of the following:
® Select the Red Eye tool in the tool strip or the Full Screen view toolbar (or press E).

® |n the Red Eye Correction area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, click the Red Eye Tool button (with an icon of a red eye).

The Red Eye target overlays reappear.
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Moving Red Eye Target Overlays

Once placed, a Red Eye target overlay can always be moved.

© To move a Red Eye target overlay
1. Make sure the Red Eye tool is selected, then place the Red Eye tool’s target over the Red Eye target
overlay you want to move until the target changes to a hand icon.

The hand icon indicates that you can drag the target overlay rather than place a new one.

Drag the Red Eye target
averlay over the red eye
in the image.

2. Drag the Red Eye target overlay to the appropriate position over the subject’s eye.
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Deleting Red Eye Target Overlays

You can always delete a Red Eye target overlay.

@ To delete a Red Eye target overlay

Do one of the following:

® Select a Red Eye target overlay in the image, then click the Delete button in the Red Eye Correction area
of the Adjustments inspector or the Adjustments pane of the Inspector HUD.

| v ¥ Red Eye Correction - a0
“spordl  Lafl | Delee - Click the Delete button
Radius; ——— e [0 58 ) to delete a Red Eye
Sarsitity: i {~ 0 + target overlay,

® Command-click a Red Eye target overlay.

Command-click a
Red Eye target overlay
to delete it

The Red Eye target overlay disappears.
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Working with the Spot & Patch Controls

You use the Spot & Patch adjustment controls when you need to modify Spot & Patch parameter settings
that were applied using previous versions of Aperture. When using the Spot & Patch adjustment to spot
or patch your images, you can modify the appearance of the pixels within the target overlays. You can
also adjust the size of Spot & Patch target overlays.

Which Retouching Adjustment Should You Use?

Aperture provides two sets of controls that you can use to retouch your image: Retouch and Spot &
Patch.

In the vast majority of cases, Retouch provides the controls that will best serve your image-repair
needs. The Spot & Patch controls have been included in Aperture 3 in order to retain the integrity of
images that were adjusted with earlier versions of Aperture. In many cases, image repairs might even
be improved by removing an existing Spot & Patch repair and replacing it with a Repair or Clone
adjustment performed with the Retouch tool. For more information about the Retouch tool, see
“Working with the Retouch Controls.”

There are certain situations in which Spot & Patch is the adjustment of choice. For example, an

artifact on or very near a curved edge in an image may be more effectively removed using the Angle
parameter.
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Spotting Your Images

When the area around the blemish is continuous (such as a solid color) and doesn’t contain a distinct
texture, you can use the spotting method to obscure the blemish by integrating the pixels that surround
it. You fix a blemish by placing the Spot & Patch target overlay over the blemish in the image and then
adjusting the size of the target overlay so that it just barely covers the blemish. By keeping the target
overlay small, you minimize the chance of a visual aberration in the final image. Aperture provides
additional parameter controls to allow you to adjust the softness, opacity, and amount of detail in the
cloned pixels, so that the corrected area looks as natural as possible.

Before Spot & Patch adjustment After Spot & Patch adjustment
[spotting) [spatting)

@ To spot an image
1. Select an image.

2. It’s a good idea to set the image to appear at full size (100 percent) to prevent image scaling from
obscuring details. To display an image at full size, click the Zoom Viewer button in the tool strip or the
Full Screen view toolbar (or press 7).

3. Choose Spot & Patch from the Adjustments pop-up menu in the Adjustments inspector or the
Adjustments pane of the Inspector HUD.

The pointer changes to a target, and the Spot & Patch HUD appears.

Soor & Parch

4. Click the blemish area to place the Spot & Patch target overlay on it.

The yellow Spot & Patch target overlay is placed over the blemish, and the blemish disappears.
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Click a blemish to place
a Spot & Patch target
owerlay an it.

Note: You can always adjust the size of the target overlay and other parameters. For more information,
see “Adjusting the Size of Spot & Patch Target Overlays.”

5. Repeat step 4 until all of the blemishes in your image are removed.
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Patching Your Images

When you need to clone pixels from a different area of an image to fix the area where the blemish is, you
use the “patching” method. Patching is similar to spotting, except that there are some additional steps.
You first place a Spot & Patch target overlay (yellow) over the blemish, and then you place a source target
overlay (white) over the area you want to clone. The pixels in the Spot & Patch target overlay are replaced
by the pixels copied from the source target overlay. Aperture provides additional parameter controls to
allow you to adjust the size of target overlays and the softness, opacity, and amount of detail in cloned
pixels, so that the patched area looks as natural as possible.

o
'ia#

Before Spot & Patch adjustment After Spot & Patch adjustment
[patching) [patching)

@ To patch a blemish in an image
1. Select an image.

2. It’s a good idea to set the image to appear at full size (100 percent) to prevent image scaling from
obscuring details. To display an image at full size, click the Zoom Viewer button in the tool strip or the
Full Screen view toolbar (or press 7).

3. Choose Spot & Patch from the Adjustments pop-up menu in the Adjustments inspector or the
Adjustments pane of the Inspector HUD.

The pointer changes to a target, and the Spot & Patch HUD appears.

Spot & Fatch

4. Click the blemish area to place a Spot & Patch target overlay on it.

A yellow target overlay is placed over the blemish, and the blemish is replaced by the pixels that
surround it. This yellow target overlay is the destination target overlay.
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Click a blemish to place
a Spot & Patch target

v overlay on it

5. Do one of the following:

e Select the Patch checkbox in the Spot & Patch area of the Adjustments inspector or the Adjustments
pane of the Inspector HUD, then drag the white source target overlay to the area you want to clone
(the source area).

e Option-click the area you want to clone.

A white source target overlay appears and is placed over the source area.
/ s

The pixels within the source target overlay are copied and replace the pixels within the destination target
overlay. The blemish is patched.

Option-click the area
you want o clone to
place a source target
overlay on it

Note: You can always adjust the size of the target overlay and other parameters. For more information,
see “Adjusting the Size of Spot & Patch Target Overlays.”

6. Repeat steps 4 and 5 until all blemishes are removed from your image.

You can adjust the angle of the cloned pixels within the destination target overlay. Adjusting the angle
rotates the cloned pixels over the destination area. This is particularly useful if you’re cloning an area
that has a visual element, such as a pattern or line, that is at a different angle from elements in the
destination area. The Angle controls allow you to match the angle of the pixels within the destination
target overlay.
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-‘ You can adjust the angle

of the cloned pixels.

@ To adjust the angle of the cloned pixels within a destination target overlay

® |n the Spot & Patch area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
adjust the Angle parameter by doing one of the following:

e Drag the Angle slider to the left to rotate the cloned pixels counterclockwise, or drag the Angle slider
to the right to rotate the cloned pixels clockwise.

e Click the left or right arrow in the Angle value slider, or drag in the value field.

e Double-click the number in the Angle value slider, then enter a value from -180.00 to 180.00 and
press Return.

¥ (¥ Spot & Patch 2 % 5
Spat#:  2of2 | [FParch | Deiete |
Readiuis: 'y 7 170 +
Softness: | §e 0 =) Use the Angle slider and
Dpacity (i< Loo - value slider to adjust the
Detait: = 100 ) angle of the pixels in the
sagle o f« o « destination target overlay.

A negative value rotates the cloned pixels counterclockwise, and a positive value rotates the cloned
pixels clockwise.
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Adjusting the Size of Spot & Patch Target Overlays
You can change the size of a Spot & Patch target overlay before and after it’s placed on an image. It’s
best to adjust the size of the target overlay so it fits the area around the blemish as tightly as possible. A
tight fit ensures that any visual aberrations are minimal.

@ To change the size of the Spot & Patch target before placing it on the image

Do one of the following:

® Drag the Radius slider in the Spot & Patch HUD.

Spot & Paich

B Click the left or right arrow in the Radius value slider, or drag in the value field.
B Double-click the number in the Radius value slider, then enter a value from 3 to 400 and press Return.

® |f you have a mouse with a scroll wheel, rotate the scroll wheel.

The size of the Spot & Patch target changes.

You can also change the size of any Spot & Patch target overlay that you’ve already placed on an image.

@ To change the size of an existing Spot & Patch target overlay

1. Display the image at full size (100 percent) by clicking the Zoom Viewer button in the tool strip or the
Full Screen view toolbar (or pressing Z).

2. Click a Spot & Patch target overlay to select it.

A hand icon appears to indicate that you can select the Spot & Patch target overlay rather than place a
new one.

A hand icon appears to
indicate that you can
miowe the target overlay.

3. In the Spot & Patch area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
adjust the Radius parameter by doing one of the following:
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e Drag the Radius slider.

e Click the left or right arrow in the Radius value slider to change the radius of the Spot & Patch target
overlay by single-pixel increments, or drag in the value field.

e Double-click the number in the Radius value slider, then enter a value from 3 to 400 and press

Return.
" ¥ Spor & Patch o s %
Spere: Zef2 | vlPareh { Delere |
‘Radius 1 (= 17 ») Lise the Radius slider and
Saltness: = 0 - value slider to adjust the
hucky: o= 106 ) size of previously placed
Detail. (= 100 - Spot & Patch target overlays.
Angle: i =0 +

The size of the Spot & Patch target overlay increases as the parameter value increases.
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Adjusting the Softness Within Spot & Patch Target Overlays

You can also change the “softness” of cloned pixels within Spot & Patch target overlays. Softness
describes how well the area within the target overlay blends in with the surrounding image area. The
Softness parameter controls the blending of pixels between the center of the Spot & Patch target overlay
and the circumference. The higher the Softness parameter value, the closer to the center the pixel
blending occurs. The lower the parameter value, the less pixel blending occurs, resulting in a “hard
edge.”

/ Yeu can adjust
the softness of
v the coned pxels.

@ To adjust the softness of pixels within a Spot & Patch target overlay

® |n the Spot & Patch area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
adjust the Softness parameter by doing one of the following:

e Drag the Softness slider.
e Click the left or right arrow in the Softness value slider, or drag in the value field.

e Double-click the number in the Softness value slider, then enter a value from 3 to 400 and press

Return.
# [ Spot & Patch @ 4% %
Spota | Zefz  WPmeh ([ Daleta |
Radius: i [= 1FG =]
Safness: [~ o = Use the Softness slider and
Dpacity: G~ 100 value slider to make the
Detail: gl 100 - edges of the Spot & Patch
R O O overlay blend better with

the surrounding image area.

A low value decreases the softness of pixels within the Spot & Patch target overlay, and a high value
increases the softness.
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Adjusting the Opacity Within Spot & Patch Target Overlays

Another method of modifying Spot & Patch target overlays to make cloned pixels blend in better with
surrounding pixels is to adjust the opacity of pixels in the target overlay. The higher the Opacity
parameter value, the more the cloned pixels obscure the original pixels they cover.

/ o can adjust
: the apacity of the
v cloned pixels.

@ To adjust the opacity of cloned pixels in a Spot & Patch target overlay

® |n the Spot & Patch area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
adjust the Opacity parameter by doing one of the following:

e Drag the Opacity slider.
e Click the left or right arrow in the Opacity value slider, or drag in the value field.

e Double-click the number in the Opacity value slider, then enter a value from 0 to 100 and press

Return.
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A low value decreases the opacity of the cloned pixels in the Spot & Patch target overlay, and a high
value increases the opacity.
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Adjusting the Detail Within Spot & Patch Target Overlays

9/28/21 12:52 PM

In addition to adjusting softness and opacity in Spot & Patch target overlays, you can adjust the amount

of detail, such as texture or grain, that is preserved in the cloned pixels.

v “fou can adjust the
amount of detail in

v the cdloned pixels.

@ To adjust the amount of detail in cloned pixels in a Spot & Patch target overlay

® |n the Spot & Patch area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,

adjust the Detail parameter by doing one of the following:
e Drag the Detail slider.

e Click the left or right arrow in the Detail value slider, or drag in the value field.

e Double-click the number in the Detail value slider, then enter a value from 0 to 100 and press Return.
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A low value decreases the amount of detail, such as texture or grain, preserved in the cloned
a high value increases the amount of detail.
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Viewing the Corrected Image Without Spot & Patch Target Overlays

After retouching the blemishes in your image, you can view the corrected image with the Spot & Patch
target overlays turned off.

@ To view the corrected image with the Spot & Patch target overlays turned off
B Select the Selection tool in the tool strip or the Full Screen view toolbar (or press A).

The Spot & Patch target overlays disappear, but the effects of the Spot & Patch adjustment remain
visible.

@ To turn the Spot & Patch target overlays on again

= Click the Spot & Patch Tool button (with a patch icon) in the Spot & Patch area of the Adjustments
inspector or the Adjustments pane of the Inspector HUD.

The Spot & Patch target overlays reappear.
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Moving Spot & Patch Target Overlays

Once placed, a Spot & Patch target overlay can always be moved.

© To move a Spot & Patch target overlay

1. Make sure the Spot & Patch HUD is shown, then place the Spot & Patch target over the Spot & Patch
target overlay you want to move until a hand icon appears.

The hand icon indicates that you can drag the target overlay rather than place a new one.

=

A hand icon appears to
indicate that you can
select the Spot & Patch
rarget overlay.

\Vg

2. Drag the Spot & Patch target overlay to the appropriate position on the image.
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Deleting Spot & Patch Target Overlays

You can delete a Spot & Patch target overlay at any time.

@ To delete a Spot & Patch target overlay

Do one of the following:

® Select a Spot & Patch target overlay in the image, then click the Delete button in the Spot & Patch area of
the Adjustments inspector or the Adjustments pane of the Inspector HUD.
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® Command-click the Spot & Patch target overlay.

Command-click
a Spot & Patch target
overlay to delate it

The Spot & Patch target overlay disappears.

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.Iproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=21 Page 1 of 1

Petitioner Apple Inc. - Ex. 1005, p. 608



Aperture 3 User Manual: Working with the Devignette Controls 9/28/21 12:52 PM

Working with the Devignette Controls

You use the Devignette adjustment controls to correct a vignette that was applied to an image as it was
shot. The term vignette describes an image whose brightness fades to its periphery from its center.
Vignettes are usually caused by poor lens design, stacked filters, lens hoods, and wide-angle zoom
lenses. Aperture corrects the image by increasing the brightness on the edges of the image where
vignettes typically occur.

Note: When you apply a Devignette and Crop adjustment to the same image, Aperture applies the
Devignette adjustment prior to the crop in order to correct lens artifacts. Applying the Devignette
adjustment before the crop prevents any distortion that would otherwise appear in the cropped image.

Before Devignette adjustment After Devignette adjustment

@ To remove the vignette from your image

1.
2.

Select an image.

If the Devignette controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Devignette from the Adjustments pop-up menu.

By default, the Intensity parameter is set to 1.0. Adjust the Intensity parameter by doing one of the
following:

e Drag the Intensity slider to the left to decrease the amount of brightness applied to the edges of the
image, or drag it to the right to increase the brightness.

e Click the left or right arrow in the Intensity value slider to change the brightness applied to the edges
of the image, or drag in the value field.

The left arrow decreases the amount of brightness applied to the edges of the image, and the right
arrow increases the brightness.

e Double-click the number in the Intensity value slider, then enter a value from 0.0 to 1.0 and press
Return.

¥ ¥ Devignetie 5o Use the Intensity slider and value
intensity: gl 18 - slider to adjust the amaunt of
L g e e T brightness applied to the edges
of the image.

4. To adjust the distance Aperture goes from the edge of the image, in pixels, to apply the Devignette
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adjustment, do one of the following:

e Drag the Radius slider to the right to increase the number of pixels Aperture goes toward the center
of the image to apply the Devignette adjustment, or drag it to the left to limit the vignette to the
edges of the image.

e Click the left or right arrow in the Radius value slider, or drag in the value field.

The left arrow limits the Devignette adjustment to the edges of the image, and the right arrow moves
the Devignette adjustment toward the center point of the image.

e Double-click the number in the Radius value slider, then enter a value from 0.0 to 2.0 and press
Return.

* [¥ Devignette L Use the Radius slider and value
Intenalty; 5 . 18 -] slider to adjust the size of the

Padluy: ——————(- 00 - area over which the Devignette
adjustment is applied.

The vignette is removed from the image.

For more information about applying a vignette to an image, see “Working with the Vignette Controls.”

You can also brush the Devignette adjustment on selected parts of an image. For more information, see
“Making Brushed Adjustments.”
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Working with the Straighten Controls

When you shoot photos, environmental conditions often make it difficult to frame an image that is level
in relation to the horizon—either real or virtual. In Aperture, you can straighten an image so that the
horizon in the image is parallel to the bottom and top edges.

Before Straighten adjustment After Straighten adjustment

You can use two different methods to straighten your images. You can use either the Straighten tool or
the Straighten adjustment controls. However, you may find it most efficient to use the Straighten tool to
quickly level the image so that it’s roughly straight and then use the Straighten controls for more
precision.
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Rotating Images with the Straighten Tool
Rotating an image with the Straighten tool is as simple as selecting the tool and dragging within the
image to make it straight. However, it’s important to understand that although the image appears to
enlarge as you rotate it, Aperture actually crops the image so that it fits within its rectangular border
without blank edges appearing on the sides.

@ To straighten your image using the Straighten tool

1. Select an image.

2. Select the Straighten tool in the tool strip or the Full Screen view toolbar (or press G).
The Selection tool changes to the Straighten tool.

3. With the Straighten tool selected, drag within the image to rotate it either clockwise or counterclockwise.

As you rotate the image, a yellow grid overlay appears to help you make the horizon perfectly straight,
and the image is cropped to prevent gaps from appearing in the corners of the image.

Drag within the image
Lo rotate it.

Note: It’s a good idea to turn zooming off when straightening an image, so that the full image fits within
the Viewer. If an image is zoomed in to its actual size, you can turn off zooming by clicking the Zoom
Viewer button in the tool strip or the Full Screen view toolbar (or by pressing Z).
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Rotating Images with the Straighten Controls

You can also straighten an image using the Straighten adjustment controls. Using these controls
provides more precision.

@ To straighten an image using the Straighten controls

1. Select the image.

2. If the Straighten controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Straighten from the Adjustments pop-up menu.

3. Change the value for the Angle parameter by doing one of the following:
e Drag the Angle slider.
e Click the left or right arrow in the Angle value slider, or drag in the value field.

e Double-click the number in the Angle value slider, then enter a value from -20.0 to 20.0 degrees and
press Return.

» [ straighten & N B Lise the Angle slider and value
il e e, [ G.0° ¥ slicer to straighten the image.

Decreasing the value rotates the image clockwise, and increasing the value rotates the image
counterclockwise.

As you rotate the image, a yellow grid overlay appears to help you make the horizon perfectly straight,
and the image is cropped to prevent gaps from appearing in the corners of the image.

Note: It’s a good idea to turn zooming off when straightening an image, so that the full image fits within
the Viewer. If an image is zoomed in to its actual size, you can turn off zooming by clicking the Zoom
Viewer button in the tool strip or the Full Screen view toolbar (or by pressing Z).
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Working with the Crop Controls

You use the Crop tool and the Crop adjustment controls when you want to improve the composition of
your image by trimming the edges, or when you want to change the aspect ratio of the image. For
example, you can change an image’s aspect ratio from 4 x 6 to 3 x 5.

Before Crop adjustment After Crop adjustment

There are two methods for cropping an image: you can use the Crop tool to manually crop the image, or
you can use the Crop adjustment controls. The method you choose is determined by the level of
precision you require. The Crop tool provides a fast freehand method and works in conjunction with a
Crop HUD that contains controls for setting the aspect ratio of the crop. The extra precision provided by
the Crop adjustment controls is useful when you want to specify exact dimensions for the cropped
image.
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Cropping Images with the Crop Tool
Cropping an image with the Crop tool is the easiest method. You simply select the Crop tool and drag a
rectangle over your image to exclude the unwanted areas. The Crop HUD appears, providing additional
controls for setting the aspect ratio of the image and displaying crop guides to help visually align the
composition of the image according to the rule of thirds.

@ To crop an image using the Crop tool

1. Select an image.

2. Select the Crop tool in the tool strip or the Full Screen view toolbar (or press C).

The Selection tool changes to the Crop tool, and the Crop HUD appears.

3. With the Crop tool selected, drag a rectangle over the image to exclude the areas that you want to trim.

A Crop overlay appears on the image with resize handles, and the trimmed edges are dimmed. When you
release the mouse button, the image is cropped.

Drag across the image
with the Crop tool.

A dark overlay is placed
over the trimmed areas.

For instructions for viewing the cropped image without the Crop overlay, see “Displaying the Cropped
Image Without the Crop Overlay.”

After adding a Crop overlay to an image, you can always change the size and shape of the overlay.

@ To change the size and shape of a Crop overlay

® Drag a resize handle on the Crop overlay to change the size of the crop.
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Drag a resize handle to
resize the Crop overlay,

You can adjust the placement of the crop by moving the Crop overlay across the image.

@ To adjust the placement of the crop

® Drag the Crop overlay to the appropriate position.

Dvag the Crop overlay to
adjust its position.

You can set the Crop overlay to a specific aspect ratio using the Crop HUD.

@ To set the aspect ratio of the Crop overlay
1. In the Crop HUD, do one of the following:

e Choose an aspect ratio from the Aspect Ratio pop-up menu.

— Choose a standard
aspect ratio for the crop
from the Aspect Ratio
POP-Up Mmenu,

The Crop overlay is updated to match the chosen aspect ratio.
e Enter a custom aspect ratio by entering values in the Width and Height fields.
Aperture interprets small (single and double-digit) numbers as inches and larger numbers as pixels.

2. If you wish, click the Switch Aspect Ratio button to switch the orientation of the Crop overlay to portrait
or landscape.
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Click the Switch Aspect Ratio
button to change the orientation
to portrait or landscape.

The values in the Width and Height fields are reversed, and the Crop overlay is updated to show the new
orientation. (Entering a number in the Width field that is smaller than the number in the Height field sets
a portrait orientation. Entering a larger number in the Width field sets a landscape orientation.)

You can also display cropping guides within the Crop overlay to help you compositionally align the Crop
overlay according to the rule of thirds.

@ To show cropping guides within the Crop overlay

® Select the “Show guides” checkbox.

Select the "Show guides”
checkbox to display
Cropping guides aver
the image.
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Displaying the Cropped Image Without the Crop Overlay

When the Crop tool is selected, the whole image is shown, with the trimmed edges dimmed. You can
also have Aperture display the cropped image without the trimmed edges.

@ To display the cropped image without the trimmed edges

® Select another tool in the tool strip or the Full Screen view toolbar. For example, select the Selection tool
(or press A).

The cropped image appears in the Viewer.

Select the Crop tool again (or press C) to make the trimmed edges visible in the Viewer again.

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=28 Page 1 of 1

Petitioner Apple Inc. - Ex. 1005, p. 618



Aperture 3 User Manual: Cropping Images with the Crop Controls 9/28/21 12:53 PM

Cropping Images with the Crop Controls

You use the Crop adjustment controls when an extra level of precision is required. For example, if a
client wants an image cropped to a precise dimension that is different from the standard aspect ratios,
you use the Crop controls.

Aperture uses a simple coordinate system to position the Crop overlay on the image. You simply set x
and y coordinates to specify the position of the bottom-left corner of the crop. The x-coordinate moves
the bottom-left corner of the crop horizontally, and the y-coordinate moves the bottom-left corner of
the crop vertically. Then you set the width and height to determine the area within the crop.

To set crop dimensions using the Crop adjustment controls

Select an image.

If you wish, use the Crop tool to place a rough crop on the image.

w N = Q0

If the Crop controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Crop from the Adjustments pop-up menu.

4. In the Crop area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, click the X
value slider’s left or right arrow, or double-click the number and enter a new number, to set the
horizontal position of the bottom-left corner of the Crop overlay.

* & Crop 85 40
— Use the Width and Height
x (= 1560 ») wigth: (= 0 - : p .
= — value sliders ta adjust the size
Yeol= A28 =) Height- [= &

of the area within the crop.

The ¥ and ¥ value sliders
control the position of the
bottom-left corner of the
crop on the anginal image.

The X value is measured in pixels, and as the value increases, the Crop overlay moves to the right.
5. Specify the vertical position of the bottom-left corner of the crop using the Y value slider.

The Y value is measured in pixels, and as the value increases, the Crop overlay moves up.
6. Specify the width of the crop using the Width value slider.

The width is measured in pixels, and the measurement starts at the bottom-left corner, increasing from
left to right.

7. Specify the height of the crop using the Height value slider.

The height is measured in pixels, and the measurement starts at the bottom-left corner, increasing from
bottom to top.
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Working with the Flip Controls

You use the Flip adjustment controls when you want to flip the composition of the image vertically,
horizontally, or both.

Before Flip adjustment After Flip adjustment

@ To flip the composition of an image
1. Select an image.

2. If the Flip controls are not shown in the Adjustments inspector or the Adjustments pane of the Inspector
HUD, choose Flip from the Adjustments pop-up menu.

¥ o Fiip o Choose how you want to flip
Flig Type: | Horizontal j ————— the image from the Flip Type
pop-up menu.

3. In the Flip area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, do one of
the following:

e To flip the image horizontally: Choose Horizontal from the Flip Type pop-up menu.
e To flip the image vertically: Choose Vertical from the Flip Type pop-up menu.

e To flip the image both horizontally and vertically: Choose Horizontal and Vertical from the Flip Type
pop-up menu.
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Working with the White Balance Controls

You use the White Balance adjustment controls to change the color temperature and color tint of an
image. If an image has pixels that are supposed to be pure white, you can use the White Balance
eyedropper to automatically adjust the color temperature and tint, or you can adjust the color
temperature and tint manually. In most cases, the automatic adjustment succeeds in removing the color
cast from the image. If the White Balance eyedropper does not completely remove the color cast from the
image, you can use the Temp and Tint adjustment controls to fine-tune the adjustment.

Although Aperture can set the white balance of the image with great accuracy, sometimes you have to

use a combination of these two methods to have the image appear with the warm or cool tonality you
intended.

Before White Balance adjustment  After White Balance adjustment
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Adjusting White Balance with the White Balance Eyedropper

When you have pixels in your image that should be pure white, you can use the White Balance
eyedropper tool to automatically set the color temperature and tint of the image. All you have to do is
use the White Balance eyedropper to select a portion of the image that contains neutral gray pixels, and
Aperture white balances the image instantaneously.

@ To adjust the color temperature and tint with the White Balance eyedropper
1. Select an image.

2. In the White Balance area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
select the White Balance eyedropper.

¥ [ white Balance LN
f—hrtm_i\_l— < SO0 K+
¥ Tine 0

R e Yo 3]

Click the White Balance

evedropper tool o
activate the Loupe.

The pointer changes to the Loupe, showing a magnified view of the target area. By default, the Loupe is
set to magnify the image to 100 percent (full size). If necessary, you can increase the magnification of

the Loupe by pressing Command-Shift-Plus Sign (+). For more information about the Loupe, see
“Viewing Images with the Loupe.”

3. Position the target area of the Loupe over the pixels in the image that are a neutral gray, then click.

The white balance of the image is adjusted. The color tonality of the image is shifted either cooler or
warmer, depending on the tonality of the original image.

Important: Make sure that there is as little digital noise in the target area of the Loupe as possible.
Digital noise can skew the white-balance calculation results, introducing a color cast that wasn’t
previously there. A simple way to avoid errant pixels is to increase the magnification of the Loupe by
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pressing Command-Shift-Plus Sign (+).
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Adjusting Color Temperature with the Temp Controls

You can also adjust the color temperature of an image manually using the Temp parameter controls.
Color temperature is a term used to describe the color of light when the image was shot. However, it
refers to the color value of the light rather than its heat value. Light’s color temperature is measured in
units called kelvin (K). Adjusting the color temperature of the image changes how Aperture interprets the
colors in the image in relation to the assigned temperature of light. The purpose of adjusting the color
temperature of an image is to make colors look as natural as possible.

@ To manually adjust the color temperature of an image

1. Select an image.

2. In the White Balance area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
adjust the Temp parameter by doing one of the following:

e Drag the Temp slider to the left to cool the tonality of the image, or drag it to the right to warm the
tonality.

e Click the left or right arrow in the Temp value slider to change the brightness of the image by 10 K
increments, or drag in the value field.

The left arrow decreases the color temperature of the image, and the right arrow increases the color
temperature.

e Double-click the number in the Temp value slider, then enter a value from 2000 K to 50,000 K and
press Return.

* i white Balance 8. Use the Temp slider and value
A Temp: == [ 500K = slider to adjust the color
DTN — e (B ¢ temperature of the image.

The color temperature of the image is updated as you change the parameter value.
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Adjusting Tint with the Tint Controls

You can also manually adjust the tint of an image using the Tint parameter controls. You use the Tint
parameter controls when you need to fine-tune the white balance adjustment by neutralizing the
remaining green or magenta tint.

@ To manually adjust the tint of your image

1. Select an image.

2. In the White Balance area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
adjust the Tint parameter by doing one of the following:

e Drag the Tint slider to the left to add a green tint to the image, or drag it to the right to add a
magenta tint.

e Click the left or right arrow in the Tint value slider to change the tint of the image by single
increments, or drag in the value field.

The left arrow adds a green tint to the image, and the right arrow adds a magenta tint.

e Double-click the number in the Tint value slider, then enter a value from -150 to 150 and press

Return.
* ¥ white Balance LI -8 Use the Tint slider and
@ Tefg: ] e, (= EODO K+ value slider to adjust
B TNl —— (D the tint of the image.

The image’s tint is updated as you change the parameter value.
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Working with the Exposure Controls

You use the Exposure adjustment controls to set the exposure, recovery, black point, and brightness
values.
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Using the Auto Exposure Button

When you want to quickly adjust the exposure of a RAW image, you can use the Auto Exposure button.
Depending on the exposure Aperture sets for the image, you can always fine-tune the image’s exposure
setting using the Exposure adjustment controls. For more information about manually adjusting the
exposure of an image, see “Correcting Exposure in the Image.”

Before Auto Exposure adjustment  After Auto Exposure adjustment

Note: Automatic exposure adjustment is available for Aperture-supported RAW images only. If you want
to adjust the exposure of another file type, such as JPEG or TIFF, see “Working with the Exposure
Controls.” For a list of supported RAW file types, go to the Apple website at
http://www.apple.com/aperture/specs.

© To automatically correct the exposure of a RAW image

1. Select an image.

2. In the Exposure area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, click
the Auto Exposure button.

Click the Auto Exposure
button to automatically
set the exposure for

the image.
T ¥ Exposure Auin; 8,
Exposie; o T
Recovery: s T
Biwck Point: =i = — (4 D0+
Brightness: i {a om =

The exposure of the image is automatically corrected. If you need to fine-tune the image’s exposure
setting, see “Correcting Exposure in the Image.”
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Correcting Exposure in the Image

If you’ve over- or underexposed an image, you can correct it by adjusting the Exposure parameter. The
amount of latitude you have—the visually acceptable range of f-stops—depends on the file type and the
bit depth of the image. Typically, a RAW file is capable of a slightly wider latitude than a JPEG file.

Before Exposure adjustment After Exposure adjustment

Note: The amount of latitude depends on the camera, the bit depth, the file format, and the amount of
compression applied during capture. For optimum results, you should shoot your images within 1.5

stops of a balanced exposure.

@ To correct the exposure of an image

1. Select an image.

2. In the Exposure area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Exposure parameter by doing one of the following:

e Drag the Exposure slider.

e Click the left or right arrow in the Exposure value slider to change the exposure of the image by 5
percent increments, or drag in the value field.

e Double-click the number in the Exposure value slider, then enter a value from -9.99 to 9.99 stops and
press Return.

| v ¥ Exposure (Auim} » 0.
i » 00 » Use the Exposure slider

Recavery: Jr— (= a0 ) and value slider to comect
the image's exposure,

Bk POIATL, e e (% 0+ ]
Brightness: i, s 0o«

Expos e W,

A negative value decreases the exposure (darkening the image), and a positive value increases the
exposure (lightening the image).

The exposure of the image is updated as you change the parameter value.
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Recovering Highlight Details in the Image

Many images, especially RAW image files, have additional highlight detail that isn’t displayed by default.
Aperture provides the Recovery parameter controls to give you access to that additional headroom.
Because digital image sensors differ from camera model to camera model, the highlight headroom
varies. In some cases, you can recover significant detail that appears lost or blown out in the most
extreme highlight areas of the image.

Note: The Recovery controls are not available for RAW decoding versions 1.0 and 1.1. To make the
Recovery controls available, reprocess the image. For more information, see “Working with the RAW Fine
Tuning Controls.”

@ To recover highlight details in the image

1. Select an image.

2. In the Exposure area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Recovery parameter by doing one of the following:

e Drag the Recovery slider.

e Click the left or right arrow in the Recovery value slider to change the amount of highlight detail to
recover in the image by 5 percent increments, or drag in the value field.

e Double-click the number in the Recovery value slider, then enter a value from 0.0 to 1.5 and press

Return.
| * ¥l Exposure TR
Exposure: i 0l
Rucownry: {5 00 ¥ Lise the Recovery slider
Blbek Point; s re— (= 00 ¢ and value slider to
Brightads; 2 f+ 00 ¢} recover highlight detail,

The higher the value, the more highlight information is made available, and the more highlight detail is
recovered.

The image’s highlights are updated as you change the parameter value.
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Setting the Image’s Blacks

Shadow detail and the importance of visual elements in shadow vary from image to image. In addition,
some cameras are more capable of capturing shadow details than others. In some photos, such as an
image of a person’s face in the shadow of an alley, the shadow is the most important visual element in
the image. In other images, the details in the shadows have nothing to do with the main subject of the
image. For example, the shadow area of the image may obscure trash that would otherwise ruin a
pristine image. In Aperture, you use the Black Point parameter controls to increase the threshold of
shadow details in the image as well as crush the blacks when necessary.

Note: The Black Point controls are not available for RAW decoding versions 1.0 and 1.1. To make the
Black Point controls available, reprocess the image. For more information, see “Working with the RAW
Fine Tuning Controls.”

@ To set the black point of the image

1. Select an image.

2. In the Exposure area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Black Point parameter by doing one of the following:

e Drag the Black Point slider.

e Click the left or right arrow in the Black Point value slider to change the shadow detail to recover in
the image by 5 percent increments, or drag in the value field.

e Double-click the number in the Black Point value slider, then enter a value from -5.0 to 50.0 and
press Return.

| * ¥ Exposure Chgmi n B
Expesiire: i ok - Use the Black Paint slider
Recovery: (+ 00 ¥ and value slider to set
Black Point; = rm— s 00 -] pure black in the image.
Arightaess: i T TED

Decreasing the value increases the amount of detail in the shadow areas by moving pure black below the
current black point. Increasing the value decreases the amount of detail in the shadow areas of the
image, effectively crushing the blacks by moving pure black above the current black point.

The image’s black point is updated as you change the parameter value.
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Adjusting Brightness in the Image

You can adjust the Brightness parameter when you want to lighten or darken your image. When you
adjust brightness, the brightness values of the midtone pixels in the image change the most. You can
change the brightness of the image temporarily to see how the adjustment affects details in the
shadows, midtones, and highlights. For more precise control over the range of tonality in the image,
consider using the Levels adjustment controls. For more information about adjusting levels, see
“Working with the Levels Controls.”

Before Brighiness adjustment After Brightness adjustment

@ To adjust brightness in an image

1. Select an image.

2. In the Exposure area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Brightness parameter by doing one of the following:

e Drag the Brightness slider.

e Click the left or right arrow in the Brightness value slider to change the brightness of the image by 5
percent increments, or drag in the value field.

e Double-click the number in the Brightness value slider, then enter a value from -2.0 to 2.0 and press

Return.
¥ [# Exposure Aol % O,
Expsors e i T
R (e (= 0D # Use the Brightness slidar
Black Palnt; ={jr— (= 00 - and value slider to lighten
Brightnaoss - « on - and darken the image.

A value below 0.0 decreases the brightness of the image. A value greater than 0.0 increases the
brightness of the image. The brightness of the image is updated as you change the parameter value.
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Working with the Enhance Controls

You use the Enhance adjustment controls to set the contrast, definition, saturation, and vibrancy, as well
as the black, gray, and white tint values.

You can also brush the Enhance adjustment on selected parts of an image. For more information, see
“Making Brushed Adjustments.”
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Adjusting Contrast in the Image

If you want to adjust the difference between the dark and bright areas of the image, you can modify the
Contrast parameter. An image with very little midtone tonality is considered to have a lot of contrast,
whereas an image with considerable midtone tonality is considered to have minimal contrast. Often, an
image with too much midtone tonality looks flat. Adding contrast to the image can add depth to it.
However, you add contrast to the image at the expense of detail in the midtones, so a little contrast goes
a long way.

Before Contrast adjustment After Contrast adjustment

@ To adjust the contrast in an image

1. Select an image.

2. In the Enhance area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Contrast parameter by doing one of the following:

e Drag the Contrast slider.

e Click the left or right arrow in the Contrast value slider to change the contrast of the image by 5
percent increments, or drag in the value field.

e Double-click the number in the Contrast value slider, then enter a value from -1.0 to 1.0 and press

Return.
* ¥ Entance 5 &
Cantrast: i (“ 08 - —— Use the Contrast slider
Definitlon: Gr——————— (= 03 +) and value slider to
: o < 1m + modify the cantrast
Wibrancy: o o ») between light and dark
" Tint calors in the image.

A value below 0.0 decreases the contrast in the image. A value greater than 0.0 increases the contrast in
the image. The contrast in the image is updated as you change the parameter value.

Note: If you're trying to retrieve detail in a high-contrast image, you should use the Highlights &
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Shadows controls. For more information, see “Working with the Highlights & Shadows Controls.”
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Adjusting Definition in the Image

When you want to add a little clarity and definition to an image without adding too much contrast, you
use the Definition parameter controls. The Definition parameter is useful for adding local contrast
(adding contrast to areas of the image that are improved by a contrast adjustment without affecting the
image’s global contrast) as well as reducing haze.

Before Definition adjustment After Definition adjustment

@ To adjust definition in an image

1. Select an image.

2. In the Enhance area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Definition parameter by doing one of the following:

e Drag the Definition slider.

e Click the left or right arrow in the Definition value slider to change the clarity of the image by 5
percent increments, or drag in the value field.

e Double-click the number in the Definition value slider, then enter a value from 0.0 to 1.0 and press

Return.
| » & Enkance 5 8
COMMIAL m— e 00 ]
Defation: | — T Use the Definition
SALUHUION; e e [ L0 slider and value slider
YRranCY, e e, = 0D to add local contrast
* Tint to the image.

A value greater than 0.0 increases the clarity in the image. The definition in the image is updated as you
change the parameter value.
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Adjusting Saturation in the Image

You can change the value for the Saturation parameter to either give your image an extra burst of color
or tone down the color palette by desaturating the image.

Before Saturation adjustment After Saturation adjustment

@ To change the saturation of an image

1. Select an image.

2. In the Enhance area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Saturation parameter by doing one of the following:

e Drag the Saturation slider.

e Click the left or right arrow in the Saturation value slider to change the saturation of the image by 5
percent increments, or drag in the value field.

e Double-click the number in the Saturation value slider, then enter a value from 0.0 to 4.0 and press

Return.
w i Enharce " & LUse the Saturation slider
Conmast o T D and value slider to adjust
Defnition: [ (= 00 +| the saturation of colors
Saturatian " “ 18 ‘——jn the image.
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= Timt

A value below 1.0 decreases the color saturation in the image, and a value above 1.0 increases the
saturation. A value of 0.0 removes all color from the image, making it grayscale. A value of 4.0 increases
the saturation by 400 percent.

The saturation of the image is updated as you change the parameter value.

A Little Saturation Goes a Long Way

Increasing the saturation of an image can make the colors appear more pure, and many people like
the effect of an image whose colors are more saturated than they would appear naturally. However,
you can easily oversaturate an image. In the process of making the colors more pure, subtleties in
shades of colors disappear, often resulting in reduced detail in the image. To ensure that visual
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elements aren’t unnecessarily lost, pay attention to the details in your image as you increase
saturation.
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Adjusting Vibrancy in the Image

You use the Vibrancy parameter controls when you want to add a bit of punch to the image without
affecting skin tones. The Vibrancy parameter applies saturation to the image in a nonlinear manner.
Colors that are already saturated are left alone, while saturation is added to all other colors. In addition,
the Vibrancy parameter takes skin tones into account, leaving them untouched. This allows you to take a
portrait and desaturate the image except for the skin tones.

Before Vibrancy adjustment After Vibrancy adjustment
[reduced saturation except for
the skin tones)

@ To adjust vibrancy in an image
1. Select an image.

2. In the Enhance area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, adjust
the Vibrancy parameter by doing one of the following:

e Drag the Vibrancy slider.

e Click the left or right arrow in the Vibrancy value slider to change the saturation of the image by 5
percent increments, or drag in the value field.

e Double-click the number in the Vibrancy value slider, then enter a value from -1.0 to 1.0 and press

Return.
v (4 Enkance Lt
Condrast: i T Use the Vibrancy slider
Defamion: f* o + and value slider to add
Sakuration: i s 1o « smart saturation to
warancy: o < an - —— the image.
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A value below 0.0 decreases the color saturation in the image, and a value above 0.0 increases the
saturation of the nonsaturated colors. A value of -1.0 removes all color from the image, making it
grayscale except for any skin tones.
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Setting the Tint of Black, Gray, and White Values in the Image

You use the Black Tint, Gray Tint, and White Tint color wheels when you want to selectively remove color
casts from the shadows, midtones, and highlights in the image. Color casts are often caused by shooting
in mixed lighting and unnatural lighting situations, where the difference in the color from the mixture of
multiple types of source lights can produce a color variance in a specific tonal range in an image. For
example, when shooting indoors, interior incandescent (tungsten) lighting can often produce a yellow
color cast through the white colors in the image. Using the White Tint eyedropper, you can have Aperture
isolate the highlights and add blue to the white values, thereby reducing the yellow color cast and
returning the whites to neutral white.

There are two methods for selectively adjusting the tint values in an image: you can use the Black Tint,
Gray Tint, and White Tint eyedroppers to have Aperture automatically adjust the tint to neutral color
values, or you can use the Black Tint, Gray Tint, and White Tint color wheels to manually adjust the tint
values. The method you choose is determined by the level of precision you require. The eyedroppers
provide an accurate means of identifying the color cast within the tonal range of each eyedropper and
returning the color values to neutral. However, depending on the subject, you may not want to
completely remove the color cast found in a specific tonal range. Therefore, you can manually adjust the
tint values in the shadows, midtones, and highlights using the Black Tint, Gray Tint, and White Tint color
wheels.

For more information about using the eyedroppers to adjust the black, gray, and white tints in the
image, see “Using the Eyedroppers to Set the Tint in an Image.”

For more information about manually adjusting the black, gray, and white tints in the image, see
“Manually Setting the Tint in an Image.”
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Using the Eyedroppers to Set the Tint in an Image

You use the Black Tint, Gray Tint, and White Tint eyedropper tools when you want to have Aperture
selectively modify the tints of the shadows, midtones, and highlights in an image automatically. Whereas
using the White Balance controls adjusts the tints of all tonal values in the image uniformly, the Black
Tint, Gray Tint, and White Tint eyedropper tools allow you to selectively neutralize color casts that affect
only the shadows, midtones, or highlights. In some difficult cases, you can use the Black Tint, Gray Tint,
and White Tint eyedropper tools in combination with the White Balance controls to first neutralize a tint
in a specific tonal range and then uniformly remove the tint from the rest of the image. For more
information about adjusting white balance, see “Working with the White Balance Controls.”

You use the Black Tint eyedropper to remove color casts from the shadows in your images.

Before Black Tint ad justiment After Black Tint adjustment

@ To set the tint of the shadows in an image
1. Select an image.

2. If necessary, click the Tint disclosure triangle in the Enhance area of the Adjustments inspector or the
Adjustments pane of the Inspector HUD to reveal the Tint color wheels, then select the Black Tint
eyedropper.

* [l Dnhanee w o
Comtrags; = |« 0.0
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Click the disclosure
triangle to reveal

O :ﬂ I the Tint color wheels,

Back # | | Gray & [ white # |

Select the Black Tint
eyedropper to activate
the Loupe.

The pointer changes to the Loupe, showing a magnified view of the target area. By default, the Loupe is
set to magnify the image to 100 percent (full size). If necessary, you can increase the magnification of
the Loupe by pressing Command-Shift-Plus Sign (+). For more information about the Loupe, see
“Viewing Images with the Loupe.”
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3. Position the target area of the Loupe over the darkest pixels in the image, then click.

The tint (hue and saturation) of the black values in the image is set to remove the color cast in the
shadows.

Important: Make sure that there are no bright pixels in the target area of the Loupe. Bright pixels in the
target area can skew the Black Tint calculation, making the image look different than intended. A simple
way to avoid errant bright pixels is to increase the magnification of the Loupe by pressing Command-
Shift-Plus Sign (+).

You use the Gray Tint eyedropper to remove color casts from the midtones in your images.

Before Gray Tint adjustment After Gray Tint adjustment

@ To set the tint of the midtone values in an image

1. Select an image.

2. If necessary, click the Tint disclosure triangle in the Enhance area of the Adjustments inspector or the
Adjustments pane of the Inspector HUD to reveal the Tint color wheels, then select the Gray Tint
eyedropper.
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| ™ ¥ Enhance - o
| Contrast: v = om =)
Defiition: [ = an |

| saturasion: " = 10 &
Gt +)

| = S - —— Click the disclosure

I triangle to reveal
the Tint color wheels,
|
( magk 2

[ white # |

Select the Gray Tint
eyedropper to activate
the Loupe.

The pointer changes to the Loupe, showing a magnified view of the target area. By default, the Loupe is
set to magnify the image to 100 percent (full size). If necessary, you can increase the magnification of
the Loupe by pressing Command-Shift-Plus Sign (+). For more information about the Loupe, see
“Viewing Images with the Loupe.”

3. Position the target area of the Loupe over a midrange color that is as close as possible to medium gray,
then click.

The tint (hue and saturation) of the gray values in the image is set to remove the color cast in the
midtones.

You use the White Tint eyedropper to remove color casts from the highlights in your images.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=47 Page 3 of 5

Petitioner Apple Inc. - Ex. 1005, p. 646



Aperture 3 User Manual: Using the Eyedroppers to Set the Tint in an Image 9/28/21 12:56 PM

Before White Tint adjustment After White Tint adjustment

@ To set the tint of the highlight values in an image
1. Select an image.

2. If necessary, click the Tint disclosure triangle in the Enhance area of the Adjustments inspector or the
Adjustments pane of the Inspector HUD to reveal the Tint color wheels, then select the White Tint

eyedropper.
¥ ¥ Emhance L
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{ \ the Tint color wheels.

Select the White Tint
eyvedropper to activate
the Loupe.

The pointer changes to the Loupe, showing a magnified view of the target area. By default, the Loupe is
set to magnify the image to 100 percent (full size). If necessary, you can increase the magnification of
the Loupe by pressing Command-Shift-Plus Sign (+). For more information about the Loupe, see
“Viewing Images with the Loupe.”

3. Position the target area of the Loupe over the lightest (white) pixels in the image, then click.
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The tint (hue and saturation) of the white values in the image is set to remove the color cast in the
highlights.

Important: Make sure that there are no dark pixels in the target area of the Loupe. Dark pixels in the
target area can skew the White Tint calculation, making the image look different than intended. A simple
way to avoid errant dark pixels is to increase the magnification of the Loupe by pressing Command-
Shift-Plus Sign (+).

Copyright © 2009 Apple Inc. All rights reserved.
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Manually Setting the Tint in an Image
You can also manually adjust the tint of the shadow, midtone, and highlight values in an image using the
Black Tint, Gray Tint, and White Tint color wheels.

@ To manually adjust the tint of the shadow, midtone, and highlight values in an image

1. Select an image.

2. If necessary, click the Tint disclosure triangle in the Enhance area of the Adjustments inspector or the
Adjustments pane of the Inspector HUD, then do the following:

e To adjust the tint of the shadows: Drag the Black point in the Black Tint color wheel.

e To adjust the tint of the midtones: Drag the Gray point in the Gray Tint color wheel.

e To adjust the tint of the highlights: Drag the White point in the White Tint color wheel.
¥ & Cnharce - 0
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Drag the Black, Gray,

! 3 and White points
U {white circles) ta
selectively adjust the
tint of the image.

Click the disclosura
triangle to reveal the
Tint color wheels.

You remove a color cast in a tonal range by dragging the point in the color wheel toward the opposite
color. For example, to remove a blue cast, you drag the point in the color wheel toward yellow until the
color cast is neutralized.
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Resetting the Tint Color Wheels

You can individually reset the Tint color wheels without affecting the other parameters in the Enhance
area of the Adjustments inspector or the Adjustments pane of the Inspector HUD.

@ To reset a Tint color wheel

B Double-click the color wheel.

|| ¥ [ Embance u o
[« : O (= Ga *)
Do fissrini v IW\-I
Saturatian: ik (g =
Vibeangy: i = on =
* Tint
6 G 0——Dauble-cl'rck a color
wheel to reset it to its
T e L | default valua,
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Working with the Chromatic Aberration Controls

When you want to fix chromatic aberration, also known as purple fringing, you use the Chromatic
Aberration adjustment controls. For example, if your image has a ghost image in high-contrast
boundary areas, you use the Chromatic Aberration adjustment controls to neutralize the color fringing.
Chromatic aberration can be caused by a poorly designed lens that fails to focus light at the correct
point on the focal plane when the lens is set at different focal lengths. Certain types of light sources can
also cause chromatic aberration.

Before Chromatic Aberration adjustment After Chromatic Aberration adjustment
(increased cyan)

Important: The Chromatic Aberration adjustment controls are available only for images using Aperture 3
image processing. For more information about reprocessing your images, see “Reprocessing Images
from Previous Versions of Aperture.”

@ To remove chromatic aberration from an image

1. Select an image.
2. If the Chromatic Aberration controls are not shown in the Adjustments inspector or the Adjustments
pane of the Inspector HUD, choose Chromatic Aberration from the Adjustments pop-up menu.
3. If your image exhibits red or cyan fringing, neutralize it by doing one of the following:
e Drag the Red/Cyan slider to the right to add cyan, neutralizing the red fringing, or drag the slider to
the left to add red, neutralizing the cyan fringing.
e Click the left or right arrow in the Red/Cyan value slider, or drag in the value field.
e Double-click the number in the Red/Cyan value slider, then enter a value from -5.0 to 5.0 and press
Return.
| ¥ Cheomaric Alsrrration 5 & Use the Red/Cyan slider and
Red/ Cyan i (« 00 value slider to neutralize red
Rluse Yo llcre o S 08 and cyan fringing.
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4. If your image exhibits blue and yellow fringing, neutralize it by doing one of the following:

e Drag the Blue/Yellow slider to the right to add yellow, neutralizing the blue fringing, or drag the slider
to the left to add blue, neutralizing the yellow fringing.

e Click the left or right arrow in the Blue/Yellow value slider, or drag in the value field.

e Double-click the number in the Blue/Yellow value slider, then enter a value from -5.0 to 5.0 and press
Return.

¥ ¥l Chramatic Abeeratian n 8. Use the BlueYellow slider and
Red |/ Cyan: . (= 0a o value slider to neutralize blue
Blua /Y ellow, s————— = 0 - and yellow fringing.

The chromatic aberration is removed from the image.

You can also brush the Chromatic Aberration adjustment on selected parts of an image. For more
information, see “Making Brushed Adjustments.”

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=50 Page 2 of 2

Petitioner Apple Inc. - Ex. 1005, p. 652



Aperture 3 User Manual: Working with the Noise Reduction Controls 9/28/21 12:56 PM

Working with the Noise Reduction Controls

You use the Noise Reduction adjustment controls when you need to reduce digital noise in an image.
Digital noise is often caused by shooting at high ISO settings in low-light conditions. When you reduce
noise in an image, you often have to sharpen the image to prevent blurry edges or loss of detail. For
more information about sharpening an image, see “Working with the Edge Sharpen Controls.”

Before Noise Reduction adjustment After Noise Reduction adjustiment

@ To reduce digital noise in an image

1. Select an image.

2. If the Noise Reduction controls are not shown in the Adjustments inspector or the Adjustments pane of
the Inspector HUD, choose Noise Reduction from the Adjustments pop-up menu (or press Control-N).

3. Reduce digital noise in the image by doing one of the following:

e By default, the Radius slider is set to the left side of the slider control. Drag the Radius slider to the
right to decrease digital noise in the image, or drag the slider back to the left to reduce the effect of
the noise reduction.

e Click the left or right arrow in the Radius value slider to adjust noise in the image by 5 percent
increments, or drag in the value field.

The left arrow increases noise in the image, and the right arrow decreases it.

e Double-click the number in the Radius value slider, then enter a value from 0.0 to 2.0 and press
Return.
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¥ [ Noise Redisgtion - @, Lise the Radius slider and
Radius: = s ny + value slider to decrease the
Edge Detail i fe 15 » digital noke in the image,

Use the Edge Detail slider
and value slider to maintain
details in areas of contrast.

A value of 0.0 applies no digital noise adjustment to the image. A value greater than 0.0 reduces digital
noise in the image.

4. Maintain edge detail in areas of high contrast in the image by doing one of the following:

e Drag the Edge Detail slider to the right to increase sharpness in areas of the image with high contrast,
or drag the slider back to the left to reduce the sharpening effect.

e Click the left or right arrow in the Edge Detail value slider to adjust edge detail by 5 percent
increments, or drag in the value field.

The left arrow decreases edge detail sharpening in the image, and the right arrow increases it.

e Double-click the number in the Edge Detail value slider, then enter a value from 0.0 to 3.0 and press
Return.

As you change the parameter value, the image is updated to display the amount of edge detail
sharpening applied to it.

You can also brush the Noise Reduction adjustment on selected parts of an image. For more information,
see “Making Brushed Adjustments.”

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=51 Page 2 of 2

Petitioner Apple Inc. - Ex. 1005, p. 654



Aperture 3 User Manual: Working with the Highlights & Shadows Controls 9/28/21 12:56 PM

Working with the Highlights & Shadows Controls

You use the Highlights & Shadows adjustment controls to correct the exposure in images shot in
complex lighting conditions. For example, you can use the Highlights & Shadows controls to correct the
exposure of the darker areas (shadows) of an image that was otherwise correctly exposed for silhouette.
You can also use the Highlights & Shadows controls to retrieve detail in extremely bright areas of an
image. This is particularly useful when adjusting images of clouds or snow, or images correctly exposed
for the shadow areas. Using the Highlights & Shadows controls is the best way to optimize your image’s
exposure in the highlights, midtones, or shadows without compromising detail in the other areas of
tonality.

You can also brush the Highlights & Shadows adjustment on selected parts of an image. For more
information, see “Making Brushed Adjustments.”
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Adjusting Brightness Values in the Highlight Areas of the Image

When you want to adjust the brightness values in the highlight areas of the image without affecting the
midtones and shadows, you can adjust the Highlights parameter. Although the human eye is more
sensitive to details in shadow areas than in highlight areas, such as snow, there is usually a fair amount
of visual information that you can retrieve in the highlights using the Highlights parameter controls.
Another example of when to use the Highlights controls is when the background of your image is
correctly exposed, and the foreground of the image is slightly overexposed. In this case, you use the
Highlights controls to make the overexposed foreground match the exposure of the correctly exposed
background.

Before Highlights adjustment After Highlights adjustment

© To adjust the highlights in an image

1. Select an image.

2. In the Highlights & Shadows area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, adjust the Highlights parameter by doing one of the following:

e By default, the Highlights slider is set to the left side of the slider control. Drag the slider to the right
to darken the highlight areas of the image, and drag the slider back to the left to reduce the
darkening effect in the highlights.

e Click the left or right arrow in the Highlights value slider to change the brightness of the highlights in
the image by 5 percent increments, or drag in the value field.

The left arrow reduces the darkening effect in the highlights, making them brighter. The right arrow
increases the darkening effect in the highlights, making them darker.

e By default, the Highlights value slider is set to 0.0. Double-click the number in the value slider, then
enter a value from 0.0 to 100.0 and press Return.
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v i Highlights & Shadows LA - N
Highlights | OETED: Use the Highlights slider and value
Shadows: (= 00 *) slider to adjust the brightness
* Advanced values in the images highlights.

Aperture isolates the areas of the image with highlights and updates them as you change the parameter
value.
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Adjusting Brightness Values in the Shadow Areas of the Image

Adjusting the shadow areas is necessary when the shadow areas in an image are underexposed. A good
example is an image shot in a doorway, where the background is correctly exposed but the foreground
is a little underexposed. Adjusting the shadows lightens the pixels in the shadow areas only, bringing
out detail that would normally have been shades of black or dark gray.

Before Shadows adjustment After Shadows adjustment

@ To adjust the shadows in an image

1. Select an image.

2. In the Highlights & Shadows area of the Adjustments inspector or the Adjustments pane of the Inspector
HUD, adjust the Shadows parameter by doing one of the following:

e By default, the Shadows slider is set to the left side of the slider control. Drag the slider to the right to
lighten the shadow areas of the image, and drag the slider back to the left to reduce the lightening
effect in the shadows.

e Click the left or right arrow in the Shadows value slider to change the brightness of the shadows in the
image by 5 percent increments, or drag in the value field.

The left arrow reduces the lightening effect in the shadows, making them darker. The right arrow
increases the lightening effect in the shadows, making them lighter.

e By default, the Shadows value slider is set to 0.0. Double-click the number in the value slider, then
enter a value from 0.0 to 100.0 and press Return.

* (5 Mighlights & Shadews 5 8. Use the Shadows slider and value
Highlights: m———— = 00 | slider to adjust the brightness
Shadows: (e - 00 ) values in the image’s shadows.
* Agvasced

Aperture isolates the shadow areas of the image and updates them as you change the parameter value.
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Using the Highlights & Shadows Advanced Settings

The Highlights & Shadows adjustment includes the following advanced parameters:

* [ Mighlights & Shadaws. L -

Highlghvts: = e =

Shadons: CET D
¥ Advanced

Rasdiuiy; s e [+ 20000+ )
Celor Corrucmin: m—e— s 00+
High Tonal width: _'\J_ (e 400 »

e —

Mid G . (= ‘pax o)
Low Tonal Widih: ss———p— s 400 =

Click the disclosure triangle to
reveal the advanced Highlights
& Shadows controls.
e Radius: Sets the area Aperture uses to determine each pixel’s tonality.
For more information, see “Adjusting the Radius of the Highlights & Shadows Controls.”
e (Color Correction: Sets the amount of saturation applied during a Shadows or Highlights adjustment.
For more information, see “Adjusting the Color for Highlights & Shadows Controls.”
e High Tonal Width: Sets the range of tones that are modified in the highlights.
For more information, see “Adjusting High Tonal Width for Highlights & Shadows Controls.”
e Mid Contrast: Sets the amount of contrast in the midtones.
For more information, see “Adjusting Midtone Contrast for Highlights & Shadows Controls.”
e [ow Tonal Width: Sets the range of tones that are modified in the shadows.

For more information, see “Adjusting Low Tonal Width for Highlights & Shadows Controls.”
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Adjusting the Radius of the Highlights & Shadows Controls

You use the Radius parameter controls to adjust the area around each pixel that Aperture uses to assess
the tonal area that each pixel inhabits. The larger the Radius value is, the larger the area used to
determine each pixel’s tonality. The Radius controls can have a large impact on the behavior of the
Highlights & Shadows controls, because the Radius controls either increase or decrease the range of
pixels used to determine how light or dark each individual pixel should be.

@ To adjust the radius of the Highlights & Shadows controls

1. If necessary, click the Advanced disclosure triangle to show the advanced Highlights & Shadows controls
in the Adjustments inspector or the Adjustments pane of the Inspector HUD.

* Wl Highlights & Shadows LN
Highlighas: T
Shadows: | (= 04 »
¥ Advanced
Radius: i (= 300.0 - Use the Radius slider and
Colar Cotrettion: m——j——— = 0.0 * value slider to adjust the
High Tonal Width: s e (= 400 | area used to determine
Mid Contrast N — (RO a pixel’s tonality.
Low Toaal Width: i (= 200 +

2. Adjust the Radius parameter by doing one of the following:

e Drag the slider to the right to increase the radius of the area Aperture uses to assess whether the
pixel requires a Highlights or Shadows adjustment, and drag the slider back to the left to reduce the
radius.

e Click the left or right arrow in the Radius value slider to adjust the radius incrementally, or drag in the
value field.

The left arrow reduces the radius of the pixel area, and the right arrow increases it.

e By default, the Radius value slider is set to 200.00. Double-click the number in the Radius value slider,
then enter a value from 1.0 to 1000.0 and press Return.

Aperture uses the new Radius setting to determine each pixel’s tonality in relation to the pixels that
surround it.
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Adjusting the Color for Highlights & Shadows Controls

You use the Color Correction parameter controls to adjust the amount of saturation applied during
Highlights and Shadows adjustments. However, the saturation adjustment is most noticeable in the
shadows.

Before Color Correction adjustment After Color Correction adjustment
(increased color correction)

@ To adjust the saturation applied during Highlights and Shadows adjustments

1. If necessary, click the Advanced disclosure triangle to show the advanced Highlights & Shadows controls
in the Adjustments inspector or the Adjustments pane of the Inspector HUD.

* ¥ Highlights & Shadows. 5 9.
Highlights: TR
Shadovw: [ je— (e 00 ¢ Use the Color Carraction
¥ Advanced slider and value slider
Riad|iil ! e ey (= 2000 ¢ te adjust the amount
Color COmpcTion! ———— j—— = 00+ of saturation applied
High Tonal Width: s — (= 40.0 ¢ during highlights and
Wil CONERAR ) e e (& DD ) shadows adjustments,
Low Tomal Width: s — 0.0 -

2. Adjust the Color Correction parameter by doing one of the following:

e Drag the Color Correction slider to the right to increase the amount of saturation applied during
Highlights and Shadows adjustments, and drag the slider back to the left to reduce the saturation.

e Click the left or right arrow in the Color Correction value slider, or drag in the value field.
The left arrow reduces the saturation, and the right arrow increases it.

e By default, the Color Correction value slider is set to 0.0. Double-click the number in the Color
Correction value slider, then enter a value from -100.0 to 100.0 and press Return.

The new Color Correction setting determines the amount of saturation applied to the highlights and
shadows during Highlights and Shadows adjustments.
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Adjusting High Tonal Width for Highlights & Shadows Controls

You use the High Tonal Width parameter controls to set the range of highlights that Aperture adjusts
with the Highlights controls. Increasing the High Tonal Width parameter value widens the range of
highlight tonal values that are adjusted toward the midtones. If you want to limit the Highlights
adjustment to a range of highlight values that are closer to white, you decrease the High Tonal Width
parameter value.

Before High Tonal Width adjustment After High Tonal Width adjustment
(increased high tonal width)

@ To adjust the high tonal width of the Highlights & Shadows controls

1. If necessary, click the Advanced disclosure triangle to show the advanced Highlights & Shadows controls
in the Adjustments inspector or the Adjustments pane of the Inspector HUD.

* [ Highlights & Shadows n 8.
Highlights: [Jim—— (5 00 ¢
Shacows: |k « %o o] Lise the High Tonal Width
¥ Advanced slider and value slider to
Bari — e (7 2000+ adjust the range of highlight
Color Correction = (= 0 =] tonal values affected by a
High Tanal Witth: s —— (= 400 - Highlights adjustment.
Mid COAREE m— . (5 00
Lirw Tanal Witith! s —— 400 «]

2. Adjust the High Tonal Width parameter by doing one of the following:

e Drag the High Tonal Width slider to the right to increase the tonal range of the Highlights adjustment,
and drag the slider back to the left to reduce the tonal range.

e Click the left or right arrow in the High Tonal Width value slider to adjust the tonal range of the
Highlights adjustment by 5 percent increments, or drag in the value field.

The left arrow reduces the tonal range, and the right arrow increases it.

e By default, the High Tonal Width value slider is set to 40.0. Double-click the number in the High Tonal
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value slider, then enter a value from 0.0 to 100.0 and press Return.

Aperture uses the new High Tonal Width setting to determine the range of highlight tonal values that are
taken into account during a Highlights adjustment. The tonal range begins at pure white, and increasing

the High Tonal Width parameter value broadens the tonal range to include tonal values closer to the
midtones.
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Adjusting Midtone Contrast for Highlights & Shadows Controls

You use the Mid Contrast parameter controls to adjust the contrast of the midtones.

@ To adjust the midtone contrast of the Highlights & Shadows controls

1. If necessary, click the Advanced disclosure triangle to show the advanced Highlights & Shadows controls
in the Adjustments inspector or the Adjustments pane of the Inspector HUD.

¥ [} Highlights & Shadows n O

Highlights. [ j—————— [ .0 =]
Shadows: b SRR

¥ Advanced Use the Mid Contrast
RIS | ] (2 2000+ slider and value slider
Color Comection s jm—— s 0.0 to adjust the contrast
High Tanal Width! ——i———— = 400 = of the midtone values
Mid CoNtrass: s—— e 0.0 in the image.

Low Tanal Wighl = [« 400 =]

2. Adjust the Mid Contrast parameter by doing one of the following:

Drag the Mid Contrast slider to the right to increase the contrast Aperture applies to the midtones in
the image, and drag the slider back to the left to reduce the contrast.

Click the left or right arrow in the Mid Contrast value slider, or drag in the value field.
The left arrow reduces the contrast in the midtones, and the right arrow increases it.

By default, the Mid Contrast value slider is set to 0.0. Double-click the number in the Mid Contrast
value slider, then enter a value from -100.0 to 100.0 and press Return.

The contrast in the midtones is updated as you change the parameter value.
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Adjusting Low Tonal Width for Highlights & Shadows Controls

You use the Low Tonal Width parameter controls to set the range of shadows that Aperture adjusts with

the Shadows controls. Increasing the Low Tonal Width parameter value widens the range of shadow tonal
values that are adjusted toward the midtones. If you want to limit the Shadows adjustment to a range of
shadow values that are closer to black, you decrease the Low Tonal Width parameter value.

Before Low Tonal Width adjustment After Low Tonal Width adjustment
{increased low tonal width)

@ To adjust the low tonal width of the Highlights & Shadows controls

1. If necessary, click the Advanced disclosure triangle to show the advanced Highlights & Shadows controls
in the Adjustments inspector or the Adjustments pane of the Inspector HUD.

* [+ Highlights & Shadows " 8.
Highlights: [jr————————————— (= 00 *|
Ehadaws: [r—— = 00
T Adwanced
RIS, e o (7 2000 Use the Low Tonal Width
Color Commeclion s p— 0o slider and value slider to
High Tanal WIth; s e— 400 * adjust the range of shadow
Mid CONrast m——— (= 00+ tonal values affected by
Lirws Tanal WIS s s, (= 408+ —— 3 Shadows adjustment,

2. Adjust the Low Tonal Width parameter by doing one of the following:

e Drag the Low Tonal Width slider to the right to increase the tonal range of the Shadows adjustment,
and drag the slider back to the left to reduce the tonal range.

e Click the left or right arrow in the Low Tonal Width value slider to adjust the tonal range of the
Shadows adjustment by single increments, or drag in the value field.

The left arrow reduces the tonal range, and the right arrow increases it.

e By default, the Low Tonal Width value slider is set to 40.0. Double-click the number in the Low Tonal
Width value slider, then enter a value from 0.0 to 100.0 and press Return.

Aperture uses the new Low Tonal Width setting to determine the range of shadow tonal values that are
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taken into account during a Shadows adjustment. The tonal range begins at pure black, and increasing
the Low Tonal Width parameter value broadens the tonal range to include tonal values closer to the

midtones.
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Working with the Curves Controls

You use the Curves adjustment controls when you want to manually set the tonal values of the shadows,
midtones, and highlights in an image using a tonal curve. Unlike the Levels adjustment controls, the
Curves controls do not reapportion the luminance values in the image by constraining the white and
black points. Instead, you use the Curves controls to precisely remap the position of the midtones
relative to the white and black points. Because the human eye’s perception of light is logarithmic rather
than incremental, a curve is necessary to distribute the luminance values across all tonal ranges in an
image in a way that matches how the eye perceives light in nature.

In addition to adjusting the tonal values of an image for overall luminance, you can also color correct an
image by applying the Curves adjustment to the red, green, and blue channels independently. Applying a
Curves adjustment to each color channel allows you to control the color tonality in an image.

You can also have Aperture automatically identify tonal ranges in an image using the Black Point, Gray
Point, and White Point eyedropper tools in the Curves adjustment controls. When you select a tonal range
using one of the eyedropper tools, Aperture plots the corresponding curve over the Curves histogram.

You can also brush the Curves adjustment on selected parts of an image. For more information, see
“Making Brushed Adjustments.”

Important: The Curves adjustment controls are only available for images using Aperture 3 image
processing. For more information about reprocessing your images, see “Reprocessing Images from
Previous Versions of Aperture.”
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An Overview of the Curves Adjustment Controls

Before applying a Curves adjustment, it’s a good idea to get acquainted with the Curves adjustment

controls.
Auro Curves Combined Auto Curves Separate
button —— buiton
i i Qe Lem® > 8| 1dd Point button

Black Point, Gray Point,
and White Point
eyedropper buttons

Channel pop-up menu

In and Out fields

T |
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Range pop-up menu

e Channel pop-up menu: Choose a color channel to apply a tonal curve to from this pop-up menu. You
can also apply the tonal curve to all color channels combined, as well as show separate color channel
overlays when tonal curve adjustments are applied to individual color channels.

e Auto Curves Combined button: Click this button to apply a tonal curve adjustment when you want to
correct contrast based on total luminance, without affecting the color cast of the image.

e Auto Curves Separate button: Click this button to apply a tonal curve adjustment when you want to
correct contrast as well as remove color casts in the image.

e Black Point eyedropper tool: Use this eyedropper to set the black point in the image.
e Gray Point eyedropper tool: Use this eyedropper to set the gray point in the image.
e White Point eyedropper tool: Use this eyedropper to set the white point in the image.

e Add Point button: Click this button to use the Loupe to sample pixels in the image and then add a
point to the tonal curve for each color channel as well as the RGB tonal curve.

e /n and Out fields: Enter the In and Out point values for a selected point on the tonal curve. The In
point represents the horizontal axis (x-axis), and the Out point represents the vertical axis (y-axis).

e Range pop-up menu: Choose a viewing range option from this pop-up menu. Choosing Shadows
restricts the view of the histogram and tonal curve from pure black to 50 percent gray. Choosing
Normal presents the view of the histogram and tonal curve from pure black to pure white. Choosing
Extended enlarges the view of the histogram from pure black to two times pure white. Because some
cameras are capable of capturing image information beyond pure white, using the Extended range
option provides controls for bringing that information into the viewable image.
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Working with the Auto Curves Buttons

You use the Auto Curves buttons to analyze the image and apply a tonal curve adjustment to the image
based on that analysis. This is a good way to make a quick correction to an image before fine-tuning the
Curves adjustment with the manual adjustment controls.

Using the Auto Curves Combined Button to Adjust Combined Luminance

When you want to quickly adjust the tonal curve of an image based on total luminance values—red,
green, and blue channels combined—you click the Auto Curves Combined button. Red, green, and blue
channels are adjusted by the same amount based on the total luminance. You use the Auto Curves
Combined button for luminance when you want to correct the contrast of the image without modifying
the color cast of the image.

Before Auto Curves Combined adjustment After Aute Curves Combined adjustment

@ To automatically adjust the tonal curve of an image based on total luminance

1. Select an image.

2. If the Curves controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Curves from the Adjustments pop-up menu.

3. In the Curves area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, click the
Auto Curves Combined button.
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Click the Auta Curves Combined
button to automatically set the
tonal curve for the image based

|nn all three color channels.

T'ﬁircum-s (hame ) | Auta @l Y
Channe! | RGA t] A ]

Aange: | Expanged 1) I Q.07 Ot 1891

The tonal curve of the image is adjusted. To fine-tune the tonal curve adjustment, see “Adjusting the
Tonal Curve of an Image Using the Curves Controls.”

Using the Auto Curves Separate Button to Adjust Color Channels Individually

When you want to automatically adjust the tonal curve of an image based on individual evaluations of the
red, green, and blue channels, you use the Auto Curves Separate button. Red, green, and blue channels
are adjusted based on the evaluation of each channel. You use the Auto Curves Separate button when
you want to correct the color cast in the image in addition to correcting the contrast.

Before Auto Curves Separate adjustment After Auto Curves Separate adjustment

@ To automatically adjust the tonal curve of an image based on an evaluation of each color channel
1. Select an image.

2. If the Curves controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Curves from the Adjustments pop-up menu.

3. In the Curves area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, click the
Auto Curves Separate button.
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The tonal curve of the image is automatically adjusted for each color channel. To fine-tune the tonal
curve adjustment, see “Adjusting the Tonal Curve of an Image Using the Curves Controls.”
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Adjusting the Tonal Curve of an Image Using the Curves Controls

You use the tonal curve in the Curves adjustment controls to adjust the overall tonality of an image.
There are two types of tonal curve adjustments: RGB and Luminance. When you want to specify a tonal
curve adjustment that modifies both the contrast and the tint in the image, you use the RGB tonal curve.
When you want to adjust the overall tonality of an image without affecting its color cast, you use the
luminance tonal curve.

As you perform a tonal curve adjustment, a histogram is displayed behind the tonal curve and is updated
as you manipulate the tonal curve. You can specify the tonal range of the histogram to focus the graph
on the part of the tonal curve you plan to work with. For example, if you plan to manipulate the contrast
in the shadow areas of the image, you can limit the tonal range of the tonal curve and histogram to
display pure black to 50 percent gray only. You can also extend the range of the histogram and tonal
curve beyond pure white to capture highlight detail that would be clipped otherwise.

You can also adjust the tonal curve of each color channel independently. For more information, see
“Using the Curves Controls for Color Correction.”

Before Curves adjustment After Curves adjustment

@ To adjust the tonal curve of an image based on luminance

1. Select an image.

2. If the Curves controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Curves from the Adjustments pop-up menu.
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3. Do one of the following:
e Choose RGB from the Channel pop-up menu.

Choosing the RGB tonal curve allows you to manipulate the tonal curve of the red, green, and blue
color channels combined. This is the proper choice when you want to modify the tint of the image in
addition to the contrast.

e Choose Luminance from the Grayscale section of the Curves Action pop-up menu, then choose
Luminance from the Channel pop-up menu.

Choosing the luminance tonal curve allows you to manipulate the luminance of the combined red,
green, and blue color channels without affecting the image’s tint.

4. Choose the tonal range to display from the Range pop-up menu.

For more information about the options in the Range pop-up menu, see “An Overview of the Curves
Adjustment Controls.”

5. Choose the type of tonal curve adjustment to apply to the image from the Type section of the Curves
Action pop-up menu.

Choosing Linear—the default option—applies the Curves adjustment to the image evenly from pure black
to pure white and beyond. Choosing Gamma-Corrected applies the Curves adjustment logarithmically to
match the way the human eye perceives light, adding additional weight to the shadows.

6. Drag the Black Point and White Point sliders to where they touch the outside of the histogram graph,
constraining the image to its new black and white points.
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7. Set a point along the curve by doing one of the following:

e Click a place on the curve where you want to add a point.

| Beures » o
Channel:[RCE 4| [ # #| [% ——— Click the Add Point
button to use the
eyedropper tool to
sample a portion of

the image and add a
point to the tonal curve,

—— Click the wonal curve
to add a new point, and
drag the new point 1o
set the tonal value,
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e Click the Add Point button and use the eyedropper tool to sample a portion of the image.

Note: You can change the Loupe’s color value sample size by choosing an option from the Adjustment
Action pop-up menu. For more information, see “Sampling Color Values.”

Aperture places a point on the curve in the exact tonal range of the sampled area of the image.
8. Adjust the shape of the curve by doing one of the following:
e Drag the point on the curve until that tonal area of the image looks correct.

For example, dragging a point down in the shadow area of the curve darkens the shadows in the
image, and dragging a point up in the shadow area lightens the shadows in the image.

e Click a point on the curve and enter new In point and Out point values in the In and Out fields.

The In point values represent the horizontal axis of the graph, and the Out point values represent the
vertical axis of the graph.
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Points on the curve that are not selected remain anchored, allowing you to independently adjust each

tonal area.
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9. Repeat steps 7 and 8 for each tonal area in the image that you want to correct.

The tonal values in the image are adjusted, giving the image the appropriate amount of contrast.
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Using Eyedropper Tools to Set Black, Gray, and White Points

You use the Black Point, Gray Point, and White Point eyedropper tools in the Curves adjustment controls
when you want to have Aperture selectively modify the tonal values of the shadows, midtones, and
highlights in an image automatically. Using an eyedropper tool, you sample the pixels of the tonal value
in the image you intend to correct, and Aperture places a point on the tonal curve and automatically
adjusts the image so that the pixels that fall in the same tonal range as the sampled pixels are set to
either black, gray, or white. For example, you use the Black Point eyedropper tool to select the specific
area of the image that should be black. Aperture samples the pixels within the selection, places a point
on the curve, and then adjusts the curve to make the selected pixels—and all other pixels in the image of
the same tonal value or darker—black.

In some difficult cases, you can use the Black Point, Gray Point, and White Point eyedropper tools in
combination with points that you manually place on the tonal curve to neutralize a tint or create the
specific contrast you want in the image. For more information about manually adjusting the tonal curve,
see “Adjusting the Tonal Curve of an Image Using the Curves Controls.”

You use the Black Point eyedropper to automatically set the black point in the image.

Before Black Point Curves adjustment After Black Point Curves adjustment

@ To set the black point in an image
1. Select an image.

2. If the Curves controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Curves from the Adjustments pop-up menu.

3. Select the Black Point eyedropper tool to activate the Loupe.
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The pointer changes to an eyedropper, and the Loupe appears, showing a magnified view of the target
area. By default, the Loupe is set to magnify the image to 100 percent (full size). If necessary, you can
increase the magnification of the Loupe by choosing a larger magnification value from the Loupe pop-up
menu. For more information, see “Viewing Images with the Loupe.”

4. Position the eyedropper over the darkest pixels in the image, then click.

The sampled pixels are used to set the black point in the image.

You use the Gray Point eyedropper to automatically set the gray point in the image.

Before Gray Point Curves adjustment After Gray Point Curves adjustment
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@ To set the gray point in an image

1. Select an image.

2. If the Curves controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Curves from the Adjustments pop-up menu.

3. Select the Gray Point eyedropper tool to activate the Loupe.
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The pointer changes to an eyedropper, and the Loupe appears, showing a magnified view of the target
area. By default, the Loupe is set to magnify the image to 100 percent (full size). If necessary, you can
increase the magnification of the Loupe by choosing a larger magnification value from the Loupe pop-up
menu. For more information, see “Viewing Images with the Loupe.”

4. Position the eyedropper over a midrange color that is as close as possible to medium gray, then click.

The sampled pixels are used to set the gray point in the image.

You use the White Point eyedropper to automatically set the white point in the image.
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Before White Point Curves adjustment After White Point Curves adjustment

@ To set the white point in an image

1. Select an image.

2. If the Curves controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Curves from the Adjustments pop-up menu.

3. Select the White Point eyedropper tool to activate the Loupe.
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The pointer changes to an eyedropper, and the Loupe appears, showing a magnified view of the target
area. By default, the Loupe is set to magnify the image to 100 percent (full size). If necessary, you can
increase the magnification of the Loupe by choosing a larger magnification value from the Loupe pop-up
menu. For more information, see “Viewing Images with the Loupe.”

4. Position the eyedropper over the lightest pixels in the image, then click.
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The sampled pixels are used to set the white point in the image.
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Using the Curves Controls for Color Correction

One of the most powerful ways to remove a color cast from an image or accentuate a desirable color cast
is to adjust the tonal curves of the red, green, and blue color channels independently. It’s important to
understand that you’re adjusting the colors of the image within the RGB spectrum; therefore, you reduce
yellow when you increase blue, you reduce magenta when you increase green, and so on.

© To adjust the tonal curve of a single color channel in an image

1. In the Curves area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose a
single color channel from the Channel pop-up menu.

Choose a color channel from
the Channel pop-up menu.
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2. Place points on the curve, and adjust them as necessary, to remove or accentuate a color cast in the
image.

For more information about placing points on the tonal curve, see “Adjusting the Tonal Curve of an
Image Using the Curves Controls.”

Adjusting the Tonal Curve of the Red Color Channel
You adjust the tonal curve of the red color channel when you want to remove red and cyan color casts in
the image.
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Before Red Curves adjustment After Red Curves adjustment

Red adjustment Effect

Move tonal curve down in the shadows Adds cyan to the shadows, removing red.

Move tonal curve up in the shadows Adds red to the shadows, removing cyan.
Move tonal curve down in the Adds cyan to the midtones, removing red.
midtones

Move tonal curve up in the midtones Adds red to the midtones, removing cyan.

Move tonal curve down in the Adds cyan to the highlights, removing red.
highlights

Move tonal curve up in the highlights  Adds red to the highlights, removing cyan.

Adjusting the Tonal Curve of the Green Color Channel

You adjust the tonal curve of the green color channel when you want to remove green and magenta color
casts in the image.

Before Green Curves adjustment After Green Curves adjustment
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Green adjustment Effect

Move tonal curve down in the shadows Adds magenta to the shadows, removing green.

Move tonal curve up in the shadows Adds green to the shadows, removing magenta.
Move tonal curve down in the Adds magenta to the midtones, removing green.
midtones

Move tonal curve up in the midtones Adds green to the midtones, removing magenta.

Move tonal curve down in the Adds magenta to the highlights, removing green.
highlights

Move tonal curve up in the highlights  Adds green to the highlights, removing magenta.

Adjusting the Tonal Curve of the Blue Color Channel

You adjust the tonal curve of the blue color channel when you want to remove blue and yellow color
casts in the image.

Before Blue Curves adjustment After Blue Curves adjustment

Blue adjustment Effect

Move tonal curve down in the shadows Adds yellow to the shadows, removing blue.

Move tonal curve up in the shadows Adds blue to the shadows, removing yellow.
Move tonal curve down in the Adds yellow to the midtones, removing blue.
midtones

Move tonal curve up in the midtones Adds blue to the midtones, removing yellow.

Move tonal curve down in the Adds yellow to the highlights, removing blue.
highlights

Move tonal curve up in the highlights  Adds blue to the highlights, removing yellow.
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Working with the Levels Controls

You use the Levels adjustment controls when you want to manually set the tonal values of the shadows,
midtones, and highlights in an image. By default, Aperture sets 0 as pure black and 1 as pure white.
Constraining the white and black point values evenly redistributes the tonal range of the pixels between
black and white. Reapportioning the luminance values increases the tonal range and contrast in the
image. However, if you clip too far into either the black or white tonal values, tonal values that were
originally near pure black and pure white are now changed to pure black and pure white, resulting in lost
image detail.

In addition to adjusting the tonal values of an image for overall shadows, midtones, and highlights, you
can also color correct an image by adjusting the levels of the red, green, and blue channels
independently. Aperture provides a way to adjust levels for each color channel, allowing you to control
the color tonality in an image.

You can also brush the Levels adjustment on selected parts of an image. For more information, see
“Making Brushed Adjustments.”
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About Working with Auto Levels Controls

You use the Auto Levels buttons in the Levels adjustment to analyze the image and adjust the levels
based on that analysis. This is a good way to make a quick correction to an image before fine-tuning the
Levels adjustment with the manual adjustment controls.

There are two ways to perform an Auto Levels adjustment. For more information, see the following
sections:

e “Using the Auto Levels Combined Button to Adjust Combined Luminance”
e “Using the Auto Levels Separate Button to Adjust RGB Channels Individually”

You can also adjust the tolerance of the white and black clipping points of the Auto Levels adjustment.
For more information, see “Setting the Auto Levels Options.”
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Using the Auto Levels Combined Button to Adjust Combined Luminance

When you want to quickly adjust the levels of an image based on total luminance values—red, green, and
blue channels combined—you choose Luminance from the Channel pop-up menu in the Levels
adjustment and then click the Auto Levels Combined button. Red, green, and blue channels are adjusted
by the same amount based on the total luminance. You use the Auto Levels Combined button for
luminance when you want to correct the contrast of the image without modifying the color cast of the

image.

Before Auto Levels Combined adjustment After Auto Levels Combined adjustment

@ To automatically adjust the levels of an image based on total luminance
1. Select an image.

2. In the Levels area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose
Luminance from the Channel pop-up menu, then click the Auto Levels Combined button.

Click the Aute Levels Combined
button to automatically set the
levels for the image based on the
combined luminance of all three

The levels of the image are automatically adjusted. To fine-tune the Levels adjustment, see “Adjusting
the Luminance Levels in an Image.”
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Using the Auto Levels Separate Button to Adjust RGB Channels Individually

When you want to automatically adjust the levels of an image based on individual evaluations of the red,
green, and blue channels, you use the Auto Levels Separate button in the Levels adjustment. Red, green,
and blue channels are adjusted based on the evaluation of each channel. You use the Auto Levels
Separate button when you want to correct the color cast in the image in addition to correcting the
contrast.

Before Auto Levels Separate After Auto Levels Separate
adjustment adjustment

@ To automatically adjust the levels based on an evaluation of each color channel
1. Select an image.

2. In the Levels area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose
RGB from the Channel pop-up menu, then click the Auto Levels Separate button.

Click the Auto Levels Separate
button to automatically set the
levels for the image based on an
evaluation of each color channel’s
luminance values.

(]
;0.0 c:[osa] w100

The levels of the image are automatically adjusted for each color channel. To fine-tune the levels
adjustment, see “Adjusting the Luminance Levels in an Image.”
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Setting the Auto Levels Options

Aperture provides the option to set both the black and white clipping point parameters for the Auto
Levels adjustments. Modifying the black and white clipping points from their default value of 0% expands
the tonal range of the image. One reason for expanding the tonal range of an image is to preserve
shadow and highlight detail when the image is printed.

Note: You may have to perform a few print tests to determine the output characteristics of your printer

before settling on final values for black and white clipping points.

@ To adjust the black clipping point

1. Choose Aperture > Preferences, then click Advanced.

B Advanced Use the Auto Adjust Black
i e YTe B 6‘&1 Clip slider and value slider
i i it L A bt o i i - 58 to add tolerance to
Hat hrea theest L oo Auto Levels adjustments
€ Aras thrsheld: o when evaluating colors
s afhont Bk D5 bt ———— beyond black.
Ao adfust Whise S3D: - =i+ DADN +)
Clipping ouwriay: | Calor 0}

2. In the Advanced pane, do one of the following:

e By default, the Auto Adjust Black Clip slider is set to the left side of the slider control. Drag the slider
to the right to increase the tolerance of Auto Levels adjustments to colors beyond the analyzed black
point in the image, and drag the slider back to the left to reduce the tolerance.

e By default, the Auto Adjust Black Clip value slider is set to 0.10%. Double-click the number in the
value slider, then enter a value from 0% to 10% and press Return.

e Click the left or right arrow in the value slider to change the tolerance of Auto Levels adjustments to
colors beyond the analyzed black point in the image, or drag in the value field.

Clicking the left arrow reduces the tolerance, and clicking the right arrow increases it.

3. Once the black clipping point is adjusted, click either the Auto Levels Combined or the Auto Levels
Separate button in the Levels area of the Adjustments inspector or the Adjustments pane of the
Inspector HUD to view the effect on the image.

@ To adjust the white clipping point

1. Choose Aperture > Preferences, then click Advanced.
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2. In the Advanced pane, do one of the following:

e By default, the Auto Adjust White Clip slider is set to the left side of the slider control

9/28/21 12:59 PM

. Drag the slider

to the right to increase the tolerance of Auto Levels adjustments to colors beyond the analyzed white

point in the image, and drag the slider back to the left to reduce the tolerance.

e By default, the Auto Adjust White Clip value slider is set to 0.10%. Double-click the number in the

value slider, then enter a value from 0% to 10% and press Return.

e Click the left or right arrow in the value slider to change the tolerance of Auto Levels
colors beyond the analyzed white point in the image, or drag in the value field.

The left arrow reduces the tolerance, and the right arrow increases it.

adjustments to

3. Once the white clipping point is adjusted, click either the Auto Levels Combined or the Auto Levels
Separate button in the Levels area of the Adjustments inspector or the Adjustments pane of the

Inspector HUD to view the effect on the image.
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Adjusting the Luminance Levels in an Image

When you want to adjust the overall tonality of an image, you use the Levels adjustment controls based
on a histogram that shows luminance. When the histogram is set to show luminance, it displays the
cumulative brightness values for all three color channels for each pixel. You use the histogram’s
luminance view when you want to adjust an image’s tonal values without affecting the color cast.

Before Levels adjustment After Levels adjustment

@ To adjust levels in an image based on luminance

1. Select an image.

2. By default, the Levels histogram is off. Turn it on by selecting the Levels checkbox in the Levels area of
the Adjustments inspector or the Adjustments pane of the Inspector HUD.

The Levels histogram appears.

* (o Levels Auol Chun @l N B,
Channel: I-mm---—----- 3 | = ]

- ——— White Levels slider
B0 G050 w100

Black Levels slider

3. Choose Luminance from the Channel pop-up menu.
4. Do one of the following:

e Drag the Black Levels and White Levels sliders to where they touch the outside of the histogram graph,
constraining the image to its new black and white points.
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* & Levels s ) (Ao 5 @
Channal | Leminare & | 1
| II
; - Drag the Black Levels and
—-l S - l— White Levels sliders to where

they touch the outside of the
histogram graph.

e Select the numbers in the Black (B) and White (W) fields, then enter a value from 0.00 to 1.00. By
default, the black point is set to 0.00, and the white point is set to 1.00.

The tonal values for shadows and highlights in the image are updated, resulting in more defined blacks
and highlight values as well as increased overall contrast.

You can also use the Gray Levels slider if you need to adjust the brightness values of the midtones while
limiting the brightening effect in the black and white points. The brighter areas of shadows and the
darker areas of highlights are affected, but the effect tapers off as it nears the dark blacks and bright
whites.

Before Gray Levels adjustment After Gray Levels adjustment

@ To adjust the midtone levels in an image

Do one of the following:

® Drag the Gray Levels slider until the brightness values in the image’s midtones are correct.

v ¥ Levels urg ) (Asto @) % 9.
Chanmel: | Luminance & -
\ i I Gray Levels slider
= = =
B2 | G %3 W 0B%
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® By default, the gray point is set to 0.50. Select the number in the Gray (G) field, then enter a value from
0.02 to 0.98 to correct the brightness values in the image’s midtones.
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Showing Quarter-Tone Levels Controls

When you need additional control over tonal values between the midtones and shadows as well as the
midtones and highlights, you use the Quarter-Tone Levels controls in the Levels area of the Adjustments
inspector or the Adjustments pane of the Inspector HUD. For example, if you need to add contrast to the
midtone values independently of the black and white point settings, you use the Quarter-Tone Levels
sliders. Unlike the Black Levels and White Levels sliders, Quarter-Tone Levels sliders are independent
and affect only the tonal range of the pixels they represent: either shadows to midtones or midtones to
highlights.

@ To show the Quarter-Tone Levels controls

B Click the Quarter-Tone Controls button.

* o Levels AUl (Ao @ B
Channel: | Luminance £ | |88 ——— Click the Quarter-Tone

— VE—— E Controls button to

\ 1 o | show the Cuarter-Tone
\ \ WY | f _ s Levels sliders.
L .'-'I dr_ --'. 'y
- " - i =

p:[0.12] w03z | o:[0.53] w:[0.60] w[oEs |
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Adjusting the Brightness of an Image

You can also use the Levels adjustment controls to adjust the brightness of an image. When you adjust
the brightness of the image, the Black Levels, Gray Levels, and White Levels sliders modify the tonality of
the image based on the new brightness value.

Adjusting Brightness Uniformly with the Brightness Levels Slider

You use the center Brightness Levels slider at the top of the Levels histogram to uniformly adjust the
brightness of the image.

@ To uniformly adjust the brightness of the image

® |n the Levels area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, drag the
Brightness Levels slider until the brightness of the entire image is correct.

| % ¥ Levels CAuB L CAUDD) % O,
Channel: | Luminance % | =y
illl. = I]- : .II I B Drag the Brightness
LY W R Levels slider to uniformly
!__ I,,.‘i |‘I_F," ¥ adjust the brightness of
=) = [ B G5 an image.
B:0.12) W 092 G083 uo6a ] winas)

Selectively Adjusting Brightness with the Shadow Brightness Levels and Highlight Brightness
Levels Sliders

You can selectively adjust the brightness of the shadows and highlights in an image using the Shadow
Brightness Levels and Highlight Brightness Levels sliders.

@ To selectively adjust the brightness of the shadows and highlights in an image

® Drag the Shadow Brightness Levels and Highlight Brightness Levels sliders until the brightness values of
the shadows and highlights in the image are correct.

¥ ¥ Levels (Ao L) (AUD & 0.
Chamner | Luminance < | 1
"'. -I_'. II !I irr : - l: Drag the Shadow Brightness
A N | :J Levels (on the left) and
\s A i Highlight Erightness Levels
- P om 8 A sliders to selectivaly adjust
&:[012) w032 ¢:[053] w/oes] woms| the brightness of an image.
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Using Levels for Color Correction

A powerful way to color correct an image is to adjust the levels of each color channel in the image.
Adjusting the levels of each color channel is useful for removing color casts in an image. It’s important
to understand that you’re adjusting the colors of the image within the RGB spectrum; therefore, you
reduce yellow when you increase blue, you reduce magenta when you increase green, and so on.

@ To adjust the levels of a single color channel in an image
1. In the Levels area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose a
color channel from the Channel pop-up menu.

Choose a color channel from
the Channel pop-up men..

|| ™ 5 Level Chutn ) Chuta @l % 9
Chasnal; | Red. E (w2

2. Drag the Black Levels, Gray Levels, and White Levels sliders (or enter values in the corresponding fields)
to create the effect you want.

Adjusting the Levels of the Red Color Channel

You adjust the levels of the red color channel when you want to remove red and cyan color casts in the
image.

Before Red Levels adjustment After Red Levels adjustment
{moved Gray Levels slider righit)

Red adjustment Effect

Move Black Levels slider right Adds cyan to the shadows, removing red.
Move Gray Levels slider left Adds red to the midtones, removing cyan.
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Move White Levels slider left Adds red to the highlights, removing cyan.

Adjusting the Levels of the Green Color Channel

You adjust the levels of the green color channel when you want to remove green and magenta color
casts in the image.

Before Green Levels adjustment After Green Levels adjustment
(moved Gray Levels slider right]

Green adjustment Effect

Move Black Levels slider right Adds magenta to the shadows, removing green.

Move Gray Levels slider left Adds green to the midtones, removing magenta.
Move Gray Levels slider right Adds magenta to the midtones, removing green.
Move White Levels slider left Adds green to the highlights, removing magenta.

Adjusting the Levels of the Blue Color Channel

You adjust the levels of the blue color channel when you want to remove blue and yellow color casts in
the image.

Before Blue Levels adjustment After Blue Levels adjustrment
[moved White Levels and Gray Levels sliders left)
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Move Black Levels slider right Adds yellow to the shadows, removing blue.

Move Gray Levels slider left Adds blue to the midtones, removing yellow.
Move Gray Levels slider right Adds yellow to the midtones, removing blue.
Move White Levels slider left Adds blue to the highlights, removing yellow.
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Working with the Color Controls

You use the Color adjustment controls to selectively adjust the red, green, blue, cyan, magenta, and
yellow colors in an image. Each color has individual Hue, Saturation, and Luminance controls. If you need
to adjust the hue, saturation, and luminance of a color that does not appear in the Color controls, you
can use the Color eyedropper to identify a hue in the image that needs adjusting.

Although segmenting control of hue, saturation, and luminance on a per-color basis may seem
complicated at first, restricting these adjustments to specific colors helps correct and enhance targeted
colors without affecting others. In addition, Aperture provides Range controls used to set the extent of
colors affected by the Hue, Saturation, and Luminance adjustments. The extent of colors affected by
these adjustments is also known as chromatic spread. You use the Range controls to fine-tune your
color adjustments.

Before Color adjustment After Color adjustment
{adjusted the hue and saturation
af blue)

You can also brush the Color adjustment on selected parts of an image. For more information, see
“Making Brushed Adjustments.”

About Hue, Saturation, and Luminance

Hue (H) describes the actual color itself. Hue is measured as an angle on a color wheel. Moving a Hue
slider in Aperture remaps the color from its original position on the color wheel to the new position
indicated by the slider. Hue adjustments are often made to match the color of the same subject in
different images. Adjusting the hue of an image is particularly useful when the subject you shot
moved between various lighting conditions. Another advantage of adjusting the hue of an image is
that camera models of different types or from different manufacturers rarely capture and render
color exactly the same way. You can use the Hue controls to match the color of a subject shot by two
different cameras, so that when the images are placed side by side, they match.

Saturation (S) defines the intensity of a specific hue. A saturated hue gives the color a vivid and pure
appearance. A less saturated hue appears flatter and more gray. A completely desaturated hue
becomes a shade of gray.
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Luminance (L) describes the brightness of the selected color. An increase in luminance brightens the
selected color value. A maximum Luminance adjustment results in pure white. Conversely, a

decrease in luminance darkens the selected color. A minimum Luminance adjustment results in pure

black.
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Adjusting the Color of the Image with the Color Controls

When you want to adjust the color values in an image, you must first identify the colors that have the
most influence on the colors you want to change. It’s important to understand that you’re adjusting the
colors of the image within the RGB spectrum; therefore, you reduce yellow when you increase blue, you
reduce magenta when you increase green, and so on. When you want to isolate a color and adjust its
hue, it’s important to identify the color’s location on the color wheel. For example, if the color value is
closer to cyan than blue, you may decide to adjust the cyan Hue value without adjusting the blue Hue
value. Depending on the image, you may decide to adjust both the cyan and blue Hue values to achieve
the color values you’re looking for. There’s not just one correct way of perfecting the colors in an image.
Your approach should be based on the image’s subject and the overall aesthetic you want to achieve.

Reds Yellows Greens Cyans Blues Magentas Reds

0" Cyan remapped 4° a0

@ To adjust a color value in an image

1. Select an image.

2. In the Color area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, click the
color button that corresponds to the color you want to adjust to view its Hue, Saturation, Luminance, and
Range controls.

Note: You can also click the Expanded View button to expand the Color area to show the controls for all
colors at the same time.
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Click the Expanded View
button to view the

cantrals for all colors
at the same time,

3. If a Hue adjustment is necessary, adjust the Hue parameter by doing one of the following:

e By default, the Hue slider is set to the center of the slider control. Drag the Hue slider to the left or
right to change the hue of the selected color.

e Click the left or right arrow in the Hue value slider to change the hue of the selected color in the
image by single increments, or drag in the value field.

The left arrow remaps the hue in the following ways:
e Red Hue value moves toward magenta.

Yellow Hue value moves toward red.

Green Hue value moves toward yellow.

Cyan Hue value moves toward green.

Blue Hue value moves toward cyan.

Magenta Hue value moves toward blue.
The right arrow remaps the hue in the following ways:
e Red Hue value moves toward yellow.

e Yellow Hue value moves toward green.
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Green Hue value moves toward cyan.

Cyan Hue value moves toward blue.

Blue Hue value moves toward magenta.

Magenta Hue value moves toward red.

e By default, the Hue value slider is set to 0.0. Double-click the number in the value slider, then enter a
value from -180.0 to 180.0 and press Return.

Hue i [~ oo o) Use the Hue slider and
Saturation: i) EID value slider to remap the
Luminanee; o v 00 r) hue of the selected colar,

Range: . F~ 100 +)

4. If a Saturation adjustment is necessary, adjust the Saturation parameter by doing one of the following:

e By default, the Saturation slider is set to the center of the slider control. Drag the slider to the left to
desaturate the selected color, or drag the slider to the right to increase the saturation of the selected

color.

e Click the left or right arrow in the Saturation value slider to change the saturation of the selected color
in the image by single increments, or drag in the value field.

e By default, the Saturation value slider is set to 0.0. Double-click the number in the value slider, then
enter a value from -100.0 to 100.0 and press Return.

v |caler = -8
B e e Use the Saturation slider
*m BEEE 5
B I e and value slider to carrect

Hut: o i« on +) the intensity of the hue
Eaturatioe: . [« Ak » of the selected color,
Lurnipance: i = 0 *)

g e (T80

5. If a Luminance adjustment is necessary, adjust the Luminance parameter by doing one of the following:

e By default, the Luminance slider is set to the center of the slider control. Drag the slider to the left to
decrease the brightness of the selected color, or drag the slider to the right to increase the brightness.

e Click the left or right arrow in the Luminance value slider to change the brightness of the selected
color in the image by single increments, or drag in the value field.

e By default, the Luminance value slider is set to 0.0. Double-click the number in the value slider, then
enter a value from -100.0 to 100.0 and press Return.
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Use the Luminance slider
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6. The Range parameter limits or expands the chromatic range of the adjustment. Adjust the Range
parameter by doing one of the following:

e By default, the Range slider is set to the center of the slider control. Drag the slider to the left to
decrease the range of the selected color, or drag the slider to the right to increase the range.

e Click the left or right arrow in the Range value slider to change the chromatic range of the selected
color by 10 percent increments, or drag in the value field.

e By default, the Range value slider is set to 1.00. Double-click the number in the value slider, then
enter a value from 0.00 to 20.00 and press Return.

Hu! —i— s+ 00 ) Use the Range slider and
Saturation: i [+ 00 ) value slider to adjust the
Lumingnce; — i =1+ 0.4 *) chromatic range of the

Range: o <10 = color adjustment.
Reds fellows Greens Magentas

10 1 0

You can adjust the chromatic range up to 20. The default spread s 1.

7. Repeat steps 2 through 6 until you are satisfied with the appearance of the colors in your image.
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Adjusting Custom Colors Using the Color Eyedropper
If you require a more specific hue as a starting point for your color adjustment, you can use the Color
eyedropper to identify a hue in the image.

@ To adjust a custom color value in an image

1. Select an image.

2. In the Color area of the Adjustments inspector or the Adjustments pane of the Inspector HUD, click the

color button with the hue closest to the one you plan to adjust, then select the Color eyedropper tool.

Click the Color eyedropper
and select the caolor in the
image you want to adjust.

¥ [ | Color = - 2
(im =nmal

Hui! LF - D -

Satisration: i (= .8 =1
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Ramge: 1F « 108 =]

The pointer changes to an eyedropper, and the Loupe appears, showing a magnified view of the target
area. By default, the Loupe is set to magnify the image to 100 percent (full size). If necessary, you can
increase the magnification of the Loupe by pressing Command-Shift-Plus Sign (+). For more information
about the Loupe, see “Viewing Images with the Loupe.”

3. Position the eyedropper over the color in the image that you want to adjust, then click.

The new hue is selected and becomes the starting point for color adjustments of that hue. For more
information about Color adjustments, see “Adjusting the Color of the Image with the Color Controls.”
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Working with the Black & White Controls

You use the Black & White adjustment controls when you want more control over converting your image
from color to black and white than simply desaturating it gives you. The Black & White adjustment
controls allow you to adjust tonal relationships and contrast in an image by adjusting the red, green, and
blue channels independently. The effects of a Black & White adjustment are similar to the effects of
attaching a color filter to a camera lens and shooting black-and-white film.

Before Black & White adjustment After Black & White adjustment

The key to the successful use of the Black & White adjustment controls is to experiment with changing
values for the Red, Green, and Blue parameters until you are satisfied with the effect on the image.

Note: A good rule of thumb is to keep the total percentage of the red, green, and blue channels at or
below 100 percent to prevent you from blowing out the highlights in your image.

@ To convert a color image to black and white using the Black & White controls

1. Select an image.

2. If the Black & White controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Black & White from the Adjustments pop-up menu (or press Control-M).

3. Adjust the mixture of red, green, and blue channels by doing one of the following:

e Drag a color slider to the left to decrease the color’s percentage in the color mix, or drag the slider to
the right to increase the percentage.

e Click the left or right arrows in the value sliders to modify the percentages by single increments, or
drag in the value fields.

The left arrows decrease the percentage, and the right arrows increase it.

e Double-click the number in a value slider, then enter a value from -100% to 200% and press Return.
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The tonal and contrast values in your black-and-white image are set.

You can also brush the Black & White adjustment on selected parts of an image. For more information,
see “Making Brushed Adjustments.”
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Working with the Color Monochrome Controls

The Color Monochrome adjustment controls are useful when you want to perform a basic conversion
from color to black and white while simultaneously applying a color tint to the image’s midtones.

Eefore Color Monochrome adjustment After Color Monochrome adjustment
{applied blus tint)

@ To convert a color image to black and white with a color tint

1. Select an image.

2. If the Color Monochrome controls are not shown in the Adjustments inspector or the Adjustments pane
of the Inspector HUD, choose Color Monochrome from the Adjustments pop-up menu.

w [ Codor Monochrome - .
Color | BN | *

0 (5 18— Use the Intensity slider
and value slider ta adjust
the strength of the colar

Click in the Color well tint applied ta the image.
ta select a color from the

Colars windaw.

3. Click the Color well and then choose a new tint color from the Colors window, or click the disclosure
button (to the right of the color well) and choose a new tint color from the pop-up color palette.

The selected color appears in the Color well and tints the midtones in the image.

4. By default, the color intensity is set to the maximum value of 1.0. Adjust the intensity of the color tint by
doing one of the following:

e Drag the Intensity slider to the left to decrease the intensity of the color in the image’s midtones, or
drag the slider back to the right to increase the intensity.

e Click the left or right arrow in the Intensity value slider to modify the intensity by 5 percent
increments, or drag in the value field.

The left arrow decreases the intensity, and the right arrow increases it.

e Double-click the number in the Intensity value slider, then enter a value from 0.0 to 1.0 and press
Return.

The image is converted to black and white, with the selected color tint applied to the midtones.
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You can also brush the Color Monochrome adjustment on selected parts of an image. For more
information, see “Making Brushed Adjustments.”

Copyright © 2009 Apple Inc. All rights reserved.
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Working with the Sepia Tone Controls

The Sepia Tone adjustment controls behave similarly to the Color Monochrome controls, except that the
sepia color is already selected.

Before Sepia Tone adjustment After Sepia Tone adjustment

@ To apply a sepia tint to an image
1. Select an image.

2. If the Sepia Tone controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Sepia Tone from the Adjustments pop-up menu.

¥ [ sepia Tone o o Use the Intensity slider and value
IEEERRiY: m— L0 slider to adjust the strength of the
sepia tint applied to the image.

3. By default, the intensity of the sepia color is set to the maximum value of 1.0. Adjust the intensity of the
sepia color by doing one of the following:

e Drag the Intensity slider to the left to decrease the intensity of the sepia color in the image’s
midtones, or drag the slider back to the right to increase the intensity.

e Click the left or right arrow in the Intensity value slider to modify the intensity by 5 percent
increments, or drag in the value slider.

The left arrow decreases the intensity, and the right arrow increases it.

e Double-click the number in the Intensity value slider, then enter a value from 0.0 to 1.0 and press
Return.

The image is converted to black and white, with the sepia color tint applied to the midtones.

You can also brush the Sepia Tone adjustment on selected parts of an image. For more information, see
“Making Brushed Adjustments.”

Copyright © 2009 Apple Inc. All rights reserved.
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Working with the Sharpen and Edge Sharpen Controls

Aperture provides two sharpening adjustments that you can use to sharpen the detail in your image:
Sharpen and Edge Sharpen.

Which Sharpening Adjustment Should You Use?

If you’ve already applied sharpening in a previous version of Aperture using the Sharpen adjustment
controls, the Sharpen adjustment controls are still there so that your adjustments remain intact and

unchanged. However, to do further sharpening on other images, it is recommended that you use the
Edge Sharpen adjustment controls, which generally offer more precise control over how sharpening

is applied. For more information, see “Working with the Edge Sharpen Controls.”

Copyright © 2009 Apple Inc. All rights reserved.
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Working with the Edge Sharpen Controls

You use the Edge Sharpen controls when you want to sharpen the detail in your image. Images shot with
digital image sensors are often a bit soft in focus because of the demosaic filter applied by the camera’s
processor. The Edge Sharpen controls adjust the luminance values in the image, increasing the contrast
between light and dark pixels that touch, creating an “edge.” Increasing the contrast between these
neighboring light and dark pixels gives the image a crisper, or sharper, appearance. You also use the
Edge Sharpen controls when you make noise-reduction adjustments, so that the image retains detail and
crisp edges that might otherwise be obscured by the effect of the noise-reduction adjustment.

Before Edge Sharpen adjustment Afrer Edge Sharpen adjustment

Important: The Edge Sharpen controls are not designed to correct images that were shot out of focus.
They are designed to help mitigate the effects of the camera’s demosaic filter, as well as maintain image
detail when noise-reduction adjustments are applied. Edge Sharpen adjustments can also compensate
for the softening that occurs with some printing processes.

@ To sharpen an image using the Edge Sharpen controls

1. Select an image.

2. If the Edge Sharpen controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Edge Sharpen from the Adjustments pop-up menu (or press Control-S).

3. Sharpen the image by doing one of the following:

e Drag the Intensity slider to the right to increase the amount of sharpening applied to the image, and
drag the slider back to the left to reduce the amount of sharpening.

e Click the left or right arrow in the Intensity value slider to adjust the sharpening by 5 percent
increments, or drag in the value field. The left arrow decreases the sharpening effect on the image,
and the right arrow increases it.

e Double-click the number in the Intensity value slider, then enter a value from 0.0 to 1.0 and press
Return.
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A value of 0.0 applies no sharpening adjustment to the image. A value greater than 0.0 increases the
sharpening adjustment applied to the image.

4. Adjust the threshold for determining which pixels are edges and which ones are not by doing one of the
following:

e Drag the Edges slider to the right to increase the area over which the sharpening effect is applied, and
drag the Edges slider back to the left to reduce it.

e Click the left or right arrow in the Edges value slider to adjust the area over which the sharpening
effect is applied by 5 percent increments, or drag in the value field.

e Double-click the number in the Edges value slider, then enter a value from 0.0 to 1.0 and press
Return.

¥ ¥ Cdge Sharpen 5 B Use the Edges slider and value
: — = o8t ) slicer to adjust the threshold
022

[ e e L + =0 of the sharpening adjustment.
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A value of 0.0 applies no sharpening adjustment to the image. A value greater than 0.0 increases the
number of pixels that qualify as edges.

Note: If you observe digital noise beginning to increase in flat areas of the image (areas with little or no
contrast), decrease the Edges parameter setting.

5. For maximum accuracy, the Edge Sharpen adjustment sharpens the image in three passes that appear to
occur simultaneously—an initial sharpening pass, where a majority of the sharpening occurs, followed by
two subsequent sharpening passes. These subsequent passes are called falloff. Adjust the amount of
sharpening applied in the subsequent sharpening passes by doing one of the following:

e Drag the Falloff slider to the right to increase the percentage of the original sharpening that’s applied
during the subsequent sharpening passes, and drag the slider back to the left to reduce it.

e Click the left or right arrow in the Falloff value slider to adjust the falloff percentage by 5 percent
increments, or drag in the value field.

e Double-click the number in the Falloff value slider, then enter a value from 0.0 to 1.0 and press

Return.
v [# Edge Sharpen e Lise the Falloff slider and value
T e ¥ = OO V- TR slider to adjust the strength
Eofies: s e s 022 ) of the subsequent sharpening
Faltaf- o 5 pss - ——— adjustment.
file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=17%26section=83 Page 2 of 3

Petitioner Apple Inc. - Ex. 1005, p. 716



Aperture 3 User Manual: Working with the Edge Sharpen Controls 9/28/21 1:00 PM

The falloff percentage is applied proportionally to the second and third sharpening passes. For example,
if 0.69 (69 percent) is set as the Falloff parameter value, 69 percent of the original amount of sharpening
is applied during the second sharpening pass, and 69 percent of the amount of sharpening from the
second sharpening pass is applied during the third sharpening pass. In other words, only 47.6 percent of
the amount of the original sharpening is applied during the third sharpening pass.

You can also brush the Edge Sharpen adjustment on selected parts of an image. For more information,
see “Making Brushed Adjustments.”
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Understanding the Edge Sharpen Workflow

The Edge Sharpen adjustment in Aperture is a professional tool that’s used to sharpen photos. Using the
Edge Sharpen adjustment controls in conjunction with the following workflow makes it easy to achieve
professional results.

@ To sharpen an image

1. In the Edge Sharpen area of the Adjustments inspector or the Adjustments pane of the Inspector HUD,
set the Intensity slider to the maximum value to see the effect of the operation.

2. Adjust the Edges slider so you can see which parts of the image are being sharpened. If possible, adjust
the Edges slider so that edges are sharpened, but noise and texture in the image are not affected.

3. Adjust the Falloff slider so that the edge sizes you want sharpened the most are accentuated.

4. Decrease the Intensity parameter value until the sharpening effect is appropriately subtle. Values below
0.5 usually work best.
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Working with the Sharpen Controls

You use the Sharpen adjustment controls when you need to modify Sharpen adjustment parameter
settings that were applied to an image in a previous version of Aperture.

@ To sharpen an image using the Sharpen controls

1. Select an image.

2. If the Sharpen controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Sharpen from the Adjustments pop-up menu.

3. Sharpen the image by doing one of the following:

e By default, the Intensity slider is set to 0.5. Drag the Intensity slider to the right to increase the
amount of sharpening applied to the image, and drag the slider back to the left to reduce the amount
of sharpening.

e Click the left or right arrow in the Intensity value slider to adjust the sharpening by 5 percent
increments, or drag in the value field.

The left arrow decreases the sharpening effect on the image, and the right arrow increases it.

e Double-click the number in the Intensity value slider, then enter a value from 0.0 to 1.0 and press

Return.
| i sharpen 5
Irtensity: Lk (« by = Use the Intensity slider and value
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the sharpening adjustmeant.

Use the Radius slider and
value slider to adjust the area

owver which the sharpening
adjustment is applied.

A value of 0.0 applies no sharpening adjustment to the image. A value greater than 0.0 increases the
sharpening adjustment to the image.

4. Adjust the area over which the sharpening adjustment is applied (the distance, in pixels, that Aperture
goes from each pixel to evaluate sharpness) by doing one of the following:

e By default, the Radius slider is set to 1.0 pixels. Drag the Radius slider to the right to increase the area
over which the sharpening effect is applied, and drag the Radius slider back to the left to reduce it.

e Click the left or right arrow in the Radius value slider to adjust the Radius pixel distance by 5 percent
increments, or drag in the value field.

e Double-click the number in the Radius value slider, then enter a value from 0.0 to 20.0 and press
Return.

A value of 0.0 applies no sharpening adjustment to the image. A value greater than 0.0 increases the
area over which the sharpening adjustment is applied.

As you change the parameter values, the image is updated to display the sharpening effect.
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You can also brush the Sharpen adjustment on selected parts of an image. For more information, see
“Making Brushed Adjustments.”

Copyright © 2009 Apple Inc. All rights reserved.
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Working with the Vignette Controls

You use the Vignette adjustment controls to apply a vignette to an image. The term vignette describes
an image whose brightness fades to its periphery from its center. Vignettes are usually applied to an
image after it is shot, for artistic effect. Aperture provides two types of vignettes: Exposure and Gamma.
The Exposure vignette is designed to simulate a lens-created vignette. The Gamma vignette is designed
for artistic effect and applies a gamma adjustment to the affected pixels within the vignette. Because the

Gamma vignette intensifies the affected pixels, it creates a more pronounced vignette effect than the
Exposure vignette.

Note: You can add a vignette to any image cropped in Aperture. The adjustment is applied after the
image is cropped.
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Applying an Exposure Vignette

You use the Exposure vignette when you want to apply the effect of a traditional lens-created vignette.

Before Exposure Vignette After Exposure Vignette
adjustment adjustment

@ To apply an Exposure vignette to an image
1. Select an image.

2. If the Vignette controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Vignette from the Adjustments pop-up menu (or press Control-V).

3. Choose Exposure from the Type pop-up menu.
4. Adjust the amount of vignette to apply to the image by doing one of the following:

e Drag the Intensity slider to the left to decrease the amount of dark shading applied to the edges of the
image, or drag the slider to the right to increase the dark shading.

e Click the left or right arrow in the Intensity value slider to change the amount of dark shading applied
to the edges of the image, or drag in the value field.

The left arrow decreases the amount of dark shading applied to the edges of the image, and the right
arrow increases the dark shading.

e Double-click the number in the Intensity value slider, then enter a value from 0.0 to 1.0 and press

Return.
| ¥ @ Vignente " oo, Use the Intensity slider and value
Type: | [xpesire B slider to adjust the amount of
BB s—— e (s 06 #] brightness removed from the
BRI = s 5 - edges of the image.

5. To adjust the distance Aperture goes from the edge of the image, in pixels, to apply the Vignette
adjustment, do one of the following:
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e Drag the Radius slider to the right to increase the number of pixels Aperture goes toward the center
of the image to apply the Vignette adjustment, or drag the slider to the left to limit the vignette to the

edges of the image.
e Click the left or right arrow in the Radius value slider, or drag in the value field.

The left arrow limits the Vignette adjustment to the edges of the image, and the right arrow moves the
Vignette adjustment toward the center point of the image.

e Double-click the number in the Radius value slider, then enter a value from 0.0 to 2.0 and press

Return.
* [ Vignete 5 0 Lkse the Radius slider and value
Type: | Bxposure ] slider to adjust the size of the
Inbensiny i = oG s area over which the Vignette

Radiils) =i {7 0,5+

adjustment s applied.

The Exposure vignette is applied to the image.

You can also brush the Exposure Vignette adjustment on selected parts of an image. For more
information, see “Making Brushed Adjustments.”
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Applying a Gamma Vignette

A Gamma vignette is an artistic adjustment that intensifies colors in the pixels affected by the vignette.

Before Gamma Vignette adjustment After Gamma Vignette adjustment

@ To apply a Gamma vignette to an image

1. Select an image.

2. If the Vignette controls are not shown in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, choose Vignette from the Adjustments pop-up menu (or press Control-V).

3. Choose Gamma from the Type pop-up menu.
4. Adjust the amount of vignette to apply to the image by doing one of the following:

e Drag the Intensity slider to the left to decrease the amount of dark shading applied to the edges of the
image, or drag the slider to the right to increase the dark shading.

e Click the left or right arrow in the Intensity value slider to change the amount of dark shading applied
to the edges of the image, or drag in the value field.

The left arrow decreases the amount of dark shading applied to the edges of the image, and the right
arrow increases the dark shading.

e Double-click the number in the Intensity value slider, then enter a value from 0.0 to 1.0 and press

Return.
* [ vignette 5 0 Use the Intensity slider and value
Type: | Camma t] slider to adjust the amount of
InbEnpity; m—— e Q6 brightness removed from the
P! m—— (i 05+ edges of the image.

5. To adjust the distance Aperture goes from the edge of the image, in pixels, to apply the Vignette
adjustment, do one of the following:

e Drag the Radius slider to the right to increase the number of pixels Aperture goes toward the center
of the image to apply the Vignette adjustment, or drag the slider to the left to limit the vignette to the
edges of the image.

e Click the left or right arrow in the Radius value slider, or drag in the value field.
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The left arrow limits the Vignette adjustment to the edges of the image, and the right arrow moves the
Vignette adjustment toward the center point of the image.

e Double-click the number in the Radius value slider, then enter a value from 0.0 to 2.0 and press

Return.
|| & Vignetie 5 Use the Radius slider and value
Typa: | Gamena | slider to adjust the size of the
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Radiug: m——ij————— 5 05 == adjustment is applied.

The Gamma vignette is applied to the image.

You can also brush the Gamma Vignette adjustment on selected parts of an image. For more
information, see “Making Brushed Adjustments.”

For information about removing a vignette that was applied to an image when it was shot, see “Working
with the Devignette Controls.”
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Switching Vignette Types

You can switch the type of vignette that’s applied to an image and maintain the Intensity and Radius
parameter values you set using the previous vignette type.

@ To switch vignette types
® Choose the other vignette type from the Type pop-up menu.

The new vignette is applied to the image, but the Intensity and Radius parameters maintain their
settings.

Copyright © 2009 Apple Inc. All rights reserved.
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Making Brushed Adjustments

In Aperture, you can apply or remove adjustments on specific portions of your images with brushes to
selectively correct and enhance your photos.

Copyright © 2009 Apple Inc. All rights reserved.
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An Overview of Brushed Adjustments

In Aperture, you brush an adjustment when you want to specify the area of the image the adjustment is
applied to. Most adjustments in Aperture can be brushed on images. You simply specify the parameter
settings for an adjustment, previewing the effect of the adjustment on the entire image, and then you
choose to either brush the adjustment “in” or brush the adjustment “away” using the adjustment’s Action
pop-up menu.

You brush an adjustment in when the area of the image you want to apply the adjustment to is small.
When you choose to brush an adjustment in, Aperture removes the application from the adjustment on
the entire image, and the adjustment is reapplied to specific portions of the image as you brush it on.

You brush an adjustment away when the area you want to apply the adjustment to is larger than the area
you don’t want the adjustment applied to. When you choose to brush an adjustment away, Aperture
applies the adjustment to the entire image, and you use the eraser brush to remove the adjustment from
the areas of the image that don’t need the adjustment.

When you brush an adjustment on an image, a Brush button appears at the top of the adjustment
controls for that adjustment.

A Brush button appears after
the adjustment has been
brushed on the image.
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Aperture also provides Quick Brush adjustments that have been specifically designed for brushing on
images. Using Quick Brush adjustments, you brush an adjustment on the image and then modify the
adjustment’s parameter settings. Several of the adjustments and adjustment parameters in Aperture
have Quick Brush equivalents: Noise Reduction, Saturation, Sharpen, Contrast, and Vibrancy. However, a
few Quick Brush adjustments are uniquely designed to fix imperfections best remedied with selective
brushing. Examples are Halo Reduction and Skin Smoothing. When you identify the area of an image that
is ideally suited for a Quick Brush adjustment, you choose the appropriate Quick Brush from the
Adjustments pop-up menu in either the Adjustments inspector or the Adjustments pane of the Inspector
HUD.
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You can also choose a Quick Brush adjustment from the Quick Brush pop-up menu in the tool strip of
the Aperture main window or in the Full Screen view toolbar.

Quick Brush

poOp-up Feny
'i-"ﬁ._i'L

fim =] TR

Each time you choose a Quick Brush adjustment from the Adjustments pop-up menu or the Quick Brush
pop-up menu, the adjustment controls for the Quick Brush adjustment also appear in the Adjustments
inspector and the Adjustments pane of the Inspector HUD, if both are shown. Some Quick Brush
adjustments, such as Retouch, have just a checkbox and a Delete button for removing brush strokes.
However, some Quick Brush adjustments, such as Definition, have additional parameter controls that
allow you to modify the radius and intensity of the adjustment after it has been brushed on the image.
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When you choose to brush either a regular adjustment or a Quick Brush adjustment, a HUD for that
adjustment appears, and the pointer turns into a brush. You use the controls in the Brush HUD to define
the size of the brush, the softness of the brush’s edges, and the strength of the brush stroke. In addition
to brush controls, the Brush HUD also contains controls for erasing brush strokes, feathering the edges
of brush strokes, working with overlays, limiting the adjustment to specific tonal ranges, and detecting
edges. When you are satisfied with the settings in the Brush HUD, you can begin brushing the
adjustment on the image.

All brushed adjustments are available for use in the Viewer and in Full Screen view, and you can apply a
brushed adjustment at any magnification setting. If you prefer to make brushed adjustments with a pen
and tablet rather than a mouse, the brushed adjustments are pressure-sensitive.

Important: Brushed adjustments are available only for images using Aperture 3 image processing. For
more information about reprocessing your images, see “Reprocessing Images from Previous Versions of
Aperture.”

Copyright © 2009 Apple Inc. All rights reserved.
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Controls in the Brush HUD

The controls in the Brush HUD are the same for all brushed adjustments except for Retouch.

For more information about the Retouch adjustment, see “Working with the Retouch Controls.”
@ To show the Brush HUD for an adjustment
Do one of the following:

® |n the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose either “Brush
[adjustment] in” or “Brush [adjustment] away” from the Action pop-up menu for the adjustment.

® |n the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose Quick Brushes from
the Adjustments pop-up menu, then choose a Quick Brush adjustment from the submenu.

® Choose a Quick Brush adjustment from the Quick Brush pop-up menu (with a brush icon) in the tool
strip.

® |n Full Screen view, choose a Quick Brush adjustment from the Quick Brush pop-up menu in the toolbar.

Brush button

Feather button

Eraser button

Brush Action
pop-up menu

e Brush button: Click this button to activate the brush.
e Feather button: Click this button to feather the edges of previously applied brush strokes.

e Fraser button: Click this button to activate the eraser used to remove portions of previously applied
brush strokes for the currently selected adjustment.

e Brush Action pop-up menu: Choose to apply the brushed adjustment to the entire image, invert the
brush strokes, remove all brush strokes, display brush strokes as color overlays, show a white mask
with the brush strokes revealing the image underneath, show a black mask with the brush strokes
revealing the image underneath, limit the brushed adjustment to the shadows of the image, limit the
brushed adjustment to the midtones of the image, and limit the brushed adjustment to the highlights
of the image.

e Brush Size slider and value slider: Enter the diameter of the brush using the slider or value slider.
e Softness slider and value slider: Enter the softness of the brush’s edge using the slider or value slider.
e Strength slider and value slider: Enter the intensity of the brush stroke using the slider or value slider.

e Detect Edges checkbox: Select this checkbox to detect edges in the image that the adjustment is
brushed over, thereby preserving detail.
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Brushing Adjustments In
When you want to apply an adjustment to a small portion of an image, you can specify the adjustment

parameter settings and then brush the adjustment in.
@ To brush an adjustment in
1. Select an image.

2. If the adjustment you want to apply to the image is not shown in the Adjustments inspector or the
Adjustments pane of the Inspector HUD, choose the adjustment from the Adjustments pop-up menu.

Note: The Red Eye Correction, Spot & Patch, Straighten, Crop, Flip, White Balance, and Exposure
adjustments cannot be brushed on images.

3. Specify parameter settings for the adjustment while viewing the effect on the image.

4. When the area of the image you want to adjust has the correct appearance, choose “Brush [adjustment]
in” from the adjustment’s Action pop-up menu (with a gear icon).
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The pointer turns into a brush, and the Brush HUD for the adjustment appears. The adjustment is also
removed from the image.

5. In the Brush HUD, specify the following settings:

e To adjust the size of the brush: Drag the Brush Size slider to the left to decrease the diameter of the
brush, or drag the slider to the right to increase the diameter. You can also enter a value in the Brush
Size value slider.

e To adjust the softness of the brush: Drag the Softness slider to the left to decrease the softness of the
brush, or drag the slider to the right to increase the softness. You can also enter a value in the
Softness value slider.

e To adjust the intensity of the brush: Drag the Strength slider to the left to decrease the strength of the
brush stroke, or drag the slider to the right to increase the strength. You can also enter a value in the
Strength value slider.

e To specify that the adjustment detect edges in order to preserve detail: Select the Detect Edges
checkbox.
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Erhamte

Note: For additional options, see “Working with Brushes.”
6. Brush the adjustment over the areas of the image you want to apply it to.

Tip: It’s a good idea to regularly zoom into the image to ensure the brush strokes cover the areas of the
image you intended the adjustment to cover.

Copyright © 2009 Apple Inc. All rights reserved.
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Brushing Adjustments Away
When you want to apply an adjustment to most of an image except for a small portion, you can specify
the parameter settings for the adjustment and then brush the adjustment away from the areas of the
image you want to exclude. Brushing an adjustment away from an image is the same operation as using
the Eraser brush.

@ To brush an adjustment away

1. Select an image.

2. If the adjustment you want to apply to the image is not shown in the Adjustments inspector or the
Adjustments pane of the Inspector HUD, choose the adjustment from the Adjustments pop-up menu.

Note: The Red Eye Correction, Spot & Patch, Straighten, Crop, Flip, White Balance, and Exposure
adjustments cannot be brushed on images.

3. Specify parameter settings for the adjustment while viewing the effect on the image.

4. When the area of the image you want to adjust has the correct appearance, choose “Brush [adjustment]
away” from the adjustment’s Action pop-up menu (with a gear icon).
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The pointer turns into a brush, and the Brush HUD for the adjustment appears. The adjustment remains
applied to the entire image.

5. In the Brush HUD, specify the following settings:

e To adjust the size of the brush: Drag the Brush Size slider to the left to decrease the diameter of the
brush, or drag the slider to the right to increase the diameter. You can also enter a value in the Brush
Size value slider.

e To adjust the softness of the brush: Drag the Softness slider to the left to decrease the softness of the
brush, or drag the slider to the right to increase the softness. You can also enter a value in the
Softness value slider.

e To adjust the intensity of the brush: Drag the Strength slider to the left to decrease the strength of the
brush stroke, or drag the slider to the right to increase the strength. You can also enter a value in the
Strength value slider.

e To specify that the adjustment detect edges in order to preserve detail: Select the Detect Edges
checkbox.
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Note: For additional options, see “Working with Brushes.”
6. Brush over the areas of the image you want to exclude the adjustment from.

Tip: It’s a good idea to regularly zoom in to the image to ensure that the brush strokes exclude the areas
of the image you don’t want the adjustment to cover.

Copyright © 2009 Apple Inc. All rights reserved.
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Applying Quick Brush Adjustments

Aperture provides Quick Brush adjustments, such as Dodge, Burn, Halo Reduction, and Skin Smoothing,
that have been specifically designed for brushing on images. Using Quick Brush adjustments, you brush
the adjustment on the image and then modify its parameter settings.

@ To apply a Quick Brush adjustment

1. Select an image.
2. Do one of the following:

e In the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose Quick Brushes
from the Adjustments pop-up menu, then choose a Quick Brush adjustment from the submenu.

e Choose a Quick Brush adjustment from the Quick Brush pop-up menu (with a brush icon) in the tool
strip.

e In Full Screen view, choose a Quick Brush adjustment from the Quick Brush pop-up menu in the
toolbar.

The pointer turns into a brush, the Brush HUD for the adjustment appears, and adjustment controls for
the adjustment appear in the Adjustments inspector and the Adjustments pane of the Inspector HUD, if
both are shown.

Note: The controls in the Retouch HUD are different from the Brush HUD for other brushed adjustments.
For more information about the controls in the Retouch HUD, see “Working with the Retouch Controls.”

3. In the Brush HUD, specify the following settings:

e To adjust the size of the brush: Drag the Brush Size slider to the left to decrease the diameter of the
brush, or drag the slider to the right to increase the diameter. You can also enter a value in the Brush
Size value slider.

e To adjust the softness of the brush: Drag the Softness slider to the left to decrease the softness of the
brush, or drag the slider to the right to increase the softness. You can also enter a value in the
Softness value slider.

e To adjust the intensity of the brush: Drag the Strength slider to the left to decrease the strength of the
brush stroke, or drag the slider to the right to increase the strength. You can also enter a value in the
Strength value slider.

e To specify that the adjustment detect edges in order to preserve detail: Select the Detect Edges
checkbox.

Note: For additional options, see “Working with Brushes.”
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4. Brush the adjustment over the areas of the image you want to apply it to.

Copyright © 2009 Apple Inc. All rights reserved.
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Working with Brushes

There are many controls in the Brush HUD that you can use to apply, remove, and feather brush strokes.
For details, see the following sections:

e “Feathering Brush Strokes”

e “Erasing Brush Strokes”

e “Applying a Brushed Adjustment to the Entire Image”
e “Inverting Brush Strokes”

e “Working with Brushed Adjustment Overlays”

e “Limiting the Tonal Range of Brushed Adjustments”

e “Modifying Previously Applied Brush Strokes”

Copyright © 2009 Apple Inc. All rights reserved.
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Feathering Brush Strokes

In many situations, it’s best to avoid brush strokes that have hard, noticeable edges. The Brush HUD has
a feathering brush that you can use to smooth the edges of previously applied brush strokes so that they
blend seamlessly into the image. The feathering brush is applied to the selected brushed adjustment
only.

@ To feather brush strokes

1. Select the image with the brushed adjustment whose brush strokes you want to feather.

2. If necessary, select the brushed adjustment in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, then click the Brush button in the adjustment controls.

Click the Brush button to
open the Brush HUD for
the adjustment.
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The Brush HUD for the adjustment appears.
3. In the Brush HUD, click the Feather button.

Click the Feather button.

4. Specify the diameter of the brush and its intensity using the Brush Size and Strength sliders and value
sliders.

5. Drag the brush over the edges of the previously applied brush strokes.

Tip: When feathering brush stokes, it’s a good idea to display the brush strokes as color overlays to help
identify the boundaries of each brush stroke. Then turn the color overlays off at regular intervals and
visually inspect the image to ensure that the brush strokes are feathered appropriately. For more
information about working with overlays, see “Working with Brushed Adjustment Overlays.”

The adjustment’s brush strokes are feathered, blending them into the image.

Copyright © 2009 Apple Inc. All rights reserved.
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Erasing Brush Strokes

You can erase the brush strokes for any brushed adjustment applied to an image using the Eraser button
in the Brush HUD. The eraser brush erases the brush strokes of the selected brushed adjustment only.
The eraser brush uses the same parameters as the regular brush (Brush Size, Softness, and Strength).

@ To erase brush strokes

1. Select the image with the brushed adjustment whose brush strokes you want to erase.

2. If necessary, select the brushed adjustment in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, then click the Brush button in the adjustment controls.

Click the Brush button to
open the Brush HUD for
the adjustment.
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The Brush HUD for the adjustment appears.
3. In the Brush HUD, click the Eraser button.

Click the Eraser button.

4. Specify the diameter of the brush, its softness, and its intensity using the Brush Size, Softness, and
Strength sliders and value sliders.

5. Drag the brush over the parts of the previously applied brush strokes that you want to remove.

Tip: Some brushed adjustments are so subtle that it’s difficult to identify the boundaries of the brush
strokes or even the brush strokes themselves. In some cases, one brushed adjustment can obscure
another when brushed over the same area. To help identify brush strokes, it’s a good idea to use
overlays. For more information, see “Working with Brushed Adjustment Overlays.”

The brush strokes selected with the eraser brush are erased.

If you want to remove all brush strokes for a specific adjustment that are applied to an image, you can
remove them all at once using the Brush Action pop-up menu in the Brush HUD for that adjustment.

@ To remove all brush strokes for a specific adjustment from an image
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1. Select the image with the brushed adjustment whose brush strokes you want to remove.

2. If necessary, select the brushed adjustment in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, then click the Brush button in the adjustment controls.

Click the Brush button to
open the Brush HUD for
the adjustment.
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The Brush HUD for the adjustment appears.

3. In the Brush HUD, choose “Clear from entire photo” from the Brush Action pop-up menu.

Enkance

Choose “Clear from
entire phota” from the
Brush Action pop-up
menu.

All brush strokes for the selected adjustment are removed from the image.

Copyright © 2009 Apple Inc. All rights reserved.
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Applying a Brushed Adjustment to the Entire Image

You can extend a brushed adjustment to the entire image if you decide that the adjustment should be
applied to the entire image rather than just the area you brushed over.

@ To apply a brushed adjustment to the entire image
1. Select the image with the brushed adjustment whose brush strokes you want applied to the entire image.

2. If necessary, select the brushed adjustment in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, then click the Brush button in the adjustment controls.

Click the Brush button to
open the Brush HUD for
the adjustment.
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The Brush HUD for the adjustment appears.

3. In the Brush HUD, choose “Apply to entire photo” from the Brush Action pop-up menu.

Choose “Apply to entire
photo” from the Brush
Action pop-up menu.

The brushed adjustment’s brush strokes are removed, and the adjustment is applied to the entire image.

Copyright © 2009 Apple Inc. All rights reserved.
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Inverting Brush Strokes

If you brush an adjustment over a specific area of an image and then decide that the adjustment should
be removed from the area you just brushed over and applied to the rest of the image, you can invert the
brush strokes.

@ To invert an adjustment’s brush strokes

1. Select the image with the brushed adjustment whose brush strokes you want to invert.

2. If necessary, select the brushed adjustment in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, then click the Brush button in the adjustment controls.

Click the Brush button to
open the Brush HUD for
the adjustment.
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The Brush HUD for the adjustment appears.

3. In the Brush HUD, choose Invert from the Brush Action pop-up menu.

Choose Invert from
the Brush Action
POpP-UR MEenu.

The adjustment’s brush strokes in the image are inverted.

Copyright © 2009 Apple Inc. All rights reserved.
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Working with Brushed Adjustment Overlays

Overlays are useful tools for identifying where brush strokes for the selected brushed adjustment have
been applied to the image. When you’ve brushed an adjustment with a subtle softness and strength over
the image, it can be difficult to discern the boundaries of the brush stroke. Aperture provides several
types of overlays to help you visually identify the selected brushed adjustment’s cumulative brush
strokes. When you accurately identify the boundaries of a brush stroke, you can use the eraser brush to
remove any parts of the brush stroke that don’t belong, and you can use the feathering brush to smooth
out the edges. For more information, see “Erasing Brush Strokes” and “Feathering Brush Strokes.”

Aperture provides the following overlay options to help you with detailed brushing:
e (Color Overlay: This option displays a pink overlay over the brush strokes for the selected adjustment.

e Brush Strokes: This option displays the brush strokes for the selected adjustment as pure white over a
pure black background. This option provides the easiest method for identifying brush strokes that
have been applied to an image. It’s a good idea to use this overlay option if you suspect that you
missed a tiny part of the image when brushing. The missed portions of the image will appear as black
dots or lines.

® On Black: This option displays a pure black mask over the image, with the brush strokes revealing the
image beneath. This option is useful for detailed brush strokes over a bright area in the image.

e On White: This option displays a pure white mask over the image, with brush strokes revealing the
image beneath. This option is useful for detailed brush strokes over dark areas in the image.
@ To apply an overlay for a brushed adjustment to an image
1. Select the image with the brushed adjustment whose brush strokes you want to view as an overlay.

2. If necessary, select the brushed adjustment in the Adjustments inspector or the Adjustments pane of the
Inspector HUD, then click the Brush button in the adjustment controls.

Click the Brush button to
open the Brush HUD for
the adjustment.
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The Brush HUD for the adjustment appears.

3. In the Brush HUD, choose an overlay option from the Overlay section of the Brush Action pop-up menu.
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Enhance

Choose an overlay from
the Overlay section

of the Brush Action
POP-Up MEenL.
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The chosen overlay appears on the image for the selected brushed adjustment’s brush strokes.

@ To turn an overlay off

® |n the Brush HUD, choose None from the Overlay section of the Brush Action pop-up menu.

Copyright © 2009 Apple Inc. All rights reserved.
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Limiting the Tonal Range of Brushed Adjustments

You can limit the adjustment you’re about to brush on an image to a specific tonal range using the Brush
Action pop-up menu in the Brush HUD. For example, if you want to brush an adjustment on an image
and have the adjustment limited to the shadows, you choose Shadows from the Brush Action pop-up
menu and then brush the adjustment on the image. If the brush touches a midtone or highlight, that
part of the image is not changed.

Tip: This feature is particularly useful when burning and dodging because you can limit the exposure
adjustment to the tonal range you want to modify without having to worry about adversely affecting
details in the tonal ranges that are appropriately exposed.

@ To limit a brushed adjustment to a specific tonal range

1. Select an image.

2. Do one of the following:

e In the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose either “Brush
[adjustment] in” or “Brush [adjustment] away” from the Action pop-up menu (with a gear icon) for the
adjustment you want to apply to the image.

e In the Adjustments inspector or the Adjustments pane of the Inspector HUD, choose Quick Brushes
from the Adjustments pop-up menu, then choose a Quick Brush adjustment from the submenu.

e Choose a Quick Brush adjustment from the Quick Brush pop-up menu in the tool strip.

e In Full Screen view, choose a Quick Brush adjustment from the Quick Brush pop-up menu in the
toolbar.

The Brush HUD for the adjustment appears.

3. In the Brush HUD, choose a tonal range to which to limit the adjustment from the Brush Range section of
the Brush Action pop-up menu.

Choose a tonal range
option from the Brush
Range sectipn of the
Brush Action pop-up
rrieru.

Note: If you don’t want the brushed adjustment limited to a specific tonal range, choose All.

Copyright © 2009 Apple Inc. All rights reserved.
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Modifying Previously Applied Brush Strokes

After applying a brushed adjustment to an image, you can still modify the effect of the adjustment on
the image. Whether you brushed a regular adjustment or a Quick Brush adjustment, you can modify the
adjustment using the controls for that adjustment in the Adjustments inspector or the Adjustments pane
of the Inspector HUD.

@ To modify a brushed adjustment after it has been applied to an image

® Specify new parameter settings using the controls for that adjustment in the Adjustments inspector or
the Adjustments pane of the Inspector HUD.

Note: Retouch and Halo Reduction brushed adjustments do not have parameter settings that can be
specified after the adjustments have been applied.

Copyright © 2009 Apple Inc. All rights reserved.
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Printing Your Images
Aperture makes it easy to print high-resolution images. You can print single images, contact sheets,
webpages, and books. You can print images selected in the Light Table, as well as create PDF files that

you can easily transfer to clients for review.
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An Overview of Printing

Aperture allows you to print your photos as high-resolution images and multi-image contact sheets. You
can also print books and Light Table arrangements created in Aperture. Aperture offers a variety of
printing options, including using a standard, roll, or custom paper size and assigning a specific
ColorSync profile.

The easiest way to print images is to use one of the Aperture print presets. Print presets, or groups of
print settings, allow you to print your images without having to repeatedly change your settings or
remember settings used in specific situations. If the preconfigured presets don’t meet your needs, you
can create your own.

For example, if you regularly print both 8-by-10-inch and 11-by-14-inch photographs, you can create
a print preset for each of those paper sizes. For photographers with multiple printers, such as a standard
and wide-format inkjet printer, you can create print presets for each printer. Give each preset a name
you’ll remember, and the next time you need to print, simply select the print preset that corresponds to
your paper size or printer type.

You can create new print presets, modify existing print presets, and delete print presets you no longer
use. When changing your print presets, remember that modifying an existing preset changes its original
settings; creating a new preset, on the other hand, allows you to preserve the settings in the existing
preset. For more information about working with print presets, see “Creating and Modifying Print
Presets.”

Before you print your images, you can soft proof them onscreen using the onscreen proofing feature.
Profiles used for onscreen proofing are also applied to the image when printed. For more information
about onscreen proofing, see “Setting Up the Viewer for Onscreen Proofing.”

Printing Tips
Here are a few suggestions to help you with the printing process:

e Use the highest-resolution image possible: 1t’s preferable to work with images imported directly
from your digital camera. However, even images imported directly from your camera or card
reader can be low-resolution, low-quality images. This is why it’s important to shoot with the
highest-resolution settings available on your camera. Compression settings applied during image
capture may be apparent when you print. Consider shooting RAW files if the setting is available,
and shoot at the highest bit depth possible.

If you’ve imported an image that was reduced or compressed in another application, Aperture
cannot increase the resolution of the file. In other words, Aperture cannot replace image
information that was previously removed during the compression process. If possible, locate the
original full-resolution image file, use the Lift and Stamp tools to apply the adjustments you’ve
made to the low-resolution file, and print the higher-resolution image file.

e Use a printer that supports 16-bit printing: Using a printer that supports 16-bit printing provides
the widest color gamut for your prints. 16-bit printers have a wider range of colors, resulting in
less color clipping.

e Color calibrate your Aperture system: It’s important to calibrate your display and printer so that
your printed images look as much as possible like the images you see on the computer screen. For
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more information about color calibrating your Aperture system, see “Calibrating Your Aperture
System.”
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Print Controls in the Print Dialog

Whether you’re printing a high-resolution print or a single image multiple times on the same page, you
use the Standard print controls in the Print dialog to print your work. If you want to print multiple image
contact sheets, you use the Contact Sheets controls in the Print dialog.

@ To open the Print dialog

® Select an image or series of images in the Browser, then choose File > Print Images (or press Command-
P).

I Presets list

I 1
Lala ) ion

= Presvriew area

- |1 e g | o 35 - o4 e (b o - |

| Print options area

To simplify your workflow, there are two versions of print options for both Standard and Contact Sheets
presets in the Print dialog. The default Print dialog contains basic print and layout controls. Clicking the
More Options button reveals additional controls such as layout, margin, image border, metadata, and
image adjustment settings, and additional options such as page numbers and crop marks. These
additional controls are often only set once, but you can access them at anytime.

@ To open additional print controls

® Click the More Options button.
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For more information about working with the default set of Standard print controls, see “Default Print
Controls for Standard Prints.”

For more information about working with the full set of Standard print controls, see “Additional Print
Controls for Standard Prints.”

For more information about working with the default set of Contact Sheets controls, see “Default Print
Controls for Contact Sheets.”

For more information about working with the full set of Contact Sheets controls, see “Additional Print
Controls for Contact Sheets.”

Presets List

Most of the controls in the Print dialog are dependent on the selection in the Presets list. Selecting the
Standard preset displays options for printing a single image per page or the same image multiple times
on the same sheet of paper. Selecting a Contact Sheets preset displays options for printing contact
sheets. Presets you’ve saved for both standard prints and contact sheets appear in the Custom Presets
section of the Presets list.

e Standard: Select this preset if you want to print a single image per page or the same image multiple
times on the same page. Settings modified using this preset are reset to their default values each time

the Print dialog is closed.

e (Contact Sheets: Select this preset if you want to print a series of images on one or more pages.
Settings modified using this preset are reset to their default values each time the Print dialog is
closed.

e Custom Presets: Presets you create and save appear here.

For more information on working with print presets, see “Creating and Modifying Print Presets.”

Preview Area
The Preview area displays how the image or images will appear on paper when they are printed.
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e Navigation buttons: Click these arrow buttons to navigate through the pages, if there are multiple
pages to print.

e Cancel button: Click this button to close the Print dialog.

e Print button: Click this button to send your print job to the printer.

Copyright © 2009 Apple Inc. All rights reserved.
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Default Print Controls for Standard Prints

There are a default set of printer and layout controls for standard print presets.

@ To access the default print controls for standard print presets
® Select either the Standard print preset or a custom preset in the Presets list of the Print dialog.

The basic controls for standard print presets are shown. If more controls appear, click the Fewer Options
button at the bottom-left corner of the Print dialog.

Select the Standard
preset to see the print
controls for printing
individual images.

The More Options button
indicates that the default
print controls are shown.

® Printer pop-up menu: Choose a printer from this pop-up menu.
e Color Profile pop-up menu: Choose a printer profile to use when printing.

Note: It is recommended that you choose the profile that matches the paper you intend to print the
image on or a custom-calibrated profile. For more information about paper print profiles, visit the
printer manufacturer’s website.

e Paper Size pop-up menu: Choose a paper size from the list of available sizes, including roll paper and
custom paper sizes.

e Width and Height fields: Enter the width and height of the printable area when Custom or Roll Paper is
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chosen in the Paper Size pop-up menu.

Note: This option does not appear unless Custom or Roll Paper is chosen in the Paper Size pop-up
menu. The units of measurement displayed in these fields depend on the region selected in the
International pane of System Preferences. For more information about System Preferences, see Mac
Help.

e QOrientation pop-up menu: Choose either the Landscape or Portrait aspect ratio from this pop-up
menu. The image version’s orientation should already be selected by default.

Note: The orientation selection affects the placement of logos, titles, metadata, and page numbers on
the page.

e /mage Size pop-up menu: Choose a fixed size for the printed image from the list of available sizes, as
well as Maximum to Fit and Custom. When Maximum to Fit is chosen, Aperture prints as much of the
image on the selected paper size as possible. When a borderless paper size is chosen in the Paper Size
pop-up menu, Aperture prints the image with no borders.

When Custom is chosen, height and width fields appear beneath the Image Size pop-up menu. To set
a custom image size, enter new height and width values.

e Photo Per Page field: Enter the number of images per page to print.

Note: This option appears dimmed when the image size selection is too large for more than one
image to fit on the selected paper size.

e Same Photo Per Page checkbox: Select this checkbox to repeat the same photo multiple times on the
same page.

Note: This option appears dimmed unless the selected image size is small enough to accommodate
multiple images on the selected paper size.

e Crop Image to Fill checkbox: Select this checkbox to make the image fill the frame of the Image Size
selection. In most situations, a border appears on two sides.

e More Options button: Click this button to reveal more print options such as additional layout, margin,
image border, metadata, and image adjustment settings.

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=19%26section=3 Page 2 of 2

Petitioner Apple Inc. - Ex. 1005, p. 756



Aperture 3 User Manual: Additional Print Controls for Standard Prints 9/28/21 1:03 PM

Additional Print Controls for Standard Prints

You can access additional print options, such as additional layout, margin, render, image adjustment,
image border, and metadata controls. For example, you can use these controls to include your studio’s
name and logo on each print and then save the settings as a preset. The next time you print images,
select the print preset you just saved and print your image selection using the default print controls for
standard prints.

© To access additional print controls for standard and custom print presets

® Select either the Standard preset or a custom preset in the Presets list of the Print dialog, then click the
More Options button.

The Print dialog expands to show additional print controls for standard prints. After adjusting the
additional print settings, click the Fewer Options button at the bottom-left corner of the Print dialog to
return to the default print controls.

Select the Standard
preset to see the print
controls for printing
individual images.

Click the More Options
button to show
additional print controds
fior standard prints,

Printer
Use the following controls to choose a printer and paper size.
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e Printer pop-up menu: Choose a printer from this pop-up menu.

e Paper Size pop-up menu: Choose a paper size from the list of available sizes, including roll paper and
custom paper sizes.

e Width and Height fields: Enter the width and height of the printable area when Custom or Roll Paper is
chosen in the Paper Size pop-up menu.

Note: This option does not appear unless Custom or Roll Paper is chosen in the Paper Size pop-up
menu.

Layout

Use the following controls to choose the orientation of the images on the page, the image size, and
spacing between images when multiple images are printed on the same sheet of paper.
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e Orientation pop-up menu: Choose either the Landscape or Portrait aspect ratio from this pop-up
menu. The image version’s orientation should already be selected by default.

Note: The orientation selection affects the placement of logos, titles, metadata, and page numbers on
the page.

e /mage Size pop-up menu: Choose a fixed size for the printed image from the list of available sizes, as
well as Maximum to Fit and Custom. When Maximum to Fit is chosen, Aperture prints as much of the
image on the selected paper size as possible. When a borderless paper size is chosen in the Paper Size
pop-up menu, Aperture prints the image with no borders.

When Custom is chosen, height and width fields appear beneath the Image Size pop-up menu. To set
a custom image size, enter new height and width values.

e Photo Per Page field: Enter the number of images per page to print.

Note: This option appears dimmed when the image size selection is too large for more than one
image to fit on the selected paper size.

e Same Photo Per Page checkbox: Select this checkbox to repeat the same photo multiple times on the
same page.

Note: This option appears dimmed when the image size selection is too large for two images to fit on
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the selected paper size, or when the Photo Per Page option is set to 1.

e Crop Image to Fill checkbox: Select this checkbox to make the image fill the frame of the Image Size
selection. In most situations, a border appears on two sides.

e Rows value slider: Enter the number of rows of images per page to print.

Note: Aperture sets the Image Size to Custom and automatically scales the size of the images based
on the number of rows specified.

e Columns value slider: Enter the number of columns of images per page to print.

Note: Aperture sets the Image Size to Custom and automatically scales the size of the images based
on the number of columns specified.

e Row Spacing value slider: Enter the amount of space to place between the image rows when multiple
images are printed on the page.

e Column Spacing value slider: Enter the amount of space to place between the image columns when
multiple images are printed on the page.

Margins

Use the following controls to set the width of the margins around the image.
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e Top value slider: Enter the amount of space, in inches, to place between the top edge of the page and
the top of the image or images.

e Right value slider: Enter the amount of space, in inches, to place between the right edge of the page
and the right side of the image or images.

e Bottom value slider: Enter the amount of space, in inches, to place between the bottom edge of the
page and the bottom of the image or images.

e [eft value slider: Enter the amount of space, in inches, to place between the left edge of the page and
the left side of the image or images.

Rendering

Use the following controls to apply a color profile, render intent, and black point compensation, and to
adjust the print resolution.
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e Color Profile pop-up menu: Choose a printer profile to use when printing.

e Render Intent pop-up menu: Choosing a render intent tells Aperture what to do with colors that fall
outside of the printer’s color gamut. The two render intent options are Perceptual and Relative
Colorimetric.

For more information about perceptual render intent, see “perceptual.”
For more information about relative colorimetric render intent, see “relative colorimetric.”

e Black Point Compensation checkbox: Select this checkbox to scale the black and white luminance
values to the selected ColorSync profile. This option compensates for the difference between the way
black images are saturated on a computer screen and the way black ink is saturated on paper. Turning
on black point compensation can prevent shadows from appearing as solid black.

e Print Resolution pop-up menu: Choose between applying the optimal DPI for the image size, a
standard DPI setting, or setting the DPI manually.

e PP field: Enter the PPI for the printed image in this field.
Note: This option appears dimmed unless Print Resolution is set to Custom.

Image Adjustments

Use the following controls to adjust brightness, contrast, saturation, and image sharpness. In addition,
you can click the Loupe button to spot check adjustments and image sharpness before printing.
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Loupe button

e Brightness slider and value slider: Specify a brightness setting so that the printed image matches the
display’s output as closely as possible. Because displays illuminate images, images shown on a display
tend to appear more luminous than when printed. Increasing the brightness value can compensate for
this difference. A typical setting ranges between 1.1 and 1.2.

e (Contrast slider and value slider: Apply additional contrast to the image using the Contrast slider and
value slider. Some printers have a tendency to print images a bit “washed out.” Adding additional
contrast can enhance the tonal values where they otherwise would have appeared flat.
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e Saturation slider and value slider: Increase or decrease image saturation using the Saturation slider
and value slider.

e Sharpen checkbox: Select this checkbox to apply a sharpening adjustment to the printed image. Use
the Amount and Radius sliders and value sliders to modify the parameters of the Sharpen adjustment.

e Sharpen Amount slider and value slider: Specify the amount of sharpness applied to the printed
image. Because images appear sharper onscreen than they do in print, a sharpen adjustment is often
necessary to make the printed image match the image that appears onscreen.

e Sharpen Radius slider and value slider: Specify the area over which the sharpening adjustment is
applied (the distance, in pixels, that Aperture uses to evaluate sharpness).

e [oupe button: Click this button to open the Loupe. Use the Loupe to zoom in to the image to ensure
that the additional adjustments you’ve applied to it meet your expectations.

Tip: It’s a good idea to use the Loupe to check image detail when applying Sharpen adjustments, to
verify that you haven’t sharpened the image too much.

Image Options

Use the following controls to rotate the image to fit the dimensions of the paper, as well as to apply
image borders and watermarks.
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e Rotate to Fit checkbox: Select this checkbox to rotate the image so that it matches the option chosen
in the Orientation pop-up menu.

e Border Size value slider: Specify the width of the image border by dragging the Border value slider to
the right to increase the border’s size, and to the left to decrease it. A setting of 0 (zero) applies no
border.

e Border Color control: Change the border color by clicking in the Border Color well and choosing a new
color from the Colors window, or by clicking the arrow button (to the right of the color well) and
choosing a new color from the pop-up color palette.

e Watermark pop-up menu: Choose to locate and apply a watermark to your image. When you apply a
watermark, additional controls become available.

e Position pop-up menu: Choose where to position the watermark over the image.
Note: This option does not appear unless a watermark is chosen in the Watermark pop-up menu.

e Opacity slider: Adjust the opacity of the watermark using the Opacity slider. Dragging the slider to the
right increases the watermark’s opacity—making it more visible—and dragging the slider to the left
decreases its visibility.

Note: This option does not appear unless a watermark is chosen in the Watermark pop-up menu.

e Scale Watermark checkbox: Select this checkbox to scale down the watermark.
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Note: This option does not appear unless a watermark is chosen in the Watermark pop-up menu.

Metadata & Page Options

Use the following controls to print an image’s metadata beside it. You can also add comment lines
beside the image to provide a space for reviewers to write notes, as well as print cut lines, page
numbers, your studio’s logo, a title, and a subtitle.
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e Metadata View pop-up menu: Choose a metadata view to display beside each image.
e Position pop-up menu: Choose where you want the metadata text positioned from this pop-up menu.

e font, font style, and font size pop-up menus: Choose a font, font style, and font size for the metadata
text. The chosen font and font style are also used for the title, subtitle, and page numbers.

e [ogo pop-up menu: Choose a logo to print at the top of the page above the image.
Note: The logo size is 0.5 inches tall.

e Comment Lines value slider: Use this control to specify the number of horizontal lines beside each
image in the contact sheet available to reviewers for written comments. When the value slider is set to
0 (zero), no comment lines are printed.

e Title checkbox: Select this checkbox to append a title at the top of the printed contact sheet. Aperture
adds the project’s name as the title. However, you can change the title by entering a new one in the
Preview area of the Print dialog.

e Sub Title checkbox: Select this checkbox to apply subtitle text below the title above the image.
Note: This option appears dimmed unless the Title checkbox is selected.

e Page Numbers checkbox: Select this checkbox to print page numbers. The page numbers are centered
on the bottom of the page. If a logo or title has been applied, the page numbers are displayed at the
upper-right corner of the page.

e Crop Marks checkbox: Select this checkbox to print cut lines.

Note: The cut lines are not visible unless the Margins settings are greater than zero.

Print Options

Use the following controls to collapse or expand the visible print controls, as well as save, duplicate, and
delete print presets.
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e Fewer Options button: Click this button to minimize the print options to the default controls.

e Print Action pop-up menu: Use this pop-up menu (with a gear icon) to save, duplicate, and delete
print presets.
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Default Print Controls for Contact Sheets

There are a default set of printer and layout controls for contact sheet presets.

@ To access the default print controls for contact sheet presets

m Select either the Contact Sheets preset or a contact sheet preset saved in the Custom Presets area of the
Print dialog.

The Printer and Layout controls for contact sheet presets are shown. If more controls appear, click the
Fewer Options button at the bottom-left corner of the Print dialog.

nnA

Select the Contact
Sheets preset to see the
print controls for printing
contact sheets.
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The More Options button
indicates that the default
print controls are showen.

Printer pop-up menu: Choose a printer from this pop-up menu.

Color Profile pop-up menu: Choose a printer profile to use when printing.

Paper Size pop-up menu: Choose a paper size from the list of available sizes, including roll paper and
custom paper sizes.

Width and Height fields: Enter the width and height of the printable area when Custom or Roll Paper is
chosen in the Paper Size pop-up menu.

Note: This option does not appear unless Custom or Roll Paper is chosen in the Paper Size pop-up
menu.

Orientation pop-up menu: Choose either a Landscape or Portrait aspect ratio from this pop-up menu.
The image version’s orientation should already be selected by default.
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e Metadata View pop-up menu.: Choose a metadata view to display underneath each image on the
contact sheet.

e Rows value slider: Enter the number of rows of images per page to print.

e Columns value slider: Enter the number of columns of images per page to print.

e More Options button: Click this button to reveal more print settings such as additional layout controls,

margins, image borders, metadata, and image adjustments.

Copyright © 2009 Apple Inc. All rights reserved.
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Additional Print Controls for Contact Sheets

You can access additional print options, such as additional layout, margin, image border, metadata, and
image adjustment controls. For example, you can use these controls to include your studio’s name and
logo on each print along with a limited amount of metadata printed below each image and then save the
settings as a contact sheet preset. The next time you want to print a contact sheet, select the contact
sheet preset you just saved, and print a contact sheet of your image selections using the default print
controls for contact sheets.

@ To access the additional print controls for contact sheet presets

m Select either the Contact Sheets preset or a contact sheet preset saved in the Custom Presets area of the
Print dialog, then click the More Options button.

The Print dialog expands to show additional print controls for contact sheets. After adjusting the
additional print settings, click the Fewer Options button at the bottom-left corner of the Print dialog to
return to the default print controls.

—— Select the Contact
Sheets preset to see the
print controls for printing
contact sheets.

Papes Size: | US Letter 1]
Orientation: | Landstaps i
Matadata View: | Nore 3]

Click the More Options
button to show
additipnal print controls
for contact sheets.

Printer

Use the following controls to choose a printer and paper size.
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Prisaar; | o Prinver Seloctsd |
PaperSiee; | USLemer 4l

e Printer pop-up menu: Choose a printer from this pop-up menu.

e Paper Size pop-up menu: Choose a paper size from the list of available sizes, including roll paper and
custom paper sizes.

e Width and Height fields: Enter the width and height of the printable area when Custom or Roll Paper is
chosen in the Paper Size pop-up menu.

Note: This option does not appear unless Custom or Roll Paper is chosen in the Paper Size pop-up
menu.

Layout

Use the following controls to choose the orientation of the contact sheet on the page, the image size,
and spacing between each image.

Row Spacing (- 013 - | IR

|

|

‘ | -.I
i Column Spacing: F-"EITITT" (1.8
|

e OQOrientation pop-up menu: Choose either the Landscape or Portrait aspect ratio from this pop-up
menu.

e Rows value slider: Enter the number of rows of images per page to print.
e Columns value slider: Enter the number of columns of images per page to print.

e Row Spacing value slider: Enter the amount of space, in inches, to place between the image rows when
multiple images are printed on the page. Aperture automatically adjusts the size of the images in
order to accommodate the change in row spacing from its default value.

e Column Spacing value slider: Enter the amount of space, in inches, to place between the image
columns when multiple images are printed on the page. Aperture automatically adjusts the size of the
images in order to accommodate the change in column spacing from its default value.

Margins
Use the following controls to set the width of the margins around the contact sheet.

Murgins
.50 i
| :
f+ 0,50 =\ iﬁ! s 050 =k
.
056 =i
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e Top value slider: Enter the amount of space, in inches, to place between the top edge of the page and
the top of the images.

e Right value slider: Enter the amount of space, in inches, to place between the right edge of the page
and the right side of the images.

e Bottom value slider: Enter the amount of space, in inches, to place between the bottom edge of the
page and the bottom of the images.

e [eft value slider: Enter the amount of space, in inches, to place between the left edge of the page and
the left side of the images.

Rendering

Use the following controls to apply a color profile, render intent, and black point compensation, and to
adjust the print resolution.

Rendering
Colior Predila | Printer Maragud [

Rt mber by dizabils yir
0 IFEE | LS MARSpEFSE

Render intent: | Relanve Colorimetic 4 |
1 Black Posrt Compensation |
PrintResolunce: (Aee 2]

e Color Profile pop-up menu: Choose a printer profile to use when printing.

e Render Intent: Choosing a render intent tells Aperture what to do with colors that fall outside of the
printer’s color gamut. The two render intent options are Perceptual and Relative Colorimetric.

For more information about perceptual render intent, see “perceptual.”
For more information about relative colorimetric render intent, see “relative colorimetric.”

e Black Point Compensation checkbox: Select this checkbox to scale the black and white luminance
values to the selected ColorSync profile. This option compensates for the difference between the way
black images are saturated on a computer screen and the way black ink is saturated on paper. Turning
on black point compensation can prevent shadows from appearing as solid black.

e Print Resolution pop-up menu: Choose between applying the optimal DPI for the image size, a
standard DPI setting, or setting the DPI manually.

e PPl field: Enter the PPI for the images in the contact sheet in this field.
Note: This option appears dimmed unless the Print Resolution is set to Custom.

Image Adjustments

Use the following controls to adjust brightness, contrast, saturation, and image sharpness. In addition,
you can click the Loupe button to check your adjustments and image sharpness before printing.

Note: The adjustments applied using the Print dialog are applied to each image in the contact sheet
uniformly.
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e Brightness slider and value slider: Specify a brightness setting so that the images in the contact sheet
match the display’s output as closely as possible. Because displays illuminate images, images shown
on a display screen tend to appear more luminous than when printed. Increasing the brightness value
can compensate for this difference. A typical setting ranges between 1.1 and 1.2.

e (Contrast slider and value slider: Apply additional contrast to the images in the contact sheet using the
Contrast slider and value slider. Some printers have a tendency to print images a bit “washed out.”
Adding additional contrast can enhance the tonal values where they otherwise would have appeared
flat.

e Saturation slider and value slider: Increase or decrease the image saturation in the contact sheet using
the Saturation slider and value slider.

e Sharpen checkbox: Select this checkbox to apply a sharpening adjustment to the images in the contact
sheet. Use the Amount and Radius sliders and value sliders to modify the parameters of the Sharpen
adjustment.

e Sharpen Amount slider and value slider: Specify the amount of sharpness applied to the images in the
contact sheet. Because images appear sharper onscreen than they do in print, a sharpen adjustment is
often necessary to make the printed images match the images that appear onscreen.

e Sharpen Radius slider and value slider: Specify the area over which the sharpening adjustment is
applied (the distance, in pixels, that Aperture uses to evaluate sharpness).

e [oupe button: Click this button (with a loupe icon) to open the Loupe. Use the Loupe to zoom in to the
images in the contact sheet to ensure that the additional adjustments you’ve applied to them meet
your expectations.

Tip: It’s a good idea to use the Loupe to check image detail when applying Sharpen adjustments, to
verify that you haven’t sharpened the images in the contact sheet too much.

Image Options
Use the following controls to rotate the images in the contact sheet to fit the dimensions of the paper, as
well as to apply image borders and watermarks.

limage Opticns
|| Rotate 1o Fit
Border Size: (- 000 - i
Border Color | I - |

e Rotate to Fit checkbox: Select this checkbox to rotate the images in the contact sheet so that they
match the option chosen in the Orientation pop-up menu.
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e Border Size value slider: Specify the width of the image borders for each image in the contact sheet by
dragging the Border value slider to the right to increase the border’s size, or to the left to decrease it.
A setting of O (zero) applies no border to the images in the contact sheet.

e Border Color controls: Change the border color by clicking the Border Color well and selecting a new
color from the Colors window, or by clicking the disclosure button to the right of the color well and
selecting a new color from the pop-up color palette.

o Watermark pop-up menu: Choose a watermark to apply to your images in the contact sheet. When you
apply a watermark, additional controls become available.

e Position pop-up menu: Choose where to position the watermark over each image in the contact sheet
from this pop-up menu. The watermark is applied to each image uniformly.

Note: This option does not appear unless a watermark is chosen in the Watermark pop-up menu.

e Opacity slider: Adjust the opacity of the watermark using the Opacity slider and value slider. Dragging
the slider to the right increases the watermark’s opacity—making it more visible—and dragging the
slider to the left decreases its visibility.

Note: This option does not appear unless a watermark is chosen in the Watermark pop-up menu.
e Scale Watermark checkbox: Select this checkbox to scale down the watermark.

Note: This option does not appear unless a watermark is chosen in the Watermark pop-up menu.

Metadata & Page Options

Use the following controls to print an image’s metadata beside it. You can also add comment lines
beside the image to provide a space for reviewers to write notes.

Mesadata & Fage Opticns
Metadata View: |hooe 1]
Position: | Belowimage 1|
e | Halvacica heus i
[Reguir  =|[B 2|
e —
Comeeat Lives: = @+ ]
[ I Tithe
Bxh Tieke
1| Pagee Mumbers b
|| Croe Marks

e Metadata View pop-up menu: Choose a metadata view to display beside each image.
e Position pop-up menu: Choose where you want the metadata text positioned.

e font, font style, and font size pop-up menus: Choose a font, font style, and font size for the metadata
text.

e Logo pop-up menu.: Choose a logo to print at the top of the contact sheet.

e Comment Lines value slider: Use this control to specify the number of horizontal lines beside each
image in the contact sheet available to reviewers for written comments. When the value slider is set to
0 (zero), no comment lines are printed.
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e Title checkbox: Select this checkbox to append a title at the top of the printed contact sheet. Aperture
adds the project’s name as the title. However, you can change the title by entering a new one in the
Preview area of the Print dialog.

e Sub Title checkbox: Select this checkbox to apply subtitle text below the title.
Note: This option appears dimmed unless the Title checkbox is selected.

e Page Numbers checkbox: Select this checkbox to print page numbers. The page numbers are centered
on the bottom of the page. If a logo or title has been applied, the page numbers are displayed at the
upper-right corner of the page.

e Crop Marks checkbox: Select this checkbox to print cut lines.
Note: The cut lines are not visible unless the Margins settings are greater than zero.

Print Options

Use the following controls to collapse or expand the visible print controls, as well as save, duplicate, and
delete print presets.

......... — O Save Prewst k.
Deiplicate Preset
Delote Preset

e Fewer Options button: Click this button to minimize the print options to the default controls.

e Print Action pop-up menu: Use this pop-up menu (with a gear icon) to save, duplicate, and delete
print presets.

Copyright © 2009 Apple Inc. All rights reserved.
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Unifying and Splitting Master Pages

Some master pages have left and right versions to match the book margins on the left and right facing
pages. You can select a left or right master page and consolidate the two versions into one page.

@ To unify left and right versions of a master page

1. Select a left or right master page in the Master Pages pane of the Book Layout Editor.

2. Choose Unify Master Page from the Book Action pop-up menu (with a gear icon).

You can also select a master page that has only one version and split it into left and right versions.

@ To split a master page that doesn’t have left or right versions into left and right versions
1. Select a master page in the Master Pages pane of the Book Layout Editor.
2. Choose Split Master Page from the Book Action pop-up menu (with a gear icon).

You can now adjust the position of items on the new pages to match the margins on the left and right
pages.

Copyright © 2009 Apple Inc. All rights reserved.
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Updating Book Pages with Master Page Changes

After you change a master page, the modified design can be applied to pages in your book. Aperture
does not automatically update the design of pages whose master pages are modified. However, you can
choose to update the pages in a book with revised master page designs.

@ To update a page with a changed master page design

1. In the Pages pane of the Book Layout Editor, select the page whose master page design you want to
update.

2. Choose Reapply Master from the Book Action pop-up menu (with a gear icon).

Aperture applies the current master page design to the selected page.

Copyright © 2009 Apple Inc. All rights reserved.
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Printing Images and Contact Sheets in Aperture

There are several configurations in which you can print photos in Aperture. See the
following sections for details on these options:

e “Printing a Single Image”

e “Printing the Same Image Multiple Times on a Single Sheet of Paper”
e “Printing a Series of Images”

e “Printing a Contact Sheet or Series of Contact Sheets”

e “Manually Adjusting Image Layout in the Preview Area”

Copyright © 2009 Apple Inc. All rights reserved.
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Printing a Single Image

When you want to print a single, high-resolution image on a single sheet of paper, you
use the Standard preset or one of the presets in the Custom Presets area of the Print

dialog.

w N = Q

To print a single image
In the Browser, select an image.
Choose File > Print Image (or press Command-P).

In the Print dialog, select either the Standard preset or a preset in the Custom Presets
area.

4. In the default print options area, specify the following settings:

Choose a printer from the Printer pop-up menu.

If necessary, choose a print profile from the Color Profile pop-up menu.

Note: Printer Managed, the default setting, is the appropriate choice in most cases.
If you are outputting to a specific device profile or if you have color calibrated your
printer, you should choose an appropriate profile from this pop-up menu.

Choose a paper size from the available items in the Paper Size pop-up menu.

In the Orientation pop-up menu, choose whether you want the image printed in
Landscape mode or Portrait mode.

Choose the size of the printed image from the Image Size pop-up menu, by doing
one of the following:

To print the image so that the entire image fits on the page: Choose Maximum to
Fit. If you’ve chosen a borderless printing option, Aperture fits the entire image
on the page; margins appear on two sides of the image where the dimensions
don’t match.

To print the image so that it fills in the entire page: Choose Maximum to Fit, and
select the Crop Image to Fill checkbox below the Image Size pop-up menu. If
you’ve chosen a borderless printing option, the image covers the entire page;
parts of the image are cropped if the dimensions don’t match.

To print the image at a standard size: Choose a standard dimension, such as
5 x 7, from the pop-up menu.

To print the image in a custom size: Choose Custom from the pop-up menu,
then enter the dimensions in the Height and Width fields that appear below.

5. After you’ve verified that the settings in the Print dialog are correct, click Print.

The OS X Print dialog appears.

6. Confirm that the settings in the OS X Print dialog are correct.
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Important: Make sure paper type and color profiles match the paper type and color
profile selected in the Aperture Print dialog.
7. Click Print.

The high-resolution image is printed on a single sheet of paper.

Use the Copies field in the OS X Print dialog to print multiple copies of your high-
resolution image.

@ To print multiple copies of an image

1. Follow steps 1 through 5 in the previous task.

2. In the OS X Print dialog, click the disclosure button to reveal additional print controls.

Printer: | No Printer Selected i8] [#}——— Qlick the disclosure
Presets: | Standard i t:urt_u_n o rE&'.eaI
additional print controls,
@ [ POFv ) [ Preview ) {-Cancel ) { Print

3. In the Copies field, enter the number of copies to print, then click Print.

Copyright © 2009 Apple Inc. All rights reserved.
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Printing the Same Image Multiple Times on a Single Sheet of Paper

You can print the same image multiple times on the same sheet of paper. This option
is useful for saving paper when the image size is small.

To print the same image multiple times on a single sheet of paper

In the Browser, select the image you want to print.

Choose File > Print Image (or press Command-P).

In the Print dialog, select either the Standard preset or a preset in Custom Presets.
In the default print options area, specify the following settings:

e Choose a printer from the Printer pop-up menu.

e If necessary, choose a print profile from the Color Profile pop-up menu.

Note: Printer Managed, the default setting, is the appropriate choice in most cases.
If you are outputting to a specific device profile or if you have color calibrated your
printer, you should choose an appropriate profile from this pop-up menu.

e Choose a paper size from the available items in the Paper Size pop-up menu.

e In the Orientation pop-up menu, choose whether you want the image printed in
Landscape mode or Portrait mode.

e Choose a standardized size, such as 2 x 3, for the printed image from the Image
Size pop-up menu. Pick a size that’s small enough to fit multiple images on the
paper size chosen in the Paper Size pop-up menu.

The Photo Per Page and Same Photo Per Page controls below the Image Size pop-up
menu become available.

e Enter the number of times you want the image printed on the page in the Photo Per
Page field, then select the Same Photo Per Page checkbox.

The Preview area updates to show multiple images on the page.

If you want each image to fill its allotted printable space, select the Crop Image to Fill
checkbox.

If you want to modify the arrangement of the images on the page, click the More
Options button at the bottom of the Print dialog, then use the Layout and Margins
controls to adjust the image spacing and page margins.

After you’ve verified that the settings in the Print dialog are correct, click Print.
The OS X Print dialog appears.
Confirm that the settings in the OS X Print dialog are correct.

Important: Make sure paper type and color profiles match the paper type and color
profile selected in the Aperture Print dialog.
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9. Click Print.

Copyright © 2009 Apple Inc. All rights reserved.
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Printing a Series of Images

You can print multiple images at once, each on its own sheet of paper.

To print a series of images

In the Browser, select the images you want to print.
Choose File > Print Images (or press Command-P).

In the Print dialog, select either the Standard preset or a preset in Custom Presets.

> W N = Q@

Confirm that the settings in the Print dialog are correct.
For more information about print settings, see “Printing a Single Image.”

5. If necessary, use the navigation buttons in the Preview area to verify that the images in
the job you are about to print are correct.

6. Click Print.
The OS X Print dialog appears.
7. Confirm that the settings in the OS X Print dialog are correct.

Important: Make sure paper type and color profiles match the paper type and color
profile selected in the Aperture Print dialog.

8. Click Print.

Your images are printed, one image per page.

Copyright © 2009 Apple Inc. All rights reserved.
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Printing a Contact Sheet or Series of Contact Sheets

You can print contact sheets of your images, and Aperture does all the layout work for
you. All you have to do is specify the number of pages or columns; Aperture adjusts
the size of the images based on your layout and margin settings.

To print contact sheets

In the Browser, select the images you want to print.
Choose File > Print Images (or press Command-P).

In the Print dialog, select either the Contact Sheets preset or the Fancy Contact Sheet
preset in Custom Presets.

In the default print options area, specify the following settings:
e Choose a printer from the Printer pop-up menu.
e If necessary, choose a color profile from the Color Profile pop-up menu.

Note: Printer Managed, the default setting, is the appropriate choice in most cases.
If you are outputting to a specific device profile or if you have color calibrated your
printer, you should choose an appropriate profile from this pop-up menu.

e Choose a paper size from the available items in the Paper Size pop-up menu.

e In the Orientation pop-up menu, choose whether you want the contact sheet printed
in Landscape mode or Portrait mode.

e Specify the number of rows and columns to set how many images are printed on the
page.

The Preview area updates to show the new print dimensions for each image in the
contact sheet. You can double-click an image to adjust its scale within the image
frame. You use the Image Scale HUD to zoom in to and out of the image.

If you want to modify the arrangement of the images on the page, click the More
Options button at the bottom of the Print dialog, then use the Layout and Margins
controls to adjust image spacing between the images and add margins.

If you want to manually adjust the spacing margins, drag the row and column lines in
the Preview area.

After you’ve verified that the settings in the Print dialog are correct, click Print.
The OS X Print dialog appears.
Confirm that the settings in the OS X Print dialog are correct.

Important: Make sure paper type and color profiles match the paper type and color
profile selected in the Aperture Print dialog.

Click Print.
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Your contact sheet is printed.

Copyright © 2009 Apple Inc. All rights reserved.
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Manually Adjusting Image Layout in the Preview Area

In addition to using the Layout and Margins controls in the Print dialog, you can
manually adjust the margins and spacing in the Preview area of the Print dialog. When
printing a single image with a border or dimensions smaller than the paper size, you
can adjust the placement of the image on the page by dragging the margin lines in the
Preview area. Similarly, when you are printing multiple images on the same sheet of
paper, you can adjust both the margins surrounding the images and the spacing
between the images. If you selected the Crop Marks checkbox in the Metadata & Page
Options section of the Print dialog, you can also adjust the crop lines to modify the
margins and spacing of the images on the page.

Note: The margin lines are not visible unless you place the pointer over the Preview
area of the Print dialog.

© To manually adjust the placement of a single image on a page
1. In the Browser, select the image you want to print.
2. Choose File > Print Images (or press Command-P).

3. In the Print dialog, choose a single image print preset and an image size that is
smaller than the chosen paper size.

4. In the Preview area, drag the margin lines to adjust the placement of the image on the
page.
The averlay displays the
distance between the

edge of the paper and
the edge of the image.
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Drag the margin lines to
adjust the placement of
the image on the page.

The distance between the edge of the paper and the edge of the image is displayed in
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an overlay as you drag the margin line.

To manually adjust the placement of multiple images on a page

In the Browser, select the image or images you want to print.

Choose File > Print Images (or press Command-P).

In the Print dialog, do one of the following:

e Select a print preset that prints the same image multiple times on the same sheet of

paper.

e Select a print preset for a contact sheet.

In the Preview area, do either or both of the following:

e Drag the margin lines between the outer edges of the images and the paper’s edge.

e Drag the lines between the images to adjust the spacing between them.

Drag the lines between
the images to adjust the
spacing between them.

b ot d o 8 - - i (L L T

The averlay displays the
distance between the
images.

Dragging one vertical line adjusts the vertical spacing between all images on the
page equally; similarly, dragging one horizontal line adjusts the horizontal spacing
between the images in equal amounts.
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Printing a Book

You can print a book to check its final format and appearance before handing it off to
a professional printer, ordering a printed copy online, or distributing copies to others.

For more information about creating and working with books, see “Creating Books.”

@ To print a book

1. Select a book album in the Library inspector.
The book appears in the Book Layout Editor.
2. Choose File > Print Book (or press Command-P).
The OS X Print dialog appears.
3. Verify that the settings in the OS X Print dialog are correct, then click Print.

Your book is printed.

You can also create a PDF file of a book to store an electronic copy for use at another
time or to send to others.

To create a PDF file of a book

In the Library inspector, select a book album.

Choose File > Print Book (or press Command-P).

w N = Q

In the Print dialog, choose Save as PDF from the PDF pop-up menu.
The Save dialog appears.

4. Enter a name for the PDF file and choose a location to save the file, then click Save.

Copyright © 2009 Apple Inc. All rights reserved.
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Printing a Light Table Arrangement

You can print an arrangement of images in the Light Table.

@ To print a Light Table arrangement
1. Select a Light Table album in the Library inspector.

The Light Table appears above the Browser.
2. Do one of the following:
e To print selected images: Select the images you want to print in the Light Table.

e To print the entire Light Table arrangement: Deselect all images in the Light Table
by clicking the background.

3. Choose File > Print Light Table (or press Command-P).
The OS X Print dialog appears.
4. Verify that the settings in the OS X Print dialog are correct, then click Print.

Your Light Table arrangement is printed.

You can also create a PDF of your Light Table arrangement using the OS X Print dialog.

@ To create a PDF file of a Light Table arrangement
1. Select a Light Table album in the Library inspector.

The Light Table appears above the Browser.
2. Do one of the following:
e To print selected images: Select the images you want to print in the Light Table.

e To print the entire Light Table arrangement: Deselect all images in the Light Table
by clicking the background.

3. Choose File > Print Light Table (or press Command-P).
The OS X Print dialog appears.

4. Choose Save as PDF from the PDF pop-up menu in the bottom-left corner of the
dialog.

The Save dialog appears.

5. Enter a name for the PDF file in the Save As field, and choose a location to save the
PDF file to from the Where pop-up menu.

6. Verify that the settings in the Save dialog are correct, then click Save.

A PDF file of your Light Table arrangement is saved to the location you chose in the
Save dialog.
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Creating and Modifying Print Presets

After examining a selected preset’s print settings, you may want to change certain
settings. You can do this by modifying an existing print preset and then saving it, or
by duplicating an existing print preset and making changes to it. You use the presets
stored in the Custom Presets area of the Print dialog to create and save your
customized print presets.

Note: The settings modified in the Standard and Contact Sheets presets are reset to
their default values each time the Print dialog is closed.
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Modifying an Existing Print Preset

Any existing print preset under Custom Presets can be changed, either temporarily or
permanently. If you change a preset’s settings without saving it, the preset will revert
to its original settings after the print job is processed. If you save the modified
settings, the preset will retain the setting changes.

@ To modify an existing print preset
1. Choose File > Print (or press Command-P).
The Print dialog appears.

2. In the Print dialog, select a print preset under Custom Presets, then click the More
Options button.

3. Modify the settings as appropriate.

4. When you’re ready to save the preset, choose Save Preset from the Print Action pop-up
menu (with a gear icon).

The print preset is saved with its new settings.

If you want to preserve the settings in an existing print preset, you can duplicate it and
then modify the new print preset as described in “Creating a New Print Preset.”
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Creating a New Print Preset

In Aperture, you create new print presets by duplicating existing print presets and
then making modifications to them.

@ To create a new print preset using the Duplicate Preset command

1. Choose File > Print Images (or press Command-P).
The Print dialog appears.

2. In the Print dialog, select a print preset under Custom Presets that you want to
duplicate, then choose Duplicate Preset from the Print Action pop-up menu (with a
gear icon).

3. Enter a new name for the preset.

4. Modify the settings as appropriate, then choose Save Preset from the Print Action pop-
up menu.

You can now select this preset whenever you need to use these print settings.

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=19%26section=17

10/1/21 11:24 AM

Page 1 of 1

Petitioner Apple Inc. - Ex. 1005, p. 789



Aperture 3 User Manual: Deleting a Print Preset 10/1/21 11:24 AM

Deleting a Print Preset

You can delete a print preset that you no longer use.

@ To delete a print preset

1. In the Custom Presets section of the Print dialog, select the preset you want to delete.
2. Choose Delete Preset from the Print Action pop-up menu (with a gear icon).
3. Confirm the deletion in the dialog that appears.

The preset is deleted from the Custom Presets list.
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Proofing Your Images Onscreen

The printer, paper type, and color profile settings all affect the way your images are
printed. Onscreen proofing allows you to check the color in your images, before you
print them.

To use onscreen proofing, choose the proofing profile that most closely matches the
characteristics of the final output device, and then turn on onscreen proofing. When
onscreen proofing is turned on, the image is converted using the selected profile
before it is sent to the printer.

For more information about ColorSync profiles and color calibrating your computer,
see “Calibrating Your Aperture System.”

@ To choose a proofing profile

® Choose View > Proofing Profile, then choose the profile you want from the submenu.

@ To turn onscreen proofing on or off
® Choose View > Onscreen Proofing (or press Shift-Option-P).

When onscreen proofing is on, a checkmark appears beside the item in the View menu.

For more information about using the Aperture onscreen proofing feature, see “Setting
Up the Viewer for Onscreen Proofing.”
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Turning Off Color Management in Your Printer

For best results, you should turn off color management in your printer when printing
an image using Aperture. By default, most printers are set to convert the image to the
printer’s color space. However, Aperture is designed to perform this conversion
internally. Each printer manufacturer creates its own Print dialog. This means the
setting for turning off color management in your printer varies depending upon the
manufacturer of your printer and the printer model.

Note: If you have multiple printers connected to your computer, you should create a
print preset and turn off color management for each printer.

@ To turn off color management for your printer

® Refer to the owner’s manual that came with your printer.
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Exporting Your Images

After you’ve finished working on your images, you can use Aperture to export them as
files. You can export these files to another application, send them to a printing service
or to your clients via email, or publish them on the web. You can export your images
in several formats, including JPEG, TIFF, PNG, and PSD file formats. During export you
can rename, resize, and adjust images and include EXIF information, IPTC information,
or other metadata. You can also apply ColorSync profiles and watermarks to files you
export.

If you worked with audio and video in Aperture, you can export both the version and
master files. If you trimmed the length of the audio or video files in Aperture, the
edited length is preserved in the exported versions.

You can also export projects, folders, and albums, as well as a combination of all
three. Aperture consolidates the masters and versions of the items you selected in the
Library inspector and exports them as a library, maintaining their organizational
structure. Then you can merge the exported library into another Aperture system. For
more information about merging libraries, see “Merging Libraries.”
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An Overview of Exporting Images

Using Aperture, you can export copies of masters, as well as versions that you’ve
created. When you export image versions, you can export them in JPEG, TIFF, PNG, and
PSD file formats.

At export, you can rename files, resize and adjust images, and include metadata such
as EXIF information, IPTC information, and keywords. You can also apply ColorSync
profiles and watermarks to the versions you’re exporting. You can export separate
lists of metadata for selected images as a file. You can also export masters with IPTC
data stored in XMP sidecar files that can be used in other applications, such as Adobe
Photoshop.

Before exporting your images to another application, a printing service, a client, or a
website, you need to know what file types the recipient can use. You should also check
with the recipient about other important information, including file size limitations,
required image dimensions, and naming conventions. The key to a successful file
transfer is anticipating—and avoiding—anything that can prevent the recipient from
opening your files.

Aperture allows you to perform multiple export operations concurrently. However, it’s
extremely important that you avoid making changes to the images you are exporting
until the operation is complete to prevent unintended behavior.

The easiest way to export images is to use one of the Aperture export presets. Presets,
or groups of export settings, allow you to efficiently export your images. If the presets
included with Aperture don’t meet your needs, you can create your own. For example,
if you regularly send groups of photos to a stock photography house and a printer,
you can create an export preset for each destination. Give the presets a name you’ll
remember, and the next time you need to send images to either destination, simply
select the correct export preset.

You can also modify existing export presets and delete export presets you no longer
use.

Exporting Images to an External Editor

Aperture provides an easy way to transfer images to another application for
changes and then bring the revised images back into Aperture. You can specify an
application as an external editor in the Export pane of the Preferences window. For
example, if your image editing sometimes requires one or more of the specialized
tools available in Adobe Photoshop, you can select Photoshop as your external
editor. You can then select an image and choose Photos > Edit With > [application
name]. Aperture makes a new master and version of your image and opens it in
Adobe Photoshop. After you make your changes and save the image, the revised
version automatically reappears in Aperture. The external editor doesn’t change
the original master. For more information, see “Using an External Editor.”
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Exporting Copies of Masters

When you export masters, duplicates of the files that were imported from your camera
or other source are created; no adjustments, file modifications, or any other changes
are exported with the file.

To export copies of masters

Select an image or images in the Browser.

Choose File > Export > Masters (or press Command-Shift-S).

In the dialog that appears, navigate to the location where you want the exported files
placed.

Do one of the following:

e Choose None from the Subfolder Format pop-up menu to specify that the masters
be stored as separate files in the selected folder.

e Choose a folder name preset from the Subfolder Format pop-up menu to specify
that Aperture create a hierarchy of subfolders with specific folder names to hold
your files. For more information about creating folders to hold your exported
images, see “Exporting Images into Folders in the Finder.”

e Choose Custom Name or Custom Name with Counter from the Subfolder Format
pop-up menu, then enter a custom folder name in the Custom Subfolder Name
field.

Choose a name format for your masters from the Name Format pop-up menu.

For more information about selecting and setting up filenaming formats, see
“Renaming Images at Export.” Aperture shows an example of the selected name format
in the dialog.

By default, IPTC metadata is not exported with the masters. To export the masters
with IPTC metadata, do one of the following:

e To write IPTC metadata into the master: Choose Include IPTC from the Metadata
pop-up menu.

e To create an XMP sidecar file that contains the image’s IPTC metadata: Choose
Create IPTC4XMP Sidecar File from the Metadata pop-up menu.

If you want to include audio attachments with your exported master files, select the
Include Audio Attachments checkbox.

If you want to be notified when the export process is complete, select the “Show alert
when finished” checkbox.

When you’re ready to export your files, click Export Masters.

Copies of the masters for the selected images are exported to the location you
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specified. If you selected the “Show alert when finished” checkbox, a dialog appears

displaying the number of masters exported and the file path. If you want Aperture to
open the Finder to the location where you exported your masters, click the Reveal in
Finder button. Otherwise, click OK to close the dialog.
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Exporting Image Versions

You can export image versions that you’ve created in Aperture. For example, you
might make adjustments to images for a specific purpose and then export them for
use in another application. You can also rename images when exporting them, make
minor adjustments on export, add watermarks, and export images with metadata. You
can also quickly export images to your email application to send them to others.

When you export image versions, you can specify settings for the exported files, such
as format, size, and filename.

Note: You can set Aperture to always include location information and names assigned
to faces when exporting your photos. For more information about including Places and
Faces information with your photos, see “Export Preferences.”

To export versions of images

Select an image or images in the Browser.

Choose File > Export > Versions (or press Command-Shift-E).
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In the dialog that appears, navigate to the location where you want the exported
images placed.
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4. Choose an export preset from the Export Preset pop-up menu.
For more information on export presets, see “Working with Export Presets.”

5. Do one of the following:

e Choose None from the Subfolder Format pop-up menu to specify that the versions
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be stored as separate files in the selected folder.

e Choose a folder name preset from the Subfolder Format pop-up menu to specify
that Aperture create a hierarchy of subfolders with specific folder names to hold
your files. For more information about creating folders to hold your exported
images, see “Exporting Images into Folders in the Finder.”

e Choose Custom Name or Custom Name with Counter from the Subfolder Format
pop-up menu, then enter a custom folder name in the Custom Subfolder Name
field.

6. Choose a name format for your files from the Name Format pop-up menu.

If you choose a Custom Name format, enter a name in the Custom Name field. For
more information on renaming images at export, see “Renaming Images at Export.”

7. If you want to be notified when the export process is complete, select the “Show alert
when finished” checkbox.

8. When you’re ready to export files, click Export Versions.

The images you selected are exported to the location you specified. If you selected the
“Show alert when finished” checkbox, a dialog appears displaying the number of
versions exported and the file path. If you want Aperture to open the Finder to the
location where you exported your versions, click the Reveal in Finder button.
Otherwise, click OK to close the dialog.

Note: If you want to check on the progress of an export operation, choose Window >
Show Activity. The Activity window displays the progress of each export operation. You
can also use this window to pause and cancel an export operation.
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Exporting Audio and Video Versions
You can export edited versions of audio and video clips brought into Aperture. If you
trimmed the length of the audio or video clip, the new edited length is exported along
with any metadata you applied in Aperture.

@ To export versions of audio and video clips

1. Select audio or video clips in the Browser.

2. Choose File > Export > Version (or press Command-Shift-E).

3. In the dialog that appears, navigate to the location where you want the exported audio
or video files placed.

Choose a location for
the exported files,

i} | [l Dexktop R

= DEVICES
= NIARFD

T PLACES

oMy Bt
! Do e ey
Espout Presd | [F
Tehimider Farmuar | hors B
Curnom Sublo'der Mame:
arre Famar | Curest erson hare Ft———————— Choose a name format
Cisstom Mame et | for the exported files.

Fie Marre Example: ORC 047 MOV
[ Shaw skt whan Eriibed

(oew Folder ) Concel ) (emart Versions)

e

4. Do one of the following:

e Choose None from the Subfolder Format pop-up menu to specify that the clips be
stored as separate files in the selected folder.

e Choose a folder name preset from the Subfolder Format pop-up menu to specify
that Aperture create a hierarchy of subfolders with specific folder names to hold
your files. For more information about creating folders to hold your exported audio
and video files, see “Exporting Images into Folders in the Finder.”

e Choose Custom Name or Custom Name with Counter from the Subfolder Format
pop-up menu, then enter a custom folder name in the Custom Subfolder Name
field.

5. Choose a name format for your files from the Name Format pop-up menu.
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If you choose a Custom Name format, enter your custom name in the Custom Name
field. For more information on renaming audio and video files at export, see
“Renaming Images at Export.”

6. If you want to be notified when the export process is complete, select the “Show alert
when finished” checkbox.

7. When you’re ready to export files, click Export Versions.

The audio or video clips you selected are exported to the location you specified. If you
selected the “Show alert when finished” checkbox, a dialog appears displaying the
number of versions exported and the file path. If you want Aperture to open the Finder
to the location where you exported your clips, click the Reveal in Finder button.
Otherwise, click OK to close the dialog.

Note: If you want to check on the progress of an export operation, choose Window >
Show Activity. The Activity window displays the progress of each export operation. You
can also use this window to pause and cancel an export operation.
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Exporting Projects, Folders, and Albums

You can select and export any combination of projects, folders, and albums in the
Library inspector. Aperture consolidates the selected items into an Aperture library
and places it in the location of your choosing. After exporting the item selection as an
Aperture library, you can either open the new library and work within it, or you can
merge the library into the library of another Aperture system.

For more information about opening Aperture libraries, see “Viewing Other Libraries.”

For more information about merging Aperture libraries, see “Merging Libraries.”

@ To export projects, folders, and albums

1. In the Library inspector, select the items you want to export, then choose File > Export
> Items as New Library.

Aperture consolidates the selected items into a library.
2. Enter a name and choose a location for the exported library.
3. Do any of the following:

e [f your project contains referenced images and you want the master files available to
the new Aperture system: Select the “Consolidate masters into exported library”
checkbox to copy the original master image files into the new library file.

e [f you want to copy the previews into the new library so that you don’t have to
rebuild them on the new Aperture system: Select the “Include Previews in exported
library” checkbox.

e [f you want Aperture to alert you when it has finished building the new
library: Select the “Show alert when finished” checkbox.

4. Click Export.

Aperture consolidates the selected items into a library and exports the library file to
the location you chose.
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Working with Export Presets

Export presets are groups of saved export settings that help you quickly and easily
export your images. Aperture comes with numerous export presets, and you can also
create your own.
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Controls in the Export Presets Dialog

Before using an export preset, whether it’s one that comes with Aperture or one that
you created, you can view its settings to make sure they are exactly what you want.

@ To view the settings for an export preset
Do one of the following:
® Choose Aperture > Presets > Image Export.

®  With an image selected, choose File > Export > Version (or press Command-Shift-E)
and in the dialog that appears, choose Edit from the Export Preset pop-up menu.

The Image Export dialog appears, listing the presets available and the configurable
export settings.

Available presets are
shown here.

— The right side of the
dialog shows the settings
for the selected preset,

The Image Export dialog includes these controls:

e /mage Format pop-up menu.: Choose an image format for the exported files, such
as JPEG or TIFF.

e [nclude Metadata checkbox: Select this checkbox to include EXIF and IPTC metadata
in the exported files.

e /mage Quality slider: Choose how much to compress your files by dragging the
slider. Setting the slider to 12 applies the least compression and results in a higher-
guality image; setting the slider to O (zero) applies the most compression and
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results in a lower-quality image.

e Size To pop-up menu: Export your images at their original size, or specify image
dimensions or a percentage of the image’s original size.

e DPI: Specify dots per inch (dpi), the resolution at which the images will be
reproduced.

e Gamma Adjust slider: Gamma describes how your image distributes brightness.
Drag the slider to apply a uniform gamma adjustment to your exported images.

e Color Profile pop-up menu: Choosing a color profile ensures consistent color
reproduction on other systems and in the printed image. Aperture provides a large
selection of profiles, and any custom profiles you’ve saved during calibration are
also included in the pop-up menu. To apply a ColorSync profile to the images
you’ve selected for export, choose a profile from the pop-up menu.

e Black Point Compensation checkbox: Select this checkbox to scale the black and
white luminance values to the selected ColorSync profile. Activating black point
compensation can prevent shadows from appearing as solid black.

e Show Watermark checkbox: To add a watermark to your images, select this
checkbox. After selecting the checkbox, you can choose a file to apply as a
watermark image and place your watermark with a specified opacity on your image.

For more information about adding watermarks, see “Adding a Watermark at
Export.”
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Creating an Export Preset
If none of the predefined export presets suits your needs, you can create your own
export preset. An easy way to create a hew export preset is to copy an existing preset
and then modify the copy.

© To create a new export preset

1. Choose Aperture > Presets > Image Export.

The Image Export dialog appears.

Select a preset on which
o base your new preset.

Click the Add button to
add a new preset,

2. Select an export preset on which to base your new preset, then click the Add (+)
button.

A new preset appears highlighted in the Preset Name list.
3. Enter a name for the new preset, then press Return.

4. Change the export settings as required, then click OK.
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Modifying an Export Preset

You can modify existing presets when you need to. The next time you export using that preset,
Aperture remembers your modified settings and exports your images accordingly.

& To modify an existing preset

1. Choose Aperture > Presets > Image Export.
The Image Export dialog appears.

2. Select the preset you want to modify and change its settings as required, then click OK.

Copyright © 2009 Apple Inc. All rights reserved.
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Deleting an Export Preset
You can delete an export preset when you no longer need it.

& To delete an export preset in the Image Export dialog

1. Select the preset, then click the Delete (-) button.

Click the Delete buttan
to delete the salected

preset.

2. In the dialog that appears, click Delete.

The preset disappears from the Preset Name list.
3. Click OK.

The preset is permanently deleted.

Note: If you click the Delete button and then click Cancel, the preset reappears the next time you
open the Image Export dialog.

Copyright © 2009 Apple Inc. All rights reserved.
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Setting Image Resolution When Exporting

You can set the image resolution you want for exported images in the Image Export dialog in several
ways: by specifying a dpi setting, by specifying a percentage of the original, or by specifying image
dimensions in inches, centimeters, or pixels. First you select an export preset, and then you specify a
resolution for that preset.

& To specify the dpi setting for exported images in an export preset

1. Do one of the following:
e Choose Aperture > Presets > Image Export.

e Choose File > Export > Versions (or press Command-Shift-E), then choose Edit from the Export
Preset pop-up menu.

The Image Export dialog appears.

Enter a OP| setting for
exported images here.

2. Select an export preset or create a new one, then enter a dpi setting.
For more information on creating export presets, see “Creating an Export Preset.”
3. Specify additional settings as necessary, then click OK.

Use this export preset when you need to export versions at the resolution specified in the DPI field.
Create a new preset when a new dpi setting is required.

& To create an export preset constraining images to a specific size at export

1. Do one of the following:
e Choose Aperture > Presets > Image Export.

e Choose File > Export > Versions (or press Command-Shift-E), then choose Edit from the Export
Preset pop-up menu.

The Image Export dialog appears.
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Choose a Size To
option and enter
the corresponding
values here,

2. Select an export preset or create a new one.
For more information on creating export presets, see “Creating an Export Preset.”

3. Choose an item from the Size To pop-up menu, then specify the size of the image by entering values
in the fields that appear below it.

4. Specify additional settings as necessary, then click OK.

Use this export preset when you need to export images at a specific size. Create a new preset when
new dimensions are required.
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Adjusting Images at Export

You can apply final adjustments to images at export by choosing ColorSync profiles, setting gamma
adjustments, and applying black point compensation. Because these adjustments are applied at
export, the image versions and masters in the Aperture library are not changed. Only exported files
receive image adjustments applied with an export preset.

To adjust images at export, you create a new export preset in the Image Export dialog and then
modify the Image Quality, Gamma Adjust, ColorSync Profile, and Black Point Compensation settings
as appropriate.

= Lse these options to
adjust images when
they are exported.

Gamma adjustments applied at export are applied on top of gamma adjustments previously applied
to image versions. Before exporting, verify that you are not doubling any gamma adjustments
previously applied to your images.

When you export, select the preset that includes the adjustments you want to make. For information
about creating export presets, see “Working with Export Presets.”

& To create an image export preset to adjust images at export

1. Do one of the following:
e Choose Aperture > Presets > Image Export.

e Choose File > Export > Versions (or press Command-Shift-E), then choose Edit from the Export
Presets pop-up menu.

The Image Export dialog appears.
2. Select an export preset, or create a new one.

For information about creating export presets, see “Creating an Export Preset.”
3. Specify adjustment options:

e To add a gamma adjustment to the exported images: Drag the Gamma Adjust slider to the right.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=20%26section=12 Page 1 of 2

Petitioner Apple Inc. - Ex. 1005, p. 811



Aperture 3 User Manual: Adjusting Images at Export 10/1/21 11:36 AM

e To change the ColorSync profile applied to the exported images: Choose a profile from the Color
Profile pop-up menu.

e To apply black point compensation to the exported images: Select the Black Point Compensation
checkbox.

4. Specify additional settings as necessary, then click OK.

Use this export preset when you want to export images with the adjustments you specified.
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Adding a Watermark at Export

A watermark is a visible graphic overlay that is applied to an image. Photographers often use
watermarks to indicate that images are protected by a copyright and to discourage others from
inappropriately using their images.

You can import a graphics file and add it to your images as a watermark.

To add a watermark image to your exported images

Select the images you want to export.

Choose File > Export > Versions (or press Command-Shift-E).

In the dialog that appears, choose Edit from the Export Preset pop-up menu.

In the Image Export dialog, select the export preset you want to use to export your images.
Select the Show Watermark checkbox.

Click the Choose Image button.

Select the image you want to use as a watermark, then click Choose.

Specify where you want the watermark to appear on the image using the Position pop-up menu.
To adjust the opacity of the watermark, drag the Opacity slider to a new position.

If you want the watermark to be scaled in proportion to the image’s output size, select the “Scale
watermark” checkbox.

When you’re satisfied with how your watermark appears in the watermark preview area, click OK.
Navigate to the location where you want the exported images placed.

Choose a name format for your exported files from the Name Format pop-up menu.

Click Export Versions.

Your files are exported with the watermark you created.

Tips for Creating High-Quality Watermarks
Use the following guidelines to create high-quality watermarks for your images:

e Save your watermark as a PSD (Photoshop) file with a transparent background.

e Create multiple sizes of your watermark so that you can select the one that is the best match
for the output size of the exported image.

Note: If a watermark file is larger than the image you want to export, Aperture automatically
scales the watermark down to fit the image. (Aperture does not scale watermarks up.)

e After you create a watermark, save it as part of an export preset so you can reuse it as often
as you need.
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Applying IPTC Metadata and Keywords to Your Images

Many publications use a standard set of image keywords; the American Newspaper Publishers
Association (ANPA) wire codes, developed by the Newspaper Association of America, are one
example. You can apply these keywords to your images when exporting to JPEG, TIFF, and PSD file
formats.

Remember that applying metadata at export applies all the metadata attached to your image. If your
image version has metadata that you don’t want exported, create a new image version that only
includes the metadata you intend to export.

Note: The PNG file format does not support the inclusion of metadata.

& To create an image export preset that includes metadata with exported images

1. Do one of the following:
e Choose Aperture > Presets > Image Export.

e Choose File > Export > Versions (or press Command-Shift-E), then choose Edit from the Export
Presets pop-up menu.

The Image Export dialog appears.

2. In the Image Export dialog, select the export preset you want to use to export your images, or create
a new one.

For more information about creating export presets, see “Creating an Export Preset.”
3. Select the Include Metadata checkbox.

Note: This checkbox is dimmed when PNG is chosen in the Image Format pop-up menu.
4. Click OK.

The version metadata is included in your exported images when this export preset is chosen.

Copyright © 2009 Apple Inc. All rights reserved.
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Exporting Images into Folders in the Finder

10/1/21 11:40 AM

When you export versions and masters, you can have Aperture place the files individually into a
selected folder or create subfolders to hold the files. For example, you might have the exported files
placed in subfolders identified by date. You can create folder name formats that you can quickly

choose to select the folder structure you want.

To create a folder name preset, you select the name elements you want in the Folder Naming dialog.
You can compose subfolder name formats that combine the following name elements:

Version Name

Master Filename

Sequence Number (1 of 3, 2 of 3, 3 of 3, and so on)

Image Year

Image Month

Image Day

Image Date

Image Time

Index Number (1, 2, 3, and so on)
Custom Name

Counter (001, 002, 003, and so on)
Folder Name

Current Date

Current Time

Current Year

Current Month

Current Day

Project Name

/ (slash)

You can specify a combination of name elements to create custom folder names.

You can also create a hierarchy of folders within folders. For example, you can specify that Aperture
place your images in a subfolder named Date, and within that folder you can create subfolders
identified by the time the image was taken. To create the folder name format, you drag the elements
you want into the Format field and drag the slash element between the elements where a subfolder
should be created.

& To create a folder name preset

1. Do one of the following:

e Choose Aperture > Presets > Folder Naming.

e In the Export dialog, choose Edit from the Subfolder Format pop-up menu.
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The Folder Naming dialog appears.

2. Click the Add (+) button to create a new folder name format, or select the preset folder name format
you want to change.

3. Drag the name elements you want into the Format field in the order you want them.
4. Drag a slash between the elements where you want subfolders created.
5. Enter a custom name in the Custom Name field, if you wish.

Note: The Custom Name field is dimmed unless “Custom Name” is one of the elements in the Format
field.

6. Click OK.

Your new folder name format now appears in the Subfolder Format pop-up menu.

When using a counter in your folder name format, you can specify the starting number and the
number of digits, from 1 to 6, that appear in the counter. When you use a folder name format with a
counter, make sure to reset the initial starting number, if necessary. Otherwise, on the next export
Aperture will continue numbering the folders containing the exported images starting from the last
number of the previous export.

& To reset the starting number of a counter in a folder name preset

® In the Folder Naming dialog, type O (zero) in the “Incrementing counter starting at” field.

Copyright © 2009 Apple Inc. All rights reserved.
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Renaming Images at Export

When you export a large group of images, the exported files often have nonsequential names. You
can rename your images at export, giving them more meaningful names.

For example, suppose you want to export images LA 031, LA 441, LA 686, and LA 894 from image
group LA 001 to LA 1061. You can use the Custom Name with Index name format to rename your
images LA 1, LA 2, and so on.

& To rename images at export

1. Select the image or images you want to export.

2. Do one of the following:

e To export masters and rename them: Choose File > Export > Masters (or press Command-Shift-
S).

e To export versions and rename them: Choose File > Export > Versions (or press Command-Shift-
E).

3. In the Export dialog, navigate to the location where you want the exported images placed.

4. Choose a name format from the Name Format pop-up menu.
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If you choose a Custom Name format, enter your custom name in the Custom Name field.
5. When you’re ready to export files, click either Export Masters or Export Versions.

The files are exported with the name format you specified.

If none of the preset name formats meets your needs, you can create a new name format.

For example, you could create a name format that uses a custom name, the index number, and the
date.

& To create a new name format

1. Do one of the following:
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e Choose Aperture > Presets > File Naming.

e Choose File > Export > Versions (or press Command-Shift-E), then choose Edit from the Name
Format pop-up menu.

The File Naming dialog appears.
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2. In the Preset Name list, select an existing name format on which to base the new name format, then
click the Add (+) button.

Select an existing name
format in this list,

Click the Add button,

A copy of the selected name format is created.
3. Enter a name for the new preset, then press Return.
4. Add name elements by dragging the elements from the Include area to the Format field.

If necessary, enter relevant naming information in the fields provided. Remove name elements from
the Format field by selecting them and pressing Delete. You can also type characters directly in the
Format field.
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The name format
example automatically
updates as you change
the name elements.

Mame elements appear
here. Remove a name
elermnent by selecting

it and pressing Delete,

Add mame elements
by dragging them to
the Format field.

As you add or delete name elements, the Example field automatically updates.
5. When you’re satisfied with the new name format, click OK.

The new name format appears in the Name Format pop-up menu.

When exporting images for specific uses, such as for use on websites, you may need to use
filenames without spaces so that the filenames are compatible with the intended application or
website. Aperture adds spaces to filenames depending on the name format you use. You can easily
modify name formats to remove spaces from filenames.

& To modify a name format to remove spaces

1. Choose Aperture > Presets > File Naming.

2. In the File Naming dialog, select the preset name format you want to modify.
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Select the name format
wou want to maodify.

Select the space
_
between name alements

and delete it.

3. In the Format field, select and delete the spaces or characters between the name elements.

If you wish, you can also add spaces or characters between name elements.

4. Click OK.
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Exporting Metadata Listed in a Separate File

You can select images and export the metadata assigned to them in a tab-delimited text file. The
text file lists the version names, ratings, keywords, and other metadata assigned to the images.

To export image metadata in a text file

9
1. Select the images whose metadata you want to export.
2. Choose File > Export > Metadata.

3

. Enter a name for the text file in the Save As field, select the location where you want the file stored,
then click Export Metadata.

Aperture exports the metadata information as a standard Unicode text file that you can open and use
with any application that uses text files.
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Exporting Using Plug-ins

Some applications, social networking sites, and photography services supply plug-ins that allow
Aperture to export files automatically with the format and settings the application or service
requires. For example, a stock photography service or print lab may require that images be
transferred at a specific size, in a specific file format, or with particular types of metadata. Such a
service can create its own plug-in that automatically sets up Aperture to export files with precisely
the characteristics the service needs.

To use an export plug-in, you must first obtain the plug-in software from the service or application
vendor and install it. You can find a list of available plug-ins by connecting to the Internet and
choosing Aperture > Aperture Plug-ins. Third-party plug-ins for Aperture are stored in the following
location: /Library/Application Support/Aperture/Plug-ins/Export/.

& To export images using a third-party plug-in
1. Select the images you want to transfer.

2. Choose File > Export, then select the plug-in that you want to use.
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file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=20%26section=18 Page 1 of 1

Petitioner Apple Inc. - Ex. 1005, p. 822



Aperture 3 User Manual: Exporting Images to Use in Email

o v A w N = O

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=20%26section=19

Exporting Images to Use in Email

While it’s not the best method for delivering uncompressed or large image files, email provides a
quick and easy way to deliver images. Aperture contains three export presets (Email Small, Email
Medium, and Email Original Size) that create compressed JPEG files that are easy to send via email. If
these export presets don’t meet your needs, you can create your own custom email export preset.

You can also have Aperture transfer an image directly to your email application. To specify that
Aperture use a specific email application to send your images, choose the email application you want
to use in the Export pane of the Preferences window. You can also specify the email export preset
used to prepare the images.

To specify an email application and email export preset for Aperture to use

Choose Aperture > Preferences, or press Command-Comma (,), then click Export.

In the Export pane of the Preferences window, choose the email application you want to use from the
“Email using” pop-up menu.

To specify an export preset for Aperture to use when preparing images for email transfer, choose a
preset from the “Email Photo Export preset” pop-up menu.

If none of the presets meets your needs, choose Edit from the “Email Photo Export preset” pop-up
menu and create a new export preset.

For more information about creating export presets, see “Creating an Export Preset.”

To send an image directly to your email application

. Select the image you want to send.

. Do one of the following:

e Choose File > Share > Email (or press Option-E).
e Click the Email button in the toolbar.
The image is exported directly to your email application.

Note: Before you attempt to email an image, find out the maximum file size your email client
supports. If your exported images exceed this maximum file size, consider using FTP software or
another file-sharing technique to deliver your images.

To export an image or images to attach to an email message later

. Select the image or images you want to export.

. Choose File > Export > Versions (or press Command-Shift-E).

Navigate to the location where you want the exported images placed.

. Choose an image file format from the Export Preset pop-up menu.
. Choose a name format for your files from the Name Format pop-up menu.

. When you’re ready to export files, click Export Versions.

You can now open your email application and attach the exported files.
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Exporting by Dragging

You can export image, audio, and video versions by dragging them from the Browser or Library
inspector to the desktop or any location in the Finder. You can also do the same with projects,
albums, and folders in the Library inspector. However, MobileMe, Flickr, and Facebook albums cannot
be exported by dragging.

Note: An image version without a JPEG preview cannot be exported via the drag-and-drop method. If
the version doesn’t have a preview, dragging and dropping is disabled for that version (except within
Aperture). If you are dragging multiple images, but only some of them have previews, only the
versions with previews are dragged out. The quality of the JPEG image is determined by the Previews
settings in Aperture preferences. For more information, see “Working with Preview Images.”

& To export versions from Aperture by dragging

1. In the Browser, select the image, audio, and video versions you want to export.

2. Drag the versions to the desktop or any location in the Finder.

& To export items in the Library inspector by dragging
1

. In the Library inspector, select the items you want to export by Shift-clicking adjacent items and
Command-clicking nonadjacent items.

2. Drag the items to the desktop or any location in the Finder.

The exported items are consolidated into a single Aperture library. The library is named after the
item that appears at the highest point (from top to bottom) in the Library inspector. If an album is
selected for export, the album and the project to which it is subordinate are exported, but only the
versions within the album are exported. Any other images in the project are left out of the export.

If you want to rename the exported library, double-click the library file’s name and enter a new
name.
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Creating Slideshow Presentations

With Aperture, you can easily create and present slideshows of your images. You can quickly create a
slideshow from a selection of images, or you can create an advanced multimedia presentation
complete with video clips, a layered soundtrack, and customized titles, borders, transitions, and
effects. You can also export your slideshows as movies to share them with others on the web or play
them on iPhone, iPod touch, or Apple TV.

Copyright © 2009 Apple Inc. All rights reserved.
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An Overview of Slideshows

Aperture makes it easy to create slideshow presentations of your images. You can use two main
methods of creating slideshows in Aperture.

To create an impromptu slideshow based on an image selection and play it on your computer, you
use slideshow presets. Slideshow presets are collections of predefined slideshow settings that
determine the overall look of your slideshow and how your images appear on the screen. Aperture
provides a number of slideshow presets, and you can also create your own custom presets.
Slideshow presets are convenient when you’re sitting with a client or friend and you want to give a
basic presentation of your images, but you don’t need to save the slideshow.

When you want to create a more elaborate multimedia presentation or when you want to export your
slideshow as a movie for others to view, you create a slideshow album and use the Slideshow Editor
to edit the slideshow. Aperture provides themes that you can apply to your slideshow to give it a
professional look, and you can also include video clips, create a layered soundtrack, and customize
elements such as titles, borders, transitions, and effects. You can play the slideshow on your
computer, or you can export the slideshow as a movie to share with others via email or the web. You
can also send your slideshow directly to iTunes for syncing with iPod, iPhone, or Apple TV.

To play a slideshow using a slideshow preset, you select an item in the Library inspector or a group
of images in the Browser and then choose File > Play Slideshow.

To create a more advanced slideshow or to create a slideshow that you can export and share via the
web, you create a slideshow album, edit your slideshow using the controls in the Slideshow Editor,
and then export the slideshow in the appropriate format.
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Playing Slideshows Using Slideshow Presets

To play a slideshow using a slideshow preset, you select an item in the Library inspector or individual
images in the Browser and then choose File > Play Slideshow (or press Shift-S).

When the Play Slideshow dialog appears, you can specify how you want images displayed by choosing
a slideshow preset.

Play Sideshow

Soihes oo Duseie 5|

(men ) (oY

Slideshow presets are groups of predefined settings for playing a slideshow. For example, you can
choose a slideshow preset to change the theme or apply transitions and timing to your onscreen
presentation.

Aperture provides several slideshow presets from which to choose:
e Dissolve: Displays each image for 3 seconds, with a 2-second cross fade over a black background.

e fade through Black: Displays each image on a black background for 3 seconds, with a 2-second
cross fade that fades to black between each image.

e Manual: You control this slideshow’s progression with the Right Arrow and Left Arrow keys.
e Slow Dissolve: Displays each image for 5.1 seconds, with a 5-second cross fade.

e Ken Burns: Displays each image for 3 seconds, with a 2-second cross fade over a black
background. A Ken Burns effect, with simultaneous zooming and panning, is applied to each
image as it is displayed.

e Photo Edges: Displays the images using the Photo Edges theme—the images appear over a light
gray background with borders similar to those of traditional photographs.

e Scrapbook: Displays the images using the Scrapbook theme—the images appear to be placed on
the pages of a traditional scrapbook.

e Shatter: Displays the images using the Shatter theme—the visual elements of an image break
apart and are reassembled into the next image.

e Sliding Panels: Displays the images using the Sliding Panels theme—the images appear over a
black background in multiple panels, and each image is individually replaced in a sliding motion
by another image.

e Snapshots: Displays the images using the Snapshots theme—the images appear with white
borders on top of each other, creating an image stack over a black background.

e Watercolor Panels: Displays the images using the Watercolor Panels theme—the images appear
over an animated colored background.

You can also create your own custom presets. For example, to prepare for a presentation, you could
create two new slideshow presets: one for your presentation and the other for your question-and-
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answer period. The presentation slideshow can be manually controlled, allowing you to move
through the images at your own pace. Your second slideshow preset, to be used during the
guestion-and-answer period of your presentation, can display the same images using the Sliding
Panels theme set to show each image for 15 seconds, with music and looping applied.

To create or modify a slideshow preset, you choose Aperture > Presets > Slideshow (or choose Edit
from the Slideshow Preset pop-up menu in the Play Slideshow dialog), and the Slideshow dialog
appears.

The Slideshow dialog lets
you create ar maodify
slideshaw presets.

You can then select a slideshow preset or create a new one, specifying the settings you want.

Copyright © 2009 Apple Inc. All rights reserved.
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Playing a Slideshow Using a Preset

You can easily set up a slideshow by selecting the images you want and then choosing a slideshow
preset.

& To create and play a slideshow

1. Select a set of images by doing one of the following:

Select an item in the Library inspector.

Select individual images or image stacks in the Browser.

2. Choose File > Play Slideshow (or press Shift-S).

The Play Slideshow dialog appears.

(omen ) (S Y

3. Choose a preset from the Slideshow Preset pop-up menu:

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=21%26section=3

Dissolve: Displays each image for 3 seconds, with a 2-second cross fade over a black background.

Fade through Black: Displays each image on a black background for 3 seconds, with a 2-second
cross fade that fades to black between each image.

Manual: You control this slideshow’s progression with the Right Arrow and Left Arrow keys.
Slow Dissolve: Displays each image for 5.1 seconds, with a 5-second cross fade.

Ken Burns: Displays each image for 3 seconds, with a 2-second cross fade over a black
background. A Ken Burns effect, with simultaneous zooming and panning, is applied to each
image as it is displayed.

Photo Edges: Displays the images using the Photo Edges theme—the images appear over a light
gray background with borders similar to those of traditional photographs.

Scrapbook: Displays the images using the Scrapbook theme—the images appear to be placed on
the pages of a traditional scrapbook.

Shatter: Displays the images using the Shatter theme—the visual elements of an image break
apart and are reassembled into the next image.

Sliding Panels: Displays the images using the Sliding Panels theme—the images appear over a
black background in multiple panels, and each image is individually replaced in a sliding motion
by another image.

Snapshots: Displays the images using the Snapshots theme—the images appear with white
borders on top of each other, creating an image stack over a black background.

Watercolor Panels: Displays the images using the Watercolor Panels theme—the images appear
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over an animated colored background.

When you choose a preset from the Slideshow Preset pop-up menu, a preview of the slideshow
preset plays below the pop-up menu.

4. Click Start.

If either no image or a single image is selected, the slideshow displays all images in the current
album or project.

Important: You can save slideshows and share them by creating a slideshow album and then placing
the image versions for your slideshow in it. For more information, see “About Creating Slideshows
with the Slideshow Editor.”

About Displaying Sharp Images in Slideshows

To display slideshows at the best quality, you should set Aperture to create high-resolution
previews. In addition to setting previews to their highest resolution, you should also use full-
size previews to prevent upscaling with large displays. If previews are not available, images in
the slideshow may not be as sharp as they would be otherwise. For more information about
creating high-resolution previews, see “Working with Preview Images.”

Copyright © 2009 Apple Inc. All rights reserved.
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Controlling a Slideshow
Once you start playing a slideshow, you can use keyboard shortcuts to control the slideshow.

& To pause the slideshow

®  Press the Space bar.

& To continue playing the slideshow

®  Press the Space bar again.

& To move forward through the slideshow

®  Press the Right Arrow key.

& To move backward through the slideshow

®  Press the Left Arrow key.

& To stop the slideshow
®m  Press Esc (Escape).

The slideshow stops playing, and the Aperture workspace reappears.

Copyright © 2009 Apple Inc. All rights reserved.
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Arranging the Order of a Slideshow’s Images
You can arrange the order in which the images in a slideshow are presented.

& To arrange the order of a slideshow’s images

= Before creating the slideshow, arrange the thumbnail images in the Browser in the order in which you
want them to appear in the slideshow.

You can then play the slideshow by following the instructions in “Playing a Slideshow Using a Preset.”

Copyright © 2009 Apple Inc. All rights reserved.
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Controls in the Slideshow Dialog
The Slideshow dialog contains options for creating and modifying slideshow presets. In it, you can
choose how many images to display at a time, how those images are arranged, and how long each
image is displayed in your slideshow. You can also choose to play slideshows on one or two displays,
with custom background colors and music.

& To open the Slideshow dialog

Do one of the following:
® Choose Aperture > Presets > Slideshow.

®  Choose File > Play Slideshow (or press Shift-S), then choose Edit from the Slideshow Preset pop-up
menu in the Play Slideshow dialog.

The Slideshow dialog appears.

e Preset Name list: Displays the list of current slideshow presets.

e Theme pop-up menu: Choose a theme for your slideshow preset from this pop-up menu.

e “Show title slide” checkbox: Select this checkbox to display a title slide at the beginning of the
slideshow. Aperture automatically generates the title using the name of the item selected in the
Library inspector.

e Timing pop-up menu: Choose how the slideshow duration is determined. There are three options:
fitting the slideshow to the duration of the music, showing each image for a fixed time, or
advancing images manually.

e Slide Duration value slider: Use this value slider to determine the minimum amount of time each
image is shown.

e Background color well: Change the background color of your slideshow by clicking the
Background color well and then selecting a new background color from the Colors window, or
click the disclosure button (to the right of the color well) and select a new background color from
the pop-up color palette.

e Inset value slider: Use this value slider to adjust the space between the edges of the screen and
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the images.
e Transition pop-up menu: Choose the type of transition that occurs between the slides.

e Transition Duration value slider: Use this value slider to adjust the length of applied transitions.
The duration setting is applied uniformly to each transition.

e “Shuffle slide order” checkbox: Select this checkbox to have Aperture shuffle the order of the
images presented in the slideshow.

e “Repeat slideshow” checkbox: Select this checkbox to loop, or continuously play, your slideshow.
If you select this option, you must stop your slideshow manually by pressing Esc.

e “Play music during slideshow” checkbox: Select this checkbox to play your slideshow with an
accompanying song or iTunes playlist.

e Audio browser area: Displays sample music and slideshow theme music selections, as well as
music from GarageBand, your iTunes library, and any audio imported into the Aperture library.
Navigate to a song to accompany your slideshow, or search for a song name, artist, or song time
by entering information in the search field. You can also preview DRM-free music by clicking the
Play button.

e OK button: Click this button to apply any changes made to the selected slideshow preset.
e Cancel button: Click this button to cancel the changes made to the selected slideshow preset.

e Reset Preset button: Click this button to reset the selected slideshow preset to its original
settings.

e Remove (-) button: Click the Remove button to remove an unwanted slideshow preset from the
Preset Name list.

e Add (+) button: Click the Add button to create a new slideshow preset based on the preset
selected in the Preset Name list.

Copyright © 2009 Apple Inc. All rights reserved.
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Creating Slideshow Presets

You create a new slideshow preset by duplicating an existing preset and then modifying it. First,
identify which existing preset you want to model your new preset on. After duplicating the preset
and renaming the duplicate, you can easily customize your new slideshow preset’s settings.

& To create a new slideshow preset

1. Choose Aperture > Presets > Slideshow.

The Slideshow dialog appears.
2. Select a preset in the Preset Name list on which to model your new preset.
3. In the bottom-left corner of the dialog, click the Add (+) button.

Ay
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Click this button 1o add
a new preset,

A copy of the slideshow preset appears highlighted in the Preset Name list.
4, Enter a new name for the copied slideshow preset, then press Return.

5. When you’ve finished specifying the slideshow settings you want, click OK.
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Modifying Slideshow Presets
You can modify slideshow presets to create custom slideshow presentations.

& To modify an existing preset

1. Choose Aperture > Presets > Slideshow.

The Slideshow dialog appears.

2. Select the preset you want to modify in the Preset Name list.
3. Modify the slideshow preset’s settings as appropriate.

4. When you’ve finished modifying settings for the slideshow preset, click OK.

& To revert back to the preset’s original settings

1. In the Slideshow dialog, select the preset whose settings you want to revert.

2. Click the Reset Preset button.

Copyright © 2009 Apple Inc. All rights reserved.
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Using Slideshow Presets to Play Slideshows with Music

Adding music to your slideshow can increase your audience’s enthusiasm and participation. You can
easily add DRM-free music from your iTunes music library to accompany your slideshow.

& To add music to your slideshow presentation

1. Select a set of images to be displayed in your slideshow.
2. Choose File > Play Slideshow (or press Shift-S).
The Play Slideshow dialog appears.
3. Choose Edit from the Slideshow Preset pop-up menu.
The Slideshow dialog appears.
4. Do one of the following:
e Select a slideshow preset to modify.

For more information about modifying existing slideshow presets, see “Modifying Slideshow
Presets.”

e Create a new slideshow preset.
For more information about creating new slideshow presets, see “Creating Slideshow Presets.”

5. In the Slideshow dialog, select the “Play music during slideshow” checkbox.

Select this checkbox

if you want to play music
or an audie clip during
your slideshow.

- Select a sang
or an audio dip.

Click the Play buttan
to preview your chaice,

6. Navigate to a song or an audio track in the audio browser.
You can search for a specific song, artist, or song time by entering information in the search field.
7. If you want to preview your song choice, click the Play button.

8. If you are satisfied with your music selection, click OK.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=21%26section=9 Page 1 of 2

Petitioner Apple Inc. - Ex. 1005, p. 838



Aperture 3 User Manual: Using Slideshow Presets to Play Slideshows with Music 10/1/21 11:42 AM

The Play Slideshow dialog appears.

9. Click Start to begin playing the slideshow presentation.
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About Creating Slideshows with the Slideshow Editor

When you want to create a slideshow, you create a slideshow album and use the controls in the
Slideshow Editor. You also create slideshow albums when you want to export a slideshow as a movie
to share with clients or friends. When you create a slideshow album, the Slideshow Editor appears.
For more information about the controls in the Slideshow Editor, see “Slideshow Editor.”

For more information about creating slideshow presentations using the Slideshow Editor, see the
following sections:

e “Workflow for Creating a Multimedia Slideshow Presentation”
e “Creating Slideshow Albums”

e “Changing a Slideshow’s Theme”

e “About Editing Slideshow Transitions and Applying Effects”

e “Modifying Settings Applied to the Entire Slideshow”

e “Modifying Individual Slides and Transitions”

e “Adding Music and Audio to Slideshows”

e “Viewing Your Slideshows in Aperture”

e “Sharing Your Slideshow Movies”

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.lproj/aperture_help/en/aperture/usermanual/index.html#chapter=21%26section=10 Page 1 of 1

Petitioner Apple Inc. - Ex. 1005, p. 840



Aperture 3 User Manual: Workflow for Creating a Multimedia Slideshow Presentation 10/1/21 11:42 AM

Workflow for Creating a Multimedia Slideshow Presentation

Creating, editing, and sharing slideshows containing your images is a fairly simple process. Here are
some of the typical steps in the slideshow creation and sharing process.

Stage 1: Selecting Images, Audio Clips, and Video Clips

Gather your initial selection of images and video clips in the Browser. Locate any audio clips you plan
to use in your slideshow presentation.

Stage 2: Creating a Slideshow Album

Create a slideshow album in the Library inspector from the selection of images and video clips in the
Browser and choose a theme for the slideshow. Drag additional images and video clips into the
slideshow album as necessary.

Note: The Classic and Ken Burns slideshow themes are the most customizable. Use the dialog that
appears when you create a new slideshow album to preview the slideshow themes that come with
Aperture. If you want to significantly modify a slideshow theme, choose Classic or Ken Burns.

Stage 3: Arranging the Slideshow Presentation

Arrange the images and video clips in the Browser, below the Slideshow Editor, from left to right to
tell the story you want. Each image and video clip functions as an individual slide.

Stage 4: Previewing the Slideshow in the Slideshow Editor

Preview the slideshow in the Slideshow Editor to verify that images and video clips play in the correct
sequence.

Stage 5: Selecting Music

Choose the music or audio clip that will play during the slideshow. You can apply a looped song to
the main audio track and then add voiceover audio clips and other audio clips to the secondary audio
track.

Stage 6: Adjusting Transitions

Adjust transitions to emphasize the most important images in the slideshow or give a particular
treatment to images with similar subject matter. Make sure that the sequence of images and the
duration of the transitions match the cadence and tempo of the music or audio clip you selected for
the slideshow.

Stage 7: Titling and Adding Text to the Slideshow

Add a title to your slideshow using the titling controls. Insert a blank slide at the beginning of the
movie to display your title. You can also use blank slides to act as chapter dividers. Add text to
individual slides where appropriate.

Stage 8: Previewing the Slideshow Again

Preview the slideshow once again in full-screen mode to make sure the images and video clips are
playing in the correct sequence. Ensure that the music or audio clip matches the theme of the
slideshow and the cadence of the images and video clips, that the effects and transitions are to your
liking, and that the title text is correct.

Stage 9: Exporting the Slideshow
Export the slideshow as a movie in the format that best fits the platform by which you mean to share
it. You can choose a format that is optimized for iPod, iPod touch, iPhone, MobileMe, YouTube,
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Apple TV, or 1080p HD. You can also create a custom movie in a wide range of frame rates and
frame sizes.

Stage 10: Sharing Your Slideshow
After exporting your slideshow movie, tell your clients and friends. If you’ve posted your slideshow
on your website or YouTube, send an email announcement.

Copyright © 2009 Apple Inc. All rights reserved.
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Creating Slideshow Albums

To create a slideshow using the Slideshow Editor, you must first create an album that holds the
slideshow’s images. The easiest way to do this is to select images you want to appear in the
slideshow and then create an album. Aperture places the images in the order in which they were
selected in the Browser, but you can rearrange the order at any time.

& To create a slideshow album from selected images

1. Do one of the following:
e In the Browser, select the images you want to place in your slideshow.
e Select an item in the Library inspector.

2. Do one of the following:
e Choose File > New > Slideshow.

e Control-click an item in the Library inspector, then choose New > Slideshow from the shortcut
menu.

e Choose Slideshow from the New pop-up menu in the toolbar.

3. In the dialog that appears, give the slideshow a name, select a theme, and make sure the “Add
selected items to new slideshow” checkbox is selected.

Enter a mame for your Make sure this checkbox
slideshow in this field, is selected.

Bideshow Mame: | Sierra Sideshem L 1 lecied Rerm, o rew shdesh

You can preview slideshow themes by selecting themes in the left column.
4, Click Choose Theme.

The new slideshow album containing the selected images appears in the Library inspector, and the
Slideshow Editor appears above the Browser. If you want to rename the slideshow album, double-
click the slideshow album’s name in the Library inspector and enter a new name.
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The new slideshow
album appears in the

Library inspector.

You can also create an empty slideshow album and then drag images into the album.

& To create a new, empty slideshow album

1. Do one of the following:
e Choose File > New > Slideshow.

e Control-click an item in the Projects & Albums section of the Library inspector, then choose New
> Slideshow from the shortcut menu.

e Choose Slideshow from the New pop-up menu in the toolbar.
2. In the dialog that appears, give the slideshow a name, then select a theme.
You can preview slideshow themes by selecting themes in the left column.

3. Make sure the “Add selected items to new slideshow” checkbox is not selected.
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4. Click Choose Theme.

The new, empty slideshow album appears in the Library inspector, and the Slideshow Editor appears
above the Browser. Drag the images you want from the Browser into the new slideshow album in the
Library inspector.

To make changes to the slideshow, you use the controls in the Slideshow Editor. For more
information about the controls in the Slideshow Editor, see “Slideshow Editor.” For more information
about making changes to the slideshow, see “About Editing Slideshow Transitions and Applying
Effects.”

Copyright © 2009 Apple Inc. All rights reserved.
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Changing a Slideshow’s Theme

The first step in creating a slideshow is to choose its theme. Aperture provides a set of professionally
designed themes that present your images with background images, graphic elements, and

animation.

Aperture asks you to choose a theme when you first create a slideshow album, and it’s a good idea
to explore the slideshow themes before you get started. Some themes may lend themselves better to
the subject matter of your images than others. However, you can change the theme of a slideshow at

any time.

For more information about creating slideshow albums, see “Creating Slideshow Albums.”

& To change the theme for a slideshow

1. In the Slideshow Editor, click the Theme button.

EN M ¢
T - I, -
bpme Keywords | ool MobileMe  Facebock

| B These. ———— Click the Theme button

Q= Al foems T [ to change a slideshow's
¥ APERTURE 3 SAMPLE LIBRARY - theme,
= Projects

2. In the dialog that appears, select a theme from the list, then click Choose Theme.

Aperture applies the selected theme to the slideshow.

Which Slideshow Theme Should You Choose?

Aperture provides a set of professionally designed themes you can use to present slideshows of
your images. However, the Classic and Ken Burns slideshow themes are the most customizable.
Use the dialog that appears when you create a new slideshow album or when you click the
Theme button in the Slideshow Editor to preview the slideshow themes that come with Aperture.
If you want to significantly modify a slideshow theme, choose Classic or Ken Burns.
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About Editing Slideshow Transitions and Applying Effects

Aperture provides two methods for applying transitions and effects to the slides in your slideshow.
The first method applies the changes uniformly to every slide and transition in the slideshow using
the Default Settings controls. The second method applies changes to individual slides and transitions
using the Selected Slides controls. You use the second method when you want to emphasize a
specific image, change the length or type of a particular transition, or apply text to an individual
slide. The settings made for selected images using the Selected Slides controls override the settings
made to the entire slideshow using the Default Settings controls. When you make changes to the
entire slideshow using the Default Settings controls, the settings made using the Selected Slides
controls are unchanged.

Although the Default Settings and Selected Slides controls are not visible by default, you can access
them by clicking the Slideshow Settings button in the Slideshow Editor. For more information about
the Default Settings and Selected Slides controls, see “Slideshow Editor.”

For more information about working with the Default Settings controls, see “Modifying Settings
Applied to the Entire Slideshow.” For more information about working with the Selected Slides
controls, see “Modifying Individual Slides and Transitions.”

& To show the Default Settings and Selected Slides controls

m Click the Slideshow Settings button (with a slide icon) in the lower-right corner of the Slideshow
Editor, then click either the Default Settings or Selected Slides button.

Click here to change
settings for all slides.

m Selected Slides I—-— Click here to change
i settings for the selected
slides only.

Azpect Ratin: | BOTY (160§ $
| Repeat siideshow
| Loop main audio track
i showritle @ | A [ 1/
Moy slide for: = 100+ seconds
Backgroend: | I - |
porger: = 0 - calor (| =)
Irqul."J'T-‘\

Crop: | Ken Burns Effect ¢ |

Tramition: | Fade Through Black 3| = =
Spagit; [+ 2,00 - ipeconds "

Prawiaw

The slideshow controls in either the Default Settings or Selected Slides pane appear, depending on
which button you clicked.
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Modifying Settings Applied to the Entire Slideshow

The onscreen duration of each slide, the type of transition between slides, and the length of the
transitions are initially set by the theme you choose for the slideshow. However, you can change
these settings at any time, along with the aspect ratio, background color, image borders, Ken Burns
effect settings, and titles. For more information about working with slideshow themes, see “Changing
a Slideshow’s Theme.”

For more information about specifying settings that are applied to the entire slideshow, see the
following sections:

e “Setting the Aspect Ratio for the Slideshow”

e “Looping the Slideshow and the Main Audio Track”
e “Applying a Title to the Slideshow”

e “Setting the Length of Time Slides Play”

e “Choosing a Background Color for the Slideshow”
e “Adding Uniform Borders to Slides”

e “Fitting the Slides to the Aspect Ratio”

e “Adding Uniform Transitions Between Slides”

e “Adding Text to Slides”

Note: The availability of controls in the Default Settings pane of the Slideshow Editor depends on the
theme selected for the slideshow. Select the Classic or Ken Burns slideshow theme to view all of the
controls in the Slideshow Editor. For more information about selecting a theme, see “Changing a
Slideshow’s Theme.”
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Setting the Aspect Ratio for the Slideshow

Determining the aspect ratio of the slideshow is the first setting you need to address. Aperture
slideshows can be output at aspect ratios that match either the main or secondary display, the
dimensions of a standard 4:3 or 16:9 widescreen TV, or the 3:2 aspect ratio of iPhone.

& To set the aspect ratio for the slideshow

m |f the Default Settings pane of the Slideshow Editor is not shown, click the Default Settings button,
then choose an aspect ratio from the Aspect Ratio pop-up menu.

‘ | Default Sewsings  Selected Lides |

!
‘ Aspect Ratio: | Main Display (16100 il
I Reneat slideshow
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Looping the Slideshow and the Main Audio Track

You can set the slideshow to play repeatedly in full-screen mode until you stop playback by pressing
Esc.

¥l Repeat slideshow
lLeos main sudss track

Aspect Ratis: | Main Display (16:10) il
Clshowste © (A |-

& To set the slideshow to loop in full-screen mode until stopped

® |n the Default Settings pane of the Slideshow Editor, select the “Repeat slideshow” checkbox.

You can also set playback of the audio clip in the slideshow’s main audio track to loop until the end
of the slideshow.

& To loop playback of the slideshow’s main audio track

® |n the Default Settings pane of the Slideshow Editor, select the “Loop main audio track” checkbox.
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Applying a Title to the Slideshow

You can apply a title to the beginning of your slideshow.

& To apply a title to the beginning of the slideshow
1. In the Default Settings pane of the Slideshow Editor, select the “Show title” checkbox.

Aspect Ratio:| Main Disalay [16:10) Y
| | Repear shideihew
i shaw tite © [ A |

Disclosure button for the
pop-up color palette

“Show title” color well

The slideshow album’s name appears in a text box over the first slide in the slideshow.
2. If you wish, double-click the title and enter new title text.

3. If you would like to choose a specific font and font size for the slideshow text, click the “Show” Fonts
button and select a font and font size from the Fonts window.

4. If you would like to change the font color for the slideshow title, do one of the following:
e Click the “Show title” color well, then select a color from the Colors window.

e Click the disclosure button to the right of the color well, then select a color from the pop-up color
palette.

You can also display your title over a solid background by inserting a blank slide.

To insert a blank slide for the title

M)

1. In the Browser, move the playhead to the beginning of the slideshow.

2. Choose Insert Blank Slide With Text from the Slideshow Action pop-up menu (with a gear icon).
3

. If necessary, drag the blank slide to the beginning of the slideshow.
A blank slide appears at the beginning of the slideshow with the title.

4. In the Slideshow Editor, double-click the text in the slide and enter a title for the slideshow.
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Setting the Length of Time Slides Play
Next, you need to set the length of time the slides play.

& To set the length of time the slides play

® |n the Default Settings pane of the Slideshow Editor, specify the number of seconds that each slide
should appear onscreen using the “Play slide for” value slider.

Note: Depending on which theme is applied to the slideshow, additional controls may appear for
fitting the slideshow to the soundtrack and aligning the slideshow to beats. For more information
about adding a soundtrack to a slideshow, see “Adding Music and Audio to Slideshows.”
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Choosing a Background Color for the Slideshow

You can change the color of the background over which the slides play.

Aspect Ratio. | HOTY (L6:9) 1l
| Repeat slideshow
Lo main dudio tradk
iishow tiie @ | 4 [T~

Play slide for- (- 300 | seconds

— N

godar - o -l Celor (T |=|
e »}

Crop: | Fitin Frame 4|

Do one of the following:

Background color well

Disclosure button for
the pop-up color palette

& To change the slideshow’s background color

10/1/21 11:49 AM

In the Default Settings pane of the Slideshow Editor, click the Background color well, then select a

color from the Colors window.

Click the disclosure button to the right of the color well, then select a color from the pop-up color

palette.
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Adding Uniform Borders to Slides

You can add a uniform border to the slides in your slideshow to help distinguish them from the

background.
Aspect Ratic: | HOTY [16:9) &
|| Bepaan slicehes
| Loap main dudss track
Mshowrne @ | Al |-
e

Playglicda for (- 3.00 - | peconds

Background | I~ | — Border color well
bocder (- 6 uur-;_l

Bt o v ~— Diisclosure button for

Crop: | Fitin Frame 24

the pop-up color palette

Barder value slider

& To add image borders

1. In the Default Settings pane of the Slideshow Editor, specify the width of the border using the Border
value slider.

2. To specify a border color, do one of the following:
e Click the Border color well, then select a color from the Colors window.

e Click the disclosure button to the right of the color well, then select a color from the pop-up color
palette.

The border is applied to every image in the slideshow.

You can apply space between the image and its border using the Inset value slider.

& To add space between the image and its border

® |n the Default Settings pane of the Slideshow Editor, specify the width of the inset (as measured in
pixels) using the Inset value slider.
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Fitting the Slides to the Aspect Ratio

After you have chosen an aspect ratio for your slideshow, you need to decide how you want your
images to appear within the aspect ratio. Use the Crop pop-up menu in the Default Settings pane of
the Slideshow Editor to choose to have the images fit within the frame of the slideshow aspect ratio,
have the images fill the frame of the slideshow aspect ratio, or apply a Ken Burns effect to each
image in the slideshow. A Ken Burns effect either zooms in to or out of the image while
simultaneously panning along the widest dimension of the image.

You can have Aperture scale the images so that they fill the screen, with no part of the background
showing. Keep in mind that Aperture must zoom in to most of the images to make them fit the
aspect ratio of the slideshow. This means that parts of the images will be cropped.

e o 0 -

L Eiihe Evadi il
Crop: | Fit in Frame 3]

& To set the crop characteristics for your images

Do one of the following:

®m To fit every image in the slideshow within the chosen aspect ratio without cropping the images,
choose Fit in Frame from the Crop pop-up menu.

®m  To have every image in the slideshow fill the frame of the chosen aspect ratio, choose Fill Frame from
the Crop pop-up menu.

Cropping will occur along the longest dimension of each image unless the image’s aspect ratio
matches the aspect ratio chosen in the Aspect Ratio pop-up menu. Drag within the images to set the
portions of the images that are visible.

®m To apply a Ken Burns effect to the images in the slideshow, choose Ken Burns Effect from the Crop
pop-up menu.
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Adding Uniform Transitions Between Slides

You can add uniform transitions between the slides in your slideshow as well as set the duration of
the transitions.

Transition Transition direction
pop-up menu buttars

Transition: | Dsseive ]

Speed: - 7.50 - secomds ,

foiad = Speed value slider

Preview area

& To add transitions between every slide in the slideshow

1. In the Default Settings pane of the Slideshow Editor, choose a transition from the Transition pop-up
menu.

A preview of the selected transition plays below the Speed value slider. You can use the Transition
direction buttons to preview the angle at which animated transitions enter and exit the frame.

2. If you chose a transition that can be applied in more than one direction, click a Transition direction
button to set the direction of the transition.

The Preview area shows the angle at which animated transitions enter and exit the frame.

Note: The Transition direction buttons appear dimmed if you choose a transition that can be applied
in only one direction.

3. Set the duration of the transitions between slides by specifying the time, in seconds, using the Speed
value slider.

The chosen transition is applied uniformly between slides in the slideshow, with the direction and
duration you specified.
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Adding Text to Slides
You can display basic information about each image in your slideshow, such as each version’s name

or caption text.
& To add slide text
1. In the Default Settings pane of the Slideshow Editor, choose the type of information to display with

each image from the Text pop-up menu.

Text pop-up menu

y .
e L m Disclosure button for the
Al = = pop-up color palette

L —

X

Text Fonts Text color well

button

2. If you would like to choose a specific font and font size for the slideshow text, click the Text Fonts
button and select a font and font size from the Fonts window.

3. If you would like to change the color of the slideshow text, do one of the following:
e Click the Text color well, then select a color from the Colors window.

e Click the disclosure button to the right of the color well, then select a color from the pop-up color
palette.

By default, the slide text is displayed on the lower-left side of the image. However, you can choose
where you want the slide text to appear onscreen.

& To move the slide text

® |n the Slideshow Editor, select the slide text, then drag it to a new position on the screen.

Yellow alignment guides appear to help you center the text horizontally and vertically or align the
text in the upper third or lower third of the image.

Yellow lines appear
to help you position
the text.

The slide text is moved to the new position, appearing in the same position over each slide.
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Modifying Individual Slides and Transitions

After specifying the basic settings for a slideshow, you use the Selected Slides controls to modify or
accentuate specific slides and transitions. You can set the length of time a specific image appears
onscreen, change the background color for any slide, modify the border width and color for
individual slides, modify the space between an image and its border, and set how a specific image is
cropped when it is set to fill the screen. You can also apply a Ken Burns effect to a specific slide and
set where the panning begins and ends within the image, apply or change an existing transition and
its duration, and apply titles to individual slides.

For more information about specifying settings that are applied to individual slides in the slideshow,
see the following sections:

e “Working with Video Slides”

e “Applying a Photo Effect to Individual Slides”

e “Modifying the Display Time for Individual Slides”

e “Changing the Background Color for Individual Slides”
e “Adding Image Borders to Individual Slides”

e “Setting the Crop for Individual Slides”

e “Applying a Ken Burns Effect to Individual Slides”

e “Modifying Individual Transitions Between Slides”

e “Adding Text to an Individual Slide”

Note: The availability of controls in the Selected Slides pane of the Slideshow Editor depends on the
theme applied to the slideshow.

For more information about working with the default settings for a slideshow, see “Modifying
Settings Applied to the Entire Slideshow.”
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Working with Video Slides

In Aperture, you can add video clips as individual slides in your slideshow. You work with video clips
in the Slideshow Editor and Browser in the same way that you work with images. However, there are
additional controls in the Selected Slides pane of the Slideshow Editor for specifying the volume
settings of the video clip. For example, you can mute the audio clip in the main audio track so that it
doesn’t drown out the audio in the video clip while it is playing in the slideshow. You can also set
duration of the fade-in and fade-out of the video clip’s audio to smooth out abrupt transitions
between the video clip and the audio clip in the slideshow’s main audio track.

Note: To trim a video clip or duplicate a video clip so that you can use multiple portions of it in the
same slideshow, see “Listening to Audio and Viewing Video in the Viewer.”

| Defaus Sewings Selected Siides. |

Velame, ———F———— '~ 1N -]

Fade ln. ——={_}— — " 1Loa

Fade Out {1 (= 200 »
o Reduce volume of main track o
———— " 3%

& To set the volume for a video slide

1. Select a video clip in the Browser.
2. If the Selected Slides pane of the Slideshow Editor is not shown, click the Selected Slides button.

Note: The video controls appear in the Selected Slides pane only when a video clip is selected in the
Browser.

3. Specify the volume of the video clip as it plays in the slideshow using the Volume slider and value
slider.

You can set the volume of a video clip to smoothly increase over time by applying a fade-in. Adding
a fade-in to a video clip helps prevent an abrupt transition from the audio clip in the slideshow’s
main audio track to the audio in the video clip.

& To add a fade-in to a video clip

® |n the Selected Slides pane of the Slideshow Editor, specify the duration of the fade-in, in seconds,
using the Fade In slider and value slider.

You can also set the volume of a video clip to smoothly decrease over time by applying a fade-out.
Adding a fade-out to a video clip helps prevent an abrupt transition from the audio in the video clip
to the audio clip in the slideshow’s main audio track.

& To add a fade-out to a video clip

® |n the Selected Slides pane of the Slideshow Editor, specify the duration of the fade-out, in seconds,
using the Fade Out slider and value slider.

You can specify the volume of the audio clip in the main audio track or turn it off completely when a
video clip is playing.

& To adjust the volume of the audio clip in the main audio track while a video clip is playing
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® |n the Selected Slides pane of the Slideshow Editor, make sure the “Reduce volume of main track to”
checkbox is selected, then drag the slider to the left to decrease the volume, or to the right to
increase it. You can also click the left or right arrow in the value slider to change the volume, or drag
in the value field.

& To mute the volume of the audio clip in the main audio track while a video clip is playing

® |n the Selected Slides pane of the Slideshow Editor, make sure the “Reduce volume of main track to”
checkbox is selected, then set the slider to 0%.
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Applying a Photo Effect to Individual Slides
You can apply an effect, such as a sepia tint, to a selection of slides in your slideshow.

& To apply a photo effect to a specific slide or group of slides

1. Select an image or group of images in the Browser.
2. If the Selected Slides pane is not shown in the Slideshow Editor, click the Selected Slides button, then

choose an effect from the “Photo effect” pop-up menu.

Make sure this checkbox
is selacted.

| Dufaus Settings  Selecteil Shdes |

A@ Phiozo affect! | Black & White 3

[+ Py sl for: (- 200 ¢ seconds

1 Backgrownd:- -|-|

] Barder: = © ) Colar [T =]

(| Inbexi{= 0 =}
(=l Crop; | KenBumns Effecy £ | [ Ean |

The effect is applied to the selected slides. Deselect the “Photo effect” checkbox to turn the effect
off.
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Modifying the Display Time for Individual Slides
You can modify the length of time any image in your slideshow appears onscreen.

& To set the display time for a specific slide or group of slides
1. Select an image or group of images in the Browser.
2. In the Selected Slides pane of the Slideshow Editor, select the “Play slide for” checkbox.

Make sure this checkbox
is selected.

'__If?-_l_f_hur[ Semings. Selacyed Siides. -l

W Photo affect | Back & Whan 3 |

Specify a duration using
this value slider.

b Play shide fior: (= 200 secands

Boeder: o Colar; -
inseti(+ O
= Crop! | Ken Dures Effect & | Edit

3. Specify the length of time you want the slide or group of slides to appear using the “Play slide for”
value slider.

The display time for the selected slide or slides changes to the duration you specified.

You can also tap record the durations of slides to match the slideshow soundtrack using the Slide
Duration button. When you click the Slide Duration button, controls appear that allow you to set the
length of time each slide plays on the fly while playing the slideshow.

& To set a slide’s duration on the fly

1. In the Browser, move the playhead to the beginning of the slideshow.
2. In the Slideshow Editor, click the Slide Duration button.

An overlay displays the length of time the slide is set to play.

Whien the slidesh 15 playing, press the refum key to set 5 _0
tha slide’'s durats Press tho spacebar to playi pause.

sedanmds

o »lald]
Click the Slide Duration Controls appear over the
button. image in the Slideshow

Editor that allow you to
change the duration of
each slide,

3. Press the Space bar to play the slideshow.
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As the playhead moves over the selected slide in the Browser, the duration counter in the overlay
counts the number of seconds. The playhead stops when it reaches the end of the slide, but the
duration counter continues to count.

4, Press Return to stop the counter and set the current slide’s display duration.
The playhead moves to the next slide in the Browser.
5. Repeat step 4 until the duration of each slide is set.

6. When you have finished, click Done.
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Changing the Background Color for Individual Slides
You can change the background color for any slide in your slideshow.

dividual Slides

10/1/21 11:49 AM

& To change the background color of a specific slide or group of slides

1. Select an image or group of images in the Browser.

2. In the Selected Slides pane of the Slideshow Editor, select the Background checkbox.

MMake sure this checkbaox
is selectad.

| Defauit Sercings

B Photo effect: | Black & White 1
¥ May aiide for: ([« 2.00 - seconds

————

3. Do one of the following:

Click here to select
a colar from the
Colors window.

Click here to select
a color from the

pop-up color palette,

— Pop-up color palette

e Click the Background color well, then select a color from the Colors window.

e Click the disclosure button to the right of the color well, then choose a color from the pop-up

color palette.

The new background color is applied to the selected slide or group of slides.
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Adding Image Borders to Individual Slides
You can apply a border to any image or group of images in a slideshow.

& To add image borders to a selected slide or group of slides

1. Select an image or group of images in the Browser.

2. In the Selected Slides pane of the Slideshow Editor, select the Border checkbox.

Make sure this checkbox
is selected.
| Dafaust Setmings
|| B Phots eftece | Biack & white 3 Click here to select
o Payside for [ 200 ) sconds a color from the
G mickarecam m —— Colars windaow.
oEil Border: (= 3+ oColor [ ':*I:'—Elickheremseleu
] wanti(= o =1 a color from the pop-up
T Crop: | Ken Bums | [ e | color palette.

Specify the width
aof the border using
this value slider,
3. Specify the width of the border using the Border value slider.
4. If you want to change the color of the border, do one of the following:

e Click the Border color well, then select a color from the Colors window.

e Click the disclosure button to the right of the color well, then select a color from the pop-up color
palette.

The new image border is applied to the selected slide or group of slides in the slideshow.
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Setting the Crop for Individual Slides
You can make an image or a group of images in your slideshow fill the screen.

| Defauln Setings - Seleeted Shiges. |
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To make the image or group of images in the slideshow fill the screen
Select an image or group of images in the Browser.

In the Selected Slides pane of the Slideshow Editor, select the Crop checkbox.
Choose Fill Frame from the Crop pop-up menu.

The selected image or images fill the screen.

You can also choose which part of the image is cropped when you choose the Fill Frame item from
the Crop pop-up menu.

To set the crop for images that fill the screen

In the Selected Slides pane of the Slideshow Editor, click the Edit button to the right of the Crop pop-
up menu.

A crop overlay appears over the selected image.
Drag the crop overlay over the part of the image that you want to appear in the slideshow.

Click Done.
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Applying a Ken Burns Effect to Individual Slides

You can select specific images in your slideshow that warrant additional emphasis and apply a Ken
Burns effect to them.

Note: If the faces in the images have names assigned to them, the Ken Burns effect takes this

information into account when cropping and positioning the faces in the slideshow.

& To apply a Ken Burns effect to an individual slide in the slideshow

1. Select an image in the Browser.

2. In the Selected Slides pane of the Slideshow Editor, select the Crop checkbox.
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3. Choose Ken Burns Effect from the Crop pop-up menu.

A Ken Burns effect is applied to the image.

You can also choose where the Ken Burns effect panning begins and ends within the image.

& To set the start and end frames for the Ken Burns effect

1. Follow the steps above for applying a Ken Burns effect to an individual slide.
2. Click the Edit button to the right of the Crop pop-up menu.
The Start and End overlays appear in the Slideshow Editor.

3. Drag the Start (green) and End (red) overlays over the parts of the image where you want the panning
to begin and end.

The yellow line between the center marks of the Start and End overlays indicates the panning path of
the Ken Burns effect.
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The End overlay is red.

The Start overlay is green,

4. If you wish, you can reverse the panning motion by clicking the Reverse button.

Reverse button

5. When you are satisfied with the panning path of the Ken Burns effect, click Done.
The customized Ken Burns effect is applied to the image.

Tip: Click the Preview Slideshow button or press the Space bar to review the customized Ken Burns
effect you applied to the image.
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Modifying Individual Transitions Between Slides
You can add a unique transition in your slideshow or change an existing one using the Transition

controls.
& To add a unique transition between slides
1. Select two images in the Browser that appear side by side.

2. In the Selected Slides pane of the Slideshow Editor, select the Transition checkbox and choose a
transition from the pop-up menu.

A preview of the transition applied between the images appears in the Preview area below the Speed
value slider.

Transition Transition direction
pop-up menu buttons
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— Preview area

Make sure this checkbox
is selected.
3. Set the duration of the transition in seconds using the Speed value slider.

4, If the transition effect can be applied in more than one direction (the Move In transition, for
example), you can set the direction of the transition by clicking one of the Transition direction
buttons.

The chosen transition is applied between the images selected in the Browser with the duration and
direction you specified.
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Adding Text to an Individual Slide

You can add text to individual images in your slideshow using the Text controls. The text for the
individual slides overrides any text applied to the entire slideshow using the Default Settings
controls. Text that can be edited appears over the selected image or group of images in the

slideshow. You can also automatically add text based on metadata such as the version name or
caption.

& To add text to an individual image in the slideshow

1. In the Browser, select an image or group of images.

2. In the Selected Slides pane of the Slideshow Editor, select the Text checkbox, then do one of the
following:

e To add custom text: Choose Custom from the Text pop-up menu.

Text that can be edited appears over the selected image in the slideshow. Enter the text for the
image here.

e To add text based on the image’s metadata: Choose a type of metadata from the Text pop-up
menu.

Text pop-Lp menu
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3. If you would like to change the color of the text, do one of the following:
e Click the Text color well, then select a color from the Colors window.

e Click the disclosure button to the right of the color well, then select a color from the pop-up color
palette.

4. If you would like to choose a specific font and font size for the slideshow text, click the Text Fonts
button and select a font and font size from the Fonts window.

5. If you would like to choose where the text appears on the screen, select the text and drag it to a new
position.
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Adding Music and Audio to Slideshows

You can add music and audio to your slideshow using the Audio browser controls in the Slideshow
Editor. In the Slideshow Editor, you can add audio to slideshows in two ways.

The first method of adding audio to a slideshow involves dragging a song or an audio clip from the
Audio browser to the background of the timeline in the Browser. Audio added in this way is called the
main audio track. The main audio track is used to play audio, such as a song, in the background.
Clips in the main audio track cannot be edited, but you can append additional audio (such as another
song) to the end of the track when the slideshow is longer than the audio file. When an audio clip is
added to the main audio track, the background of the timeline in the Browser appears green.
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The second method of adding audio to a slideshow involves dragging a song or an audio clip, such
as voiceover recorded using GarageBand, from the Audio browser to a specific slide in the Browser.
Dragging an audio clip to a slide creates a secondary audio track, which appears as a green bar
below the slides in the Browser. You can trim the length of audio clips in the secondary audio track
as well as control fade-in and fade-out effects.
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You can use the Audio browser controls to access DRM-free audio files from a variety of sources,
including the Sample Music folder, the Theme Music folder, GarageBand, or your iTunes music
library. You can also use any audio file imported into the Aperture library.

You can fit the slideshow to match the length of the main audio track, and you can align the slides to
match the beat of the music.

& To show the Audio browser controls

®m |n the Slideshow Editor, click the Audio Browser button (with an icon of a musical note) in the lower-
right corner of the Slideshow Editor.

For more information about adding music and audio to the slideshow, see the following sections:
e “Adding Audio Clips to Your Slideshow”

e “Working with Audio Clips in the Secondary Audio Track”

e “Adjusting the Volume Between the Main Audio Track and Secondary Audio Track”

e “Syncing the Main Audio Track to the Slides in the Slideshow”

e “Removing Audio Clips from Your Slideshow”
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Adding Audio Clips to Your Slideshow
You can add audio to your slideshow by dragging an audio clip to the background of the Browser to

create the main audio track, or you can drag an audio clip to a specific slide in the Browser to create
the secondary audio track.
@ To add an audio clip to the main audio track in your slideshow

1. If the Audio browser controls are not shown in the Slideshow Editor, click the Audio Browser button.

2. Select the source for your audio from the Source list.

— Select the source for
your audio hera.

— Select a sang or audio
clip in this area.

Audio Browser button

3. Select a song or audio clip from the Audio browser.
4. If you wish, preview the audio by clicking the Play button.
5. Drag the selected song or audio clip to the point in the Browser where you want the audio to begin.

The background of the Browser appears green, indicating that the selected song or audio clip is
applied to the main audio track of the slideshow.
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6. If the audio clip in the main audio track is not long enough, drag another audio clip from the Audio
browser to the point in the Browser where the previous audio clip ended.

The main audio track is extended by the duration of the second audio clip.

& To add an audio clip to the secondary audio track in your slideshow

1. If the Audio browser controls are not shown in the Slideshow Editor, click the Audio Browser button.

2. Select the source for your audio from the Source list.
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3. Select a song or audio clip from the Audio browser.
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4. If you wish, preview the audio by clicking the Play button.
5. Drag the selected song or audio clip to the specific slide in the Browser where you want the audio to
begin.

A green bar appears at the bottom of the Browser to indicate that the audio clip has been added to
the secondary audio track. When the playhead reaches the secondary audio track, the audio clip in
that track plays over any audio clip in the main audio track.
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Drag the song or The green bar
audio clip to where you indicates a clip in the
want the secondary secondary audio track,

audio to begin,
6. Repeat steps 2 through 5 to add additional audio clips to the secondary audio track.
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Working with Audio Clips in the Secondary Audio Track
You can adjust the duration and placement of audio clips in the secondary audio track.
& To trim an audio clip in the secondary audio track

= |n the Browser, click the right edge of the audio clip, then drag to the left to shorten the audio clip or
drag to the right to lengthen it.

The pointer changes to a Resize pointer, indicating that you can change the clip duration.
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| Use the Resize pointer to
shorten or lengthen the
audio clip.

You can also adjust the placement of an audio clip in the secondary audio track after the clip has
been applied.

& To adjust the placement of an audio clip in the secondary audio track
® Drag the audio clip to a new position in the Browser timeline.

The pointer changes to a hand, indicating that you can drag the audio clip to a new position.
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The hand icon appears
when you drag the audio
clip 1o a new position,
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Adjusting the Volume Between the Main Audio Track and Secondary Audio Track

As the slideshow plays, the clips in the secondary audio track always play on top of audio clips in the
main audio track. However, you can apply fade-ins and fade-outs to the clips in the secondary audio
track, and you can adjust the volume of clips in the main audio track when a clip in the secondary
audio track is playing.

& To add a fade-in to an audio clip in the secondary audio track

1. In the Browser, select the clip in the secondary audio track to which you want to apply a fade-in.
2. Do one of the following:

e Choose Adjust Audio from the Slideshow Action pop-up menu (with a gear icon).

e In the Browser, double-click the audio clip.

The Audio Adjustments HUD appears.

3. In the Audio Adjustments HUD, drag the Fade In slider to the right to increase the duration of the
fade-in, or to the left to decrease the duration.

You can also click the left or right arrow in the Fade In value slider, or drag in the value field.

Fade In shider

Madis Adjusiments

Fade In value slider

A setting of 0.0s turns the fade-in off.

The volume at the beginning of the audio clip in the secondary audio track will slowly increase
according to the setting you specified in the Audio Adjustments HUD.

& To add a fade-out to an audio clip in the secondary audio track

1. In the Browser, select the clip in the secondary audio track to which you want to apply a fade-out.
2. Do one of the following:

e Choose Adjust Audio from the Slideshow Action pop-up menu (with a gear icon).

e In the Browser, double-click the audio clip.

The Audio Adjustments HUD appears.

3. In the Audio Adjustments HUD, drag the Fade Out slider to the right to increase the duration of the
fade-out, or to the left to decrease the duration.

You can also click the left or right arrow in the Fade Out value slider, or drag in the value field.
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Fade Out value slider

Rivart All

Fade Out slider

A setting of 0.0s turns the fade-out off.

The volume at the end of the audio clip in the secondary audio track will slowly decrease according
to the setting you specified in the Audio Adjustments HUD.

You can specify the volume of clips in the main audio track or turn the track audio off completely
when a clip in the secondary audio track is playing.

& To adjust the volume of clips in the main audio track while a clip in the secondary audio track
is playing
1. In the Browser, select a clip in the secondary audio track.
2. Do one of the following:
e Choose Adjust Audio from the Slideshow Action pop-up menu (with a gear icon).
e In the Browser, double-click the audio clip.
The Audio Adjustments HUD appears.
3. In the Audio Adjustments HUD, do one of the following:

e To change the volume of clips in the main audio track: Make sure the “Reduce volume of main
track to” checkbox is selected, then drag the slider to the left to decrease the volume, or to the
right to increase it. You can also click the left or right arrow in the value slider to change the
volume, or drag in the value field.

e To mute the main audio track: Make sure the “Reduce volume of main track to” checkbox is
selected, then set the slider to 0%.

Audlo Adfesoments

Use this checkbox and the
controls below to change
or mute the valume of dips
in thie main audio track.
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Syncing the Main Audio Track to the Slides in the Slideshow

You can set the slideshow to fit the duration of the main audio track. However, you need to make
sure that the audio clips you apply to the main audio track are long enough to play each slide.

& To fit the slideshow to the duration of the main audio track

® |n the Slideshow Editor, choose Fit Slides to Main Audio Track from the Slideshow Action pop-up
menu (with a gear icon).

You can also align the slides in the slideshow to the beat of the music.

& To align the slides to the beat of the music

= |n the Slideshow Editor, choose Align Slides to Beats from the Slideshow Action pop-up menu (with a
gear icon).

You can always reset any audio adjustments you’ve made to an audio clip applied to a slideshow.

& To reset audio adjustments

1. If necessary, open the Audio Adjustments HUD by choosing Adjust Audio from the Slideshow Action
pop-up menu (with a gear icon).

2. In the Audio Adjustments HUD, click the Revert All button.

Adjdis AdjusEmants

Click this button to reset
all audio adjustments.,
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Removing Audio Clips from Your Slideshow
If necessary, you can remove audio clips from both the main and secondary audio tracks.

& To remove an audio clip from the main audio track

1. In the Browser, select the audio clip in the main audio track.
The audio clip is surrounded by a white outline.
2. Press the Delete key.

The audio clip is removed from the main audio track, and the green background in the Browser
disappears.

& To remove an audio clip from the secondary audio track

1. In the Browser, select the audio clip you want to remove from the secondary audio track.
The audio clip is surrounded by a white outline.
2. Press the Delete key.

The audio clip is removed from the secondary audio track.
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Viewing Your Slideshows in Aperture

You can view your slideshow at any time in one of two ways in Aperture: in full-screen mode or in
the Slideshow Editor.

Play Slideshow button

Llideshow Action Slideshow Settings
pPOp-up Mmenu Slide Duration button bButton
(o rln = [W & —— hudio Browser button
o] el R )

Preview Slideshow button

& To preview your slideshow in the Slideshow Editor
Do one of the following:
® |n the Slideshow Editor, click the Preview Slideshow button.
®  Click the Space bar to begin playing the slideshow, and click it again to pause playback.

The slideshow plays in the Slideshow Editor, and a playhead in the Browser moves across the images
as they appear in the slideshow.

& To play your slideshow in full-screen mode
® |n the Slideshow Editor, click the Play Slideshow button.

The computer screen turns blank, and then the slideshow begins playing. Press the Esc key at any
time to exit the slideshow.

Note: If you have a dual-display system, you can choose which display the slideshow appears on
when you click the Play Slideshow button. To specify which display the slideshow appears on, choose
Aperture > Preferences, then click Appearance. Choose which display you want the slideshow to
appear on from the “View Slideshows on” pop-up menu.
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Sharing Your Slideshow Movies

Once you have completed your slideshow, you are ready to share it with clients and friends. Aperture
provides a few simple controls for exporting your slideshow as a movie, in the size and format most
suitable for your intended audience. When you’'re ready to share your slideshow, the first thing you
need to decide is how it will be viewed. By default, the export dialog provides options for exporting
your slideshow as a movie suitable for playback on iPod, iPhone, and iPod touch; as a movie for the
web to be posted on MobileMe or YouTube; or as a high-resolution movie compatible with HD 720p
Apple TV or HD 1080p televisions. If necessary, you can also output your slideshow movie in a
custom size.

& To share your slideshow as a movie

1. In the top-right corner of the Slideshow Editor, click the Export button.

2. In the dialog that appears, give the slideshow movie a name in the Save As field, then select a
location to save it to.

3. Choose the viewing platform for your movie from the “Export for” pop-up menu.

4. If you want to export a slideshow movie in a custom size, choose Custom from the “Export for” pop-
up menu, then enter the width and height, in pixels, in the Width and Height fields, and enter the
number of frames per second in the Frame Rate field.

5. If you want Aperture to automatically send a copy of the slideshow movie to iTunes, select the
“Automatically send slideshow to iTunes” checkbox.

6. Click Export.
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Using the Light Table

The Light Table provides a large, open space where you can freely resize, group, and rearrange
images. You can also easily arrange related images together to compare them, as you might during
color correction.

Copyright © 2009 Apple Inc. All rights reserved.
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An Overview of the Light Table

The Light Table is used to arrange and view images. You can work with images in the Light Table just
as you would work with slides on a physical light table. You can place a selection of images in the
Light Table for review and drag them to new positions, arranging, grouping, and resizing them in
different combinations to see how they might look on webpages or book pages. The Light Table
automatically displays yellow guidelines that show you how the item you’re working with aligns with
other items already on the page. You never run out of space in the Light Table—it grows as you add

images to it, and it’s easy to adjust the view by zooming in or changing the area of the Light Table
that’s shown.

¥ im] allme———m

You can use the Light Table when color correcting many related photos. You can arrange related
images together and carefully compare the color values between images.

You can also use the Light Table to sort images into related piles. After sorting, you can select
groups of images and assign keywords to all the images in a group at once.

You can use the Light Table to create editorial layouts as well, arranging images onscreen to tell a
story. You can put the selects from a given project in the Light Table and arrange them so that they
progress visually, eliminating repetitive images. As you group and pair images of the same subject,
you’ll find the Light Table ideal for examining the relationships between images.
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Creating a Light Table Album

To view images in the Light Table, you first create a Light Table album. You can create a new, empty
album and drag images into it, or you can select images in a project and create a Light Table album
to hold them.

& To create a new, empty Light Table album

1. In the Library inspector, select Library Albums or the project or folder where you want the new Light
Table album to appear.

2. Do one of the following:
e Choose File > New > Light Table.

e Control-click the item in the Library inspector, then choose New > Light Table from the shortcut
menu.

e Choose Light Table from the New pop-up menu in the toolbar.

Choose Light Table from
the Mew pop-up menu
in the toolbar.

3. In the dialog that appears, enter a name for the Light Table, and make sure to deselect the “Add
selected items to new light table” checkbox.

Make sure this checkbox
is nat selected.

4. Click OK.

The new empty Light Table album appears in the Library inspector. Now you can drag images into
the new Light Table album from any item in the Library inspector.
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& To create a Light Table album that holds a selection of images
1. In the Browser, select the images you want in the Light Table album.
2. Do one of the following:

e Choose File > New > Light Table.

e Control-click the selected item in the Library inspector, then choose New > Light Table from the
shortcut menu.

e Choose Light Table from the New pop-up menu in the toolbar.

Choose Light Table from
the Mew pop-up menu
in the toolbar.

3. In the dialog that appears, enter a name for the Light Table, and make sure the “Add selected items
to new light table” checkbox is selected.

e _.;.:-iHE_. T

Make sure this chackbox
is selected.

4, Click OK.
The new Light Table album containing your image selection appears in the Library inspector. If

necessary, you can drag additional images from the Browser to the Light Table album in the Library
inspector.

Copyright © 2009 Apple Inc. All rights reserved.
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Placing and Viewing Images in the Light Table
After adding images to the Light Table album, you can select the ones you want to work with and
place them in the Light Table for viewing.

& To add images to the Light Table

m Select a Light Table album in the Library inspector, then drag images from the Browser to the Light
Table.

n |00

o — Simply drag images
from the Browser to
the Light Table,

& To remove an image from the Light Table

m Select the image, then click the Put Back Selected button.
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Click the Put Back Selected
button to remove a
selected Image.

[T EY

The image disappears from the Light Table but remains available in the Browser.

If you have many images in a Light Table album, it may be difficult to remember which images you
haven’t yet placed in the Light Table. You can set the Browser to show only those images that haven’t
been placed in the Light Table.

Show All Images button

1 i Rt e ] (B Crand ol Show Unplaced Images
bt

Rrvimertics D0

& To see only images in the Browser that remain unplaced

®m  Click the Show Unplaced Images button.

& To see the entire contents of the Light Table album in the Browser

®  Click the Show All Images button.

Making Adjustments to Images in the Light Table

The Straighten, Crop, and Red Eye adjustment tools and the Quick Brush pop-up menu in the
tool strip are unavailable when using the Light Table. To use these controls to make a change to
an image in the Light Table, select the image in the Browser, then click the Show Viewer button
at the top of the Browser (to the right of the Filmstrip View, Grid View, and List View buttons).
The selected image appears in the Viewer, and you can make your changes. Click the Show
Viewer button again to return to the Light Table.
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Moving and Resizing Images in the Light Table

You can drag images to different locations in the Light Table, trying out different combinations and
orientations. For example, you might take a group of related images and arrange them to see how

they’d appear on a print page. You can also enlarge or reduce images. After resizing an image, you
can quickly reset the image back to its original size.

& To move images in the Light Table

® |n the Light Table, select the images you want to move and drag them to a new location.

& To drag an image to a location offscreen

® Drag the image to the border of the Light Table until the screen begins to scroll.

& To change the size of an image

®m  Position the pointer over the image, then drag a resize handle.

Move the pointer over the
image to show the resize
handles, then drag to
change the image's size.

& To reset an image to its previous size

®m  Control-click the image, then choose Reset Selected Size from the shortcut menu.

Copyright © 2009 Apple Inc. All rights reserved.
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Aligning and Arranging Images in the Light Table

As you drag images in the Light Table, you’ll see yellow guidelines appear that mark the vertical,
horizontal, and center points of the stationary, unselected images in relation to the images you are
dragging. Using the guidelines, you can make sure that your selected images visually align with other
images in the Light Table.

You can also select a group of images in the Light Table and automatically align them according to
their top, bottom, or side edges, or by their centers. In addition, you can have Aperture arrange a
selected group with equal space between each image.

&l &.a

When you drag an image,
guidelines appear, helping
you align it with the other
images.

& To manually align images

1. In the Light Table, select the images you want to align, making sure that the image or group of
images you want to align with remain unselected.

2. Drag the selected image or group of images.

As you drag the selected image or group of images, yellow guidelines appear as a visual cue to help
you align the selected images with the unselected ones. When you quit dragging, the yellow
guidelines disappear.

You can also have Aperture automatically arrange the images in the Light Table.
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& To automatically arrange images in the Light Table

® |n the Light Table, Control-click beside the images, then choose Arrange All ltems from the shortcut
menu.

If some images in a group are hidden behind other images, you can also reveal, or uncover, all
images in the group.

& To reveal images in the Light Table that are covered by other images

1. Select the top image in the group.

[l e il ———[

The top image
is selected

hlf o,

2. Click the Uncover button (or press Shift-X).

Click the Uncover button
to reveal all images under
the selected image.

3= [ o @ w— =

Al [t @ m)

3. Select an uncovered image.
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The images are regrouped, with the selected image on top.

Copyright © 2009 Apple Inc. All rights reserved.
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Adjusting the Light Table View

You can adjust the Light Table view to better view and work with images. This is particularly useful

when the Light Table is larger than your screen size. You can also increase the area of the Light
Table.

Scale to Fit button

B @ @

Drag the Light Table
Foom slider ta zoom
in or out,

& To zoom in to or out of the Light Table

® Drag the Zoom slider to change the view.

& To fit the Light Table to your screen size

®  (Click the Scale to Fit button.

& To change the Light Table view to 100 percent

m  Control-click in a blank area of the Light Table, then choose Zoom to 100% from the shortcut menu.

@ To increase the area of the Light Table

® Drag an image to the border of the grid background so that the area of the Light Table automatically
expands.

Drag an image to a
border of the Light
Tabde to expand the
Light Table area.

Ayl fs o
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Printing Light Table Arrangements
After arranging your images, you can print the image arrangement for further review.

For more information about printing Light Table arrangements, see “Printing a Light Table
Arrangement.”

Copyright © 2009 Apple Inc. All rights reserved.
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Deleting a Light Table Album

You can quickly delete an entire Light Table album. If you’ve transferred images from the Light Table
album to other projects or albums, the images in the other projects and albums remain unchanged,
even though the Light Table versions are gone.

& To delete a Light Table album
1. Select the Light Table album in the Library inspector.

2. Choose File > Delete Light Table (or press Command-Delete).

The deleted Light Table album is placed in the Aperture Trash. For more information about the
Aperture Trash, see “Working with the Aperture Trash.”
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Creating Books

Using the book designs and page layouts included in Aperture, you can print outstanding portfolios
of your work that show your images in their best light. You can order printed books of your images

using the Apple print vendor service, which provides excellent printed results and direct delivery to

you or your clients. You can also print your own custom books on a color printer, or create files that
you can hand off to a print vendor.
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An Overview of Creating Books

Aperture provides options for creating a print book to suit a variety of needs. When you select or
create a book album in the Library inspector, the Book Layout Editor appears along with the Browser.
You use the Book Layout Editor to set up the page structure of your book and place images and text
on the pages.

[ o= e 2ok | T TP RNV KPR R

—— The Book Layout Editor
s where you design
your book,

The Pages pane on the left shows thumbnails of your book pages. You scroll through the thumbnails
and click to select a page of your book to work on. A larger view of the selected page appears on the
right.

When you first create a book album in the Library inspector, Aperture automatically creates a default
set of pages for you. You then use the Book Layout Editor to format your pages and create any
additional pages you need.

Books are based on a theme, or design, and master page layouts that present your images in a
standardized way. Click the Theme button to see the themes you can choose.

When you choose a theme, the Book Layout Editor provides a professionally designed set of master
pages that determine how you mix text and images on the page. For example, you can choose
among master pages that create a cover page, pages of text in columns of various sizes, pages of
images in different arrangements, and pages with different combinations of images and text. You’ll
find master pages provide a fast and convenient method for quickly laying out a book.

You can apply a master page design to any selected page to define where your text and images
appear. Pages appear with gray photo boxes to hold images and text boxes to hold text. To add
images, you drag them into the photo boxes from the Browser. To add text, you select a text box
and type or paste text into it. If you wish, you can also place metadata boxes next to images to
display an image’s version name, caption, keywords, and other metadata. You can also add a map
showing the places where the images in your book were shot.
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If you prefer, you can build a book page by page. You can add a new page to your book, choose a
master page design, fill in images and text, and then create the next page, repeating the procedure
for each page you add.

You can also select a group of images in the Browser and have Aperture automatically place them in
pages in your book. Aperture creates as many pages as you need and fills them with your images.
You can change the page design of individual pages later by applying different master page designs.

As you work on a book, you may need to adjust the layout of individual pages. For example, you may
discover that one image in a group should appear slightly larger. You can move and resize the boxes
that hold images on individual pages, making minor layout adjustments when a master page design
doesn’t quite suffice.

To change the design of a page, click the Edit Layout button. You can then work with the photo
boxes and text boxes that appear on the page, resizing and rearranging them as necessary. The
Book Layout Editor automatically displays yellow guidelines that show you how the item you’re
working with aligns with other items already on the page.

To add text and images to your pages without changing the page layout, click the Edit Content
button. You can then add images and text to the page, but you can’t move or resize the boxes on the
page, which helps prevent unintended formatting changes.

You can also add photo, text, map, or metadata boxes to a page when you need them.

Click the Edit Layout button and then choose a text, metadata, map, or photo box option from the
Add Box pop-up menu. When a box appears, you can resize and reposition it.

The Book Layout Editor also allows you to create covers, indexes, and blank pages, use automatic
page numbers, and create or modify master page designs.

When your book is complete, you can purchase printed copies from the Apple print vendor for a fee.

Note: Although you can create books larger than 99 pages, there is a 99-page limit for books
ordered through the Apple print vendor. When you try to order a book larger than 99 pages, a dialog
warns you that there are too many pages. If you plan to print a book using the Apple print vendor,
make sure to keep the number of pages at or below the 99-page limit.

If you prefer to print your books yourself, you can print your book using your own office printer or
export your book as a PDF file that you can send to a print shop for printing.
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Planning Your Book

The amount of planning and work involved in creating a book varies with the type of project. If
you’re creating wedding photo albums, you may be primarily concerned with creating a reusable
book design into which you can quickly place images that tell the wedding story. The end result may
be one or several printed copies per project.

On the other hand, producing a large book, such as a coffee table book, may require a good deal of
planning, writing, design, page composition, proofing, and production work. In addition, you’ll want
to look ahead and decide how the manuscript should be printed and bound, the number of copies for
the print run, and what copyright and permissions information your book should include.

For relatively simple books, here are some of the typical steps in the publishing process.

Stage 1: Planning Your Book’s Cover
Choose a cover image and decide what text should appear on the cover.

Stage 2: Creating Copyright Notices
Create any copyright or permissions notices you need.

Stage 3: Creating a Book Album
Create a book album and choose a theme for your book.

Stage 4: Choosing the Book’s Images

Place the book’s images in the book album and arrange them in the Browser in the order in which
they should appear in the book. Don’t place the images on your pages yet.

Stage 5: Specifying the Book’s Settings

Specify any overall settings for the book, such as size, hardcover or softcover binding, page
numbering, and so on.

Stage 6: Creating the Book’s Pages
Create the number of pages you need and apply master page designs to them.

Stage 7: Placing Images in the Book
Have Aperture automatically place your images, or drag the images onto your pages.

Stage 8: Repositioning and Resizing Images
Reposition and resize images, adjusting individual page layouts if necessary.

Stage 9: Adding Text to Your Book
Add text to your pages and cover.

Stage 10: Proofing Your Book
Print a proof and carefully review the text and layout of the book.

Stage 11: Distributing Your Book

Send the book to the Apple print vendor, or create a PDF file that you can print or send to a print
vendor. If you create a PDF file, make sure to include all the fonts you used in your book in the PDF
file.
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If you’re creating a larger, more complex book, contact your print vendor early in the process to
make sure you consider printing issues such as the choice of paper stock, the use of inks and
varnishes, and the review of bluelines, as well as other issues such as binding, packaging, shipping,
and pricing.

If you routinely produce printed albums, you can create a book album that you can copy and reuse
with each new project. After setting up master pages and individual page layouts, you can copy the
book album to another project and then substitute the new images, increasing your publishing

productivity greatly. You can then customize certain pages, such as your cover, to provide any
unique touches you like.
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Creating a Book Album
You can create a book album in two ways:

e Select the images you want to include in the book and then create a new book album containing
the selected images.

e Create a new book album and then drag the images into it.

& To create a book album from a selection of images

1. Select the images you want to use in the book, then do one of the following:
e Choose File > New > Book.

e Control-click the current project or album in the Library inspector, then choose New > Book from
the shortcut menu.

e Choose Book from the New pop-up menu in the toolbar.

2. In the dialog that appears, enter a name for the book album in the Book Name field, and specify the
following:

e Theme list: Select a theme in the list to see a preview of its design on the right.
e Book Type pop-up menu: Choose the physical size of the book.
3. Select the “Add selected items to new book” checkbox.

4. If you plan to use the Apple print service to print your book and you want to check the pricing for
your book type and theme combinations, click the Options & Prices button.

Pricing options for ordering printed books through the Apple print service appear in your web
browser.

5. When you’re ready, click Choose Theme.

A new book album appears in the Library inspector, containing the selected images.

& To create a new, empty book album

1. Do one of the following:
e Choose File > New > Book.
e Choose Book from the New pop-up menu in the toolbar.

2. In the dialog that appears, enter a name for the book album in the Book Name field, and specify the
following:

e Theme list: Select a theme in the list to see a preview of its design on the right.
e Book Type pop-up menu: Choose the physical size of the book.
3. Make sure the “Add selected items to new book” checkbox is not selected.

4. If you plan to use the Apple print service to print your book and you want to check the pricing for
your book type and theme combinations, click the Options & Prices button.

Pricing options for ordering printed books through the Apple print service appear in your web
browser.

5. When you’re ready, click Choose Theme.
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A new book album with no images appears in the Library inspector.

& To add images to any book album

1. In the Library inspector, select the project, folder, or album that holds the images you want to add to
the empty album.

The project, folder, or album’s images appear in the Browser.

2. Drag the images from the Browser to the empty book album in the Library inspector.
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Controls in the Book Layout Editor

The Book Layout Editor is where you design the layout of pages in your book and add images and
text to pages.

— The Book Layout Editor
is where you design
yvour book.

Celehmhng our Wedding
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For more information about the controls in the Book Layout Editor, see “Book Layout Editor.”
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Choosing a Theme

You choose a theme for your book when you create your book album. However, you can change the
book’s theme at any time. A theme provides a professionally designed set of master pages that
determine how text and images are placed on the page.

It’s a good idea to explore the page styles and designs of Aperture themes. Some theme designs
lend themselves better to presenting many pictures without much text; others to more traditional
mixes of text and images, such as you might find in coffee table books. Once you know the
characteristics of the different themes, you can choose the theme best suited to a project.

You can also create your own custom theme with the dimensions of your choosing. However, you
can’t order books from Apple created with custom themes. For more information about creating
custom themes, see “Working with Custom Themes.”

It’s important to choose the theme you want at the beginning of a project. Each theme presents
different combinations of master pages. Although you can change themes after you start a project
and Aperture will attempt to convert your book structure to the new theme’s master pages, you may
need to redo some of your work to make up for differences between themes. It’s not recommended
that you complete a book and then change themes to see it with different layouts.

Warning: It’s possible to lose text when you change themes. If you change book themes, make
sure to first copy the text you’ve entered into another document so that you have a backup copy.

& To choose a new theme for your book

1. In the Book Layout Editor, click the Theme button.

Theme button

T
[ heme | [hasdconer Sofcove

A dialog appears, alerting you that you may lose text when you change themes and any custom
layouts you created will not be preserved.

Click OK.
Choose a book size from the Book Type pop-up menu.

In the Themes list, select a theme.

Vi & W N

Click Choose Theme.
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After you change the theme, Aperture updates all of your pages to use the new theme.
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Viewing Pages

As you work on a book, you can select and view particular pages, and you can change your view of

the pages. You can display your pages laid out singly or side by side, and you can enlarge or reduce
your view of book pages.

For more information on the various page-viewing options, see the following sections:
e “Navigating to Book Pages”
e “Displaying Single Pages or Spreads”

e “Resizing the Page View”

Copyright © 2009 Apple Inc. All rights reserved.
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Navigating to Book Pages
You can navigate to pages in your book by clicking a page in the Pages pane or by clicking the

navigation buttons.
& To view a particular page in a book

m  Use the scroll bar in the Pages pane of the Book Layout Editor to scroll to a specific page, then click
the page to select it.

Click to select the page you
want in the Pages pane.

Use the scroll bar to
scroll through the pages
in your book,

You can also quickly scroll through your pages by clicking the Previous Page and Next Page buttons.

Previous Page button
BRI Y
Mext Page button
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Displaying Single Pages or Spreads

You can set the Book Layout Editor to display your pages singly or side by side. For example, you can
display pages side by side to see how images work beside each other in two-page spreads.

¢« » | |oo @

Shiowe Full Spreads Shaw Single Pages
buttan buttan

& To display pages singly or side by side
®m  Click the Show Single Pages or Show Full Spreads button.

Note: Printing single- or double-sided pages is a function of your printer and the options available in

the printer’s Print dialog. If you’re purchasing printed books from the Apple print vendor, your book
is automatically printed double-sided.
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Resizing the Page View

You can reduce or enlarge the view of your book pages in the Book Layout Editor. For example, you
might enlarge the display of your pages to closely inspect details, or reduce the view to get an
overview of the general page composition.

Scale to Fit button

] ':mux] - I o Display Size slider

‘ Actual Size button

& To reduce or enlarge the display of your pages

®m Drag the Display Size slider left or right to change your view.

& To return your page view to a size that fits within the Book Layout Editor

®  Click the Scale to Fit button.

& To change the page view to show the actual size of the page

®  (Click the Actual Size button.
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Placing Images in a Book

Once you have created a book album with images and chosen a theme, it’s time to place images on
the book’s pages.

See the following sections for detailed information:
e “Placing Images Manually”
e “Placing Images Automatically”

e “Viewing Images to Be Placed in a Book”
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Placing Images Manually
You can place images in a book manually by dragging them into the Book Layout Editor one at a
time.

& To add images to the book manually

® Drag an image from the Browser to a photo box on the page.
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Placing Images Automatically

Using the Autoflow feature, you can have Aperture automatically place your images in a book. It’s a
good idea to set up the page structure of your document first by creating the number of pages
needed and assigning master page layouts. Then arrange your images in the Browser in the order in
which they should appear in the book and let Aperture place the images into the structure you
created.

You can place all of the unplaced images in your book at once, or you can select specific images and
have Aperture distribute them into any empty pages. For example, you might select several images
and have Aperture place them into the first several pages of your book, and then select several more
images and have Aperture place them on the following pages.

If you prefer, you can have Aperture create as many pages as necessary to hold all of your images
and place them on the pages. Aperture creates new pages using master page designs from the
selected theme and fills those pages with your images. You can then change the master page
assignments if you wish.

Automatically Placing Unplaced Images

When you create a structure of pages to hold your images, Aperture can distribute unplaced images
into the pages of the book. If more pages are required to hold your images, Aperture creates
additional pages. If you’ve already placed some images on pages in the book, Aperture distributes
images beginning with the first empty photo box.

& To have Aperture "autoflow” unplaced images
B Choose Autoflow Unplaced Images from the Book Action pop-up menu (with a gear icon) in the Book

Layout Editor.

Automatically Placing Selected Images

You can select images in the Browser and Aperture can distribute them into the current page
structure of the book, starting with the first empty photo box. For example, you can select two
images in the Browser and have Aperture place them into the first two empty photo boxes of your
book. You can thus place images into a document’s page structure little by little as you go. If you
select more images than your current page structure can hold, Aperture creates new pages as
necessary.

& To have Aperture "autoflow” selected images

1. In the Browser, select the images you want to place in the book.

2. Choose Autoflow Selected Images from the Book Action pop-up menu (with a gear icon) in the Book
Layout Editor.

Copyright © 2009 Apple Inc. All rights reserved.

file:///Applications/Aperture.app/Contents/Resources/English.Iproj/aperture_help/en/aperture/usermanual/index.html#chapter=23%26section=12 Page 1 of 1

Petitioner Apple Inc. - Ex. 1005, p. 917



Aperture 3 User Manual: Viewing Images to Be Placed in a Book 10/1/21 11:53 AM

Viewing Images to Be Placed in a Book

After an image is placed in the book, its Browser thumbnail is marked with a number to show how
many times the image appears on the pages of the book.

il

' { | The number indicates
A A the number of times an
/ B - x v image has been placed

g E . in a book.

0T1014_King_0575

In a long book with many images, it can at times be difficult to know which images have been placed
in a book. To help you work efficiently, you can click the Show Unplaced Images button to see only
the images that remain unplaced.

Click the Show All Images
button to see all the
images in the book album.
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Click the Show Unplaced
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& To display only unplaced images in the Browser

m  Click the Show Unplaced Images button.

& To display all of an album’s images in the Browser

m  Click the Show All Images button.

To inspect selected images in detail, you can display them in the Viewer. When the Book Layout
Editor is open, the Browser provides a button for quickly switching to a standard Viewer.

& To display a selection of images in a book album in a standard Viewer

1. Select the images in the Browser.

2. Click the Show Viewer button.
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Show Viewer button

The Book Layout Editor is replaced by the Viewer, allowing you to view the images in detail and
perform adjustments. To return to the Book Layout Editor, click the Show Viewer button again.

Making Adjustments to Images in a Book

You can't select and use the Lift, Stamp, Rotate, and adjustment tools in the tool strip when
using the Book Layout Editor. To use these tools to make a change to an image in your book,
select the image in the Browser, then click the Show Viewer button. The selected image appears
in the Viewer where you can make adjustments. Click the Show Viewer button again to return to
the Book Layout Editor.
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Adding and Removing Pages

When you create a book album, Aperture automatically sets up default pages laid out in the Book
Layout Editor. You can select and change these pages to suit your book’s requirements, and you can
add and remove pages as needed. You can insert new blank pages wherever you like. After adding
pages, you can drag them in the Pages pane to new locations in the book.

See the following sections for detailed information on these topics:
e “Adding Individual Pages to a Book”

e “Automatically Creating New Pages”

e “Adding New Pages to Hold a Selection of Images”

e “Adding New Pages Based on a Master Page”

e “Adding an Image Index to a Book”

e “Removing Pages from a Book”
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